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Foreword
The yearly Revít series of books çreated by Robert Yori/ Marcus Kim/ and Lance Kirby is a

valuable resource to record and push forward the evolution of Revit/ which is the leading BIM

(building information model) product. I remember the founder of Revit, Leonid Riaz, saying the

goal of BIM. is to allow the construction industry to virtually desígn buildings/ virtually build
buildings/ and virtually fly buildings just as he had helped make this happen for the Boeing 777
in the 1990s. Revit is defínitely on tMs path wíth recent progress toward enabling architects,

engineers, general contractors/ trade contractors/ and building product manufacturers to come

together through BIM and virtually build the buildings, acHeving the similar high standards
accomplished with the jet.

I also remember an early board meetmg at Revit in 2000 when we approved the term BIM to

be the taglme to describe what we do at Revit. BIM hás expanded its definition and influence
beyond Revit to include other powerjful software and applications to create platforms that allow

our industry to virtually design, build, and fly (test) our buildings. Kudos to people like Chuck
Eastman, Leonid RÈaz/ Cari Bass/ Phil Bemsteín, the authors of this book/ and many others who

have been making the dream of BIM come alive over the last 20 years.

The authors of this book have advanced the power of BIM by expandmg our knowledge of
the capabilities of Revit along with the BIM process and platform, which encompasses many

software solutions and applications. The BIM advancernents have allowed the pursuit of virtual

buildmgs demonstrated in the relatively new pursuit of Virtual Design and Construction (VDC).
In just the last few years/ the VDC revolution/ which includes the actual virtual construction of

the building/ is being followed immediately by virtually flying/testmg the buildmg. The promíse
of the avionics industry experience is now occurring within the AEC industry.

I believe virtually flying the building is the ultimate goal. Being able to virtually test the
design and test the quality of the virtually buüt building demonstrates the balancing of
the design and the build quality of a building. I refer to Üüs review usmg the acronym FACE/
which represents the (F) Function of the building; (A) the Aesthetic of the building; (C) the Cost
of the building; and (E) the Environmental impact of the buildmg.

The function must be addressed because the design and ite resulting buildmg are falling far
short of what it should be. Por instance, m hospitais in the United States/ more than 15% of the

people get sick during their stay/ while this same statistic is less than 5% in Norway and Sweden.

Addiüonally/ Carnegie Mellon Architectural School studies have shown that elementary schools

with generous natural Ughting raise test scores for their students. (F)unction in design and the

quality of the construcüon of the building is criücal.
(A)esthetic is also criticai to the quality of the design. This is an aspect of design that the many

architects I know are very passionate about and extremely capable of delivermg. If they used the

same energy and genius on the Fitnction/ Cost/ and Environmental aspects of FACE/ we would

have a revolutionary breakthrough in the quality of our design and actual construction of our

buildings.

Unfortunately/ architects and engineers of buildings in the United States continuously

underestimate the (C)ost of theír buíldings when the constructors actually come in with their bid.

I personally thought I had a breakthrough when we sold Revit to Autodesk and Cari Bass, the
new person in charge of Revit/ said that he would provide Quantity Survey Software with Revit
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if I would build out a full system of BIM objects in the early 2000s (SmartBIM and Autodesk Seek
were created for this purpose)/ which I would then connect with the RS Means Cosfing Systems

(a company I had owned and later had a strong influence over).

Therefore/ with a capable staff that included early software construction pioneers like Dennis

Neely Raghi lyengar/ Andrew Amold, BlaÍne Wishart/ Charles de Andrade/and Marc Fagan/ we
created a reasonably accurate (within 10%) Bstimated Cost of a Buílding done m Revit by"using
the SmartBIM Objects/ Revit Quantity Survey/ and RS Means. I personaÏly contacted executives at

least half of the top 40 architectural firms in the United States and offered this Cost Software
System for free/ and only two firms were interested. Basically, each architectural firm/executive

said they wanted nothing to do with the cost of the buiÏdmg because of lack of interest/ expertise/
and liabilityproblems. Though more money in the United States is spent on counting and
measuring (Quantíty Survey) by frade contractors/ manufacturer representatives/ and dístríbu-

tors than ali the money paid to architects and engineers for theír design work/1 believe Üiis is
still a huge opporhinity for improvement in our industry.

I believe owners really would Ïike better cost numbers than they now get duríng the design

F^?cess^1} wi, BIM/ thearchitects and engineers should be a lot more capable ofbeing within
10% to 15% of the cost of their designed buÜding. Unfortunately/ today, when the ardutect/
engineer does give an estimate for the cost of their new building, it is often at least 15%-20% too

low. We then are stuck withValue Engineering/ which is a euphemism for making it cheaper/ and

the environmental (the E of FACE) concepts—which are longer-term cost benefíts—get eviscer-

ated to attain Üie desired price. ThÍs new price is totally cost-based with too Uttle regard for

longer-term environmental concerns. Hopefuïly, usmg the principies of FACE with BIM/ the

architects/engineers and the constructors can help our industry achieve productivity gains as
well as environmental advances.

Starting around 1920, Gropius/ CorbusÍer/ and Mies van der Rohe were looking at modern

design paradígms to streamline the cost and production of buildings that would allow a stronger
and less expensive buildmg. These founders of modern architecture were using manufacturmg

PrínaPles and techniques that were used for making cars and airplanes at their infancy.

BIM was started with the concept of virtually designing and viríually constmcting íhe
buildings of the future, to attain better construction and enviromnental design characteristícs.

Combined with more sophisticated manufacturing materiais like steel/ aluminum/ glass/ and

concrete/ wlüch permit stronger/ taller/ and faster-buiït buildmgs, BIM empowers more manufac-

tunng techniques. BIM enables the construction of modern tall and strongbuildings being built
with the precision and strength of a jet. Sustainability in a building is advanced and created with
the use ofmodern materiais and sophisticated techniques of manufacturing. These tedmiques

advance the clean strong, and safer manufacturing ofbuildings needed fortíie hígh quaUty and
preasion reqmred for the highest achievement of a sustainable building.

BIM and VIM (Virtual Information Model) offer the next steps ahead for thâ construction
industry/ which can provide profound processes for the design and building of high-performance

buildings that achieve the appropriate balance of FACE (Fimction/ Aesthetics, Cosi,
Enyironment) for a buildmg/s ultimate performance, espedaUy as it serves to enhance the quality
and performance of the people in the buildíng.

Our cost engineers and analytical staff led by our president/ Durwood Snead/ at RS Means

Construction Cost Corporation/ throughout the 1990s and the early 2000s demonstrated to me
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following. Over 25 years of a building/s life/ the first 5 years accounted for 25% of the buildmg

cost through design/construction. The final 75% of the cost was covered over 20 years thiough

facility management/ includmg rehab/maintenance. The RS Means team stressed to me that in

reality/ the real costs of a bmlding should be measured by productivity/ wellness/ and happiness

of the people in the buildmg—Hélio WeWork!
We can set higher standards for the quality of life of the people m the building if we not only

desígn and build it with BIM/ but we actually test or fly the building before it's built, for safety,
health/ and productivity. Modermsm in buildings does not mandate sterílity or bormg design/

but to the contrary/ it can bring more complexity/ sophistication, and beauty at lower costs if it is

empowered with an advanced form of BIM that is used to achieve the high standards of a jet. The

new challenge is to make BIM join with VIM to allow us to help pursue the challenge of properly
addressing FACE for the future só we can create the next step of modern buildmgs that serve the

productivity and the health quality of the people using the buildings we design and build. BIM
as software, like Revit/ is rapidly evolving each year/ and the actual evolution is accurately

depicted in this book.
In this book, hundreds of pages are needed to depict in necessary exquisite detaíl the actual

changes to the Revit software. BIM is a process that is not only enhanced by the evolution of the

Revit software/ but also by its necessary connection to new BIM' software that is created by others

than Autodesk/ which hás greatly enhanced and expanded the BIM platform and therefore the

BIM process. New enhancements to the BIM process are chronicled and explained in this yearly

publication, which is achieved by multiple authors with wide expertise creating a necessary new

extensive book each year. I believe this book and past publications will help us on this quest to

achieve a new dimension of what a modern building can be.

—Arol Wolford

Aro; hás served on the boards ofRevÍt, CMD (Construction Market Data), and RS Means, and

currently serves on the boards of Manufactory, BCÏ (Buüdíng Construction ïnformation), Vizz, VlMaec,

BSD, SIG (SustaÍnable Investment Group), ana TDG (The Digit Grozip).



Introduction

What you hold in your hands is regarded as the definitive source of Autodesk Revit expertise
available in written form. It hás been a leading book in educating novice and experienced users

alike for the better part of a decade. Those of you who have read previous editions know there is

a wealth of information regarding the practical usage and application of the program in produc-

mg many different architectural designs. If you have used these preceding editions to help you

gam a better understanding of this complex application, then you know that new information is

provided in each edition to update you on the newest features and how they mi.ght improve your

workflow every day. What you may not know is that this specifíc edition seeks to go further. Its

purpose is to provide you with not only the best understanding of the available tools, but also
many of the skills sorely needed by professionals to manage these tools in an archÍtectural

buildmg information modejling (BIM) workflow.
Often when working with architects around t-he world/ we fmd that the terms Revit and BIM

are used interchangeably m describing what is new about the profession and the way we execute

work. From the typical user ali the way to the principal members of a fírm/ there is a misconcep-

tion that if you are using Revit/ you are doing BIM. The chaiïenge/ of course/ is separating the

tool from the technique. Although Autodesk® Revit® is a wonderful apparatus for joining
three-dimensional geometry with incredibly powerful and accurate data/ it is not a process or a

road map for producing architectural work. Although Revit is an important foundational asset to

a BIM-based workflow/ it is still a resource that needs associated procedures and the intent for

reaching planned deliverables. Where is technology without technique?
BDVt is a methodology used to produce a complete desígn, construction/ and operations

solution. ït hás become a catalyst for transformmg design and production processes m the

architecture/ engmeering, and construction industry. More than a decade ago in 2005, BIM was

represented solely as architectural design and documentation authoring tools. Today/ BIM hás

grown to forrn the basis of the process from design discipline authorship to construction and

operatíon management of built assets. It is also being adopted for infrastructure as well as

buildings. As the use of BIM tools and processes hás become more mature/ nations have changed

legislation to accommodate the immediacy of centralized collaborative workíng practices in

contrast with traditional sequential paper workflows. Global organizations wíthin specific

industries have defined exchange classifícations such as Industry Fonndation Classes (IFC) and
COBie/ and owners and their customers now expect to see full 3D media to describe a building at

any stage of the design and buÜd process. They even expect to see it as part of the construction

process on-site, corLtrolImg and validating the build environment.

The challenge for any company in the architecture/ engineermg, and construction (AEC)

mdustry is to recognize the BDVE áreas that match its business rúche and to ensure that the
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information that it attributes to a model can be generated efficientíy and maximized by ali

other information-model users. With this comes much more responsibility to users of the tools

and managers of the mformation/ beyond lines and ares generated by zeros and ones. It entails

that you work with intent beyond what you see displayed on monitors. It is not enough to know

every button and setting contamed in the program; the BIM practitioner must know why to use a

feature and whenitis appropriate. It is not enough to know how to customize the tempÍates for

your specific workflow; it involves user understanding/ knowing when customizatíon is needed

to create a specifíc output/ and when settings are best left unchanged. It is not enough to know

how to create iterative forms through the manipulation of Python coding; it also requires an

understanding of design criteria and how BIM uses align with them. Most important/ it is not

enough to just have the knowledge of how to model a thing; it is necessary to have the wisdom
to know when and why io do só.

Rest assured/ this book's purpose is to educate you on the best techniques and practices of

RevÍt/ regardless of your responsibiUtíes as an architectural project team member. New users will

fínd a plethora of information regarding everything from simple concepts to complex techniques

in executing modeling/ documentation/ and data Ínput/output. AH the while/ we~have included

some lesser-known tips and tricks for seasoned veterans. Ali readers/ regardless of theír experi-

ence/ will benefít from the authors' knowledge in planning/ collaborating, governing/ and

supportmg BIM projects with Revit at the center. The goal is not to turn ali readers into BIM

managers/ but to extend the amazing mformation provided in previous volumes with additional

recommendations for supporting your work for more effíciency and better quality.

Anyone involved m any aspect of BD^Í/ even tangentially/ can benefit from knowledge of the

bigger picture. This edition/s coverage of the collaboratíon process/ the management of practices,

and the governance of data standards hás been expanded só that even novices can mcrease theü'

value to the team. By understanding principies that show that every actíon should have a

method and every method should have a purpose/ readers will contmue to progress their

expertise in providmg precise modeling and valid data to their teams at the right time and in the
right formai.

If you seek a greater understandíng of the BIM process and strive to transcend your tradÍ-

tional responsibílities, this editíon will help you toward the goal of BIM management. Pursuing

knowledge ofplanning, organizmg, leadmg, and controlling your projects through new tech-

niques andtools will help you take those next steps. By planning/ you will estabfish strategies for

achieving BIM use objectives. By organizmg/ you will be structuring the workflow to maximize

the collaborative integration of your team. By Ïeading/ you will optimize your project team/s

potentíal for providing quality deliverables efficientíy. By controlling, you wÍU be able to
measure the team/s performance and provide continuai self-improvement with the goalof

raising the levei of excellence. Regardless of your role/ you wül contribute more.

As you begin delving into this book, keep an active núnd about how each of the provided
recommendations might fít your company/s culture/ your experience/ and your customer's

needs. Not ali of íhese ideas may be of interest or value to every project/ but the goal of this book

is at you wiu ëvow beyond any of the tools or technÍques you deploy on your BIM projects/

that the tools become second nature and an extension of your creativity/ and that through thís
you will .realize great architecture.

Architecture is the process of turning a thought mto a space. Although it/s só simple to convey

that in the written word, the actual act of domg só Ís much more than it is possible to write. It/s

glory/ it/s tormení/ it's frustration/ itfs .freedom/ ít's the realization that one miscalculation means

a complete redesign/ and it/s the 3 a.m. epiphany when you realize that the new design was what
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you were meant to get to m the first place. With ali of that/ it's also the burning desire to work

relentlessly to make something better one step at a time.
Âutodesk® Revit® 2020 is one of the many tools we employ to help us through this organic

.Ït's one tool m the toolbox/ but it can be much more than that. ït can be the workflow

Ïhatïlps" to empower a team. That team is the designers/ the contractors, and ultímately the

ownerswho are ali looking to speak the same language.
We hope that m the process of using this book/ you wiU experience abit of the stmggle to

reaiize7bit of the satisfaction of findmg the solution. We hope what you learn in this book helps
, to youï own bit of greatness/ because whafs most importante that architectu^e isrL't

aboutbuildmgs. It's about what we are able to accompUsh with what little time we have Tïús is

ïhe elegant essence of Revit. Before we go much fuïther/ we have a few semanticstodiscuss-

First, ali the tutoriaí files necessary to complete the book's exercises plus sample families are

hosted online at:

www.w-iley.com/go/mastenngrevit2Q2Q

DorVt have a copy of Revit 2020? Download the trial version of Revit from:

https://www.autodesk.com/products/revit/free-tn al

Here you'11 also fínd complete system requirements for runnmg Revit.
Are you a student or educator? Someone with an .edu e-mail address? You can get a copy of

Revit for free at:

https: //www. autodesk. com/educat-ion/home

For the clearest direction when followmg the exercises in this book/ please make sure to mstaU

ali the Revit-support files that come with the default Ínstallation. We reference them heavíly/ and

will need them to best leverage the software.
Smce Revit 2018, there is only a~smgle version of Revit that offers the ArchÍÉecfcure Structures/

andMEP-packagesm one appUcation"We have focused this book onthe architecturalfeatures and

have setthe useï interface to remove some of the Structural and MEP tools for better visual darity.

The variations wiU be slight and ideally manageable, which really means you have some extra

tools for Structure and MEP design. For case of reading/ we removed those from the

book's images.

Pinally, Revit extends Íts capabilities with some additional cloud-based tools that require an

Autodesk account. We cover these tools throughout the book. Vou can go to

https://accounts.autodesk.com

to create an Autodesk® account to access those additional tools.

Who Should Read This Book?
This book is written for architects and designers who have had some exposure to Revit and are

eager to leam more. It's for arclútects of any geneïation—you don/t need to be a comPuter

wSard to understand or appreciate the content within. We designed the book to foUow real

project workflows and processes to help make the tools easier to use The chapters are full of

harídy tips to make Revit easler to leverage in your day-to-day world.
This book is also for the entire range of architects/ from those who are fresh out of school to

seasoned project managers. We have endeavored to mclude content for ali walks of the profes-
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sion só that regardless of your role on a project/ you can learn how BIM changes both workflow

and^culture wíthin a project team. With that, a basic understandmg of Revit will make it easier to

work through the book. Revit is a robust tool requiring more than one project iteratíon to master.

c. . I_M,mana?ers/ the book offerslrtsights into the best practíces for creatíng good project or
office templates; these managers should also take a sneak peek into the powerfuÍ world of

sml.din?.content an,d Revit families- we have added many time-saving and mspiring concepts to

?!ÍOOÍ/ _su?ported by examples from our own Projects and the rest of the real worïd/ to help
motivate and iíispire you on your journey through building informatíon modeling.

WhatYouWillLearn

This book will help you take the basics of Revit and BIM that you already know and expand on
them usmg real-worid examples. We will show you how to take a preliminary model and add

layers of mtelligence to help anaÏyze and augment your designs. We'H show you how to create

robust and accurate documentation/ and then we'llhelp you through the construction process.

We go beyond introductory topics. To that end/ we won't be starting a project ÍTom scratch or

!iea?íng70u the. basi?s of howto buüd a simple BIM model. If you areinterested in leaming at
that levei or are brand new to Revit/ we strongly recommend you pick up Autodesks Remt<s

^hítecture 2016 Essentials (Wiley/ 2015) before plunging headlonginto this~b^~7ï^ï^1his
bo^Küegins wim a ünef overview of theBIM approach.As you are already aware, BIM is more

ê^í^ ichange m softwa^e; ifs a chm5eln_architectural workflow anrl çnl+ni^T^Twerage
the íuÜ advamages oí üotli tílM and K^ïfïTy^Toffi^sïïucture/ you will needto make some
ranges to you^^e. We/ve designed the book around an_idealmïegráted workSawto\
you máke this transition.

^Fting with the project team/ standards/ and culture, we'11 díscuss how BIM changes your

project approach and how to best build your team around a newer workflow. Prom there,we/Il

delve mto conceptual desigiLandsystamabüity stu^g^continuing through best practices for

?es,ign iteratïon and refinement. YouaHearn^owtouse powerfulmodeUng ^^

ito^Ígn.docum-entationbesÍ£Tactices/ ho^tomake comg^gjpre^a^^^^ics/aB.d
h^^Ï^aá^aItÈage^f^^M^des]^w^ workffow
?^E^?uch as trackin?chan§es and wo^hariïÏFs"^lT^sÕmeiTrategïes^^
traditional concepts of BIM. The book includes an appendix on troubleshooting and best'

p.ractíces/ so you can avoid common Pi^lls. Throughout the book we/ve shared our practical
experience with you/ particularly in the form of real-world ecenarios.

^Vhether you're studymg Revit on your own or in a class or trairdng program/ you can use the

~^S-Ir quçstion^ in A^£C±ü^L£âÜÊâ^Ïb&Bottom Lme" at the end of each chapter to test
your mastery of the skills you/ve learned.

FREE AUTODESK SOFTWARE FOR STÜDENTS AND EDÜCATORS

The Autodesk Educatíon Community is an online resource with more than five million members

that enables educators and students to download—for free (see the website for terms and condi-

tions)—the same software used byprofessionals worldwide. You can also access additional tooïs and

matéria s to help you design, visualize, and simulate ideas. Connect with other learners to stay cur..

rent with the latest industry trends and get the most out ofyour designa. Get started today at:

www.autodesk.com/educat-ion/-free-software/featured
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The Mastering Series
The Mastermg series from Sybex provides outstanding instmction for readers with^intejmediate

and advanced skills/ m the form of top-notch traming and development for those already

working in their field and clear, serious education for those aspiring to becoine prós. Every

Mastermg book mcludes the followmg:

• Real-world scenarios/ ranging from case studies to interviews, that show how the tool,

technique/ or knowledge presented is applied m actual practice

• Skill-based instruction, with chapters organized around real tasks rather than abstract

concepts or subjects

• Self-review test questions/ só you can be certam you/re equipped to do the pb right

Whafs New?
The Autodesk Revit team works continuously to improve the software/ add new features, and

elïmmatebugs^ It/s a constant evolution. Here is a list of the items that have been added or

enhanced in the 2020 release'.

Cloud Technologies Revit hás made several changes to how it integrates with cloud

gies. Thís mdudes updates tp_Autodesk@BIM360 Designa A360^ where documents
anïmod°eTsare-shared online/ and how^dTworkFwïtíï'conceptual design applications suA

as Autodesk® Dynamo® and Autodesk®F^ïú^

PDFManãgem~enTãïï^lfflpTwëïÏmage QualÍty RevitnowauowsfortheinsertlonofpDF
fites as 2D àjects. If the PÔF is vector based/ it allows for snapping. In addition, you can use

, to select vector elements to generate native Revit elements such as walls and

linework. Now you can copy images as mstances and do not need to load duplicate copies.

Elliptical Walls The wall tool now allows for the generation of bothril^tÍcaLiïâüê.and
curtam walls. You'11 see an ellipse option available in the draw panei.

Fath oí Travei New functionality in Revit allows for the picking of two polnts; then Revit
wiU caÍculate the shortest distance between them/ taking into account the geometry (i.e, walls/

doors, openings/ and furniture) that may impede the path of travei.

Improvement in Filters Improvements to the filter fimctionality mclude the addiüon of

/'OR/r logic/ and general Uï enhancements.

Scope Boxes You can now edit and manage scope boxes in a view list, eliminating the need

to manually search and manipulate them in mdividual views.

Better Model Graphic Fidelity The error message/ /'Element is too small to be viewed on

screen// hás been removed. This allows for a tighter granularity when detailing.

What to Expect
Mastering Autoâesks Revifí 2020 is divided into several_parts/ each representing a milestone^m

yourprogresstoward becommg an expert Revit user. Here is a description of those parts ,

what fhey will show you.

-^
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Part l: Fundamentais

Thís book is not intended for novices, but we recognize that not everyone will know how to fínd

every tool or have a complete understanding of the workflow. The chapters m Part l help you
build a foundation of essential tools and knowledge.

Chapter l/ "Understanding the Principies of BIM// covers principies in building information

modeling within your office or project environment.

Chapter 2/ "Exploring the UI and Organizing Projects/" details the Revit interface and general
organization.

Chapter 3/ "The Basics of tihe Toolbox/" explores (-he commands and tools within Revit. It

gíves you an overview of where to fínd them and prepares the deep dive mto their use for the
chapters ahead.

Chapter 4/ //Configuring Templates and Standards/" discasses the tools you'11 need to develop

and manage graphic standards m a project template.

Part 2: Collaboration and Teamwork

Part 2 sets you on the path toward usmg Revit on a team or throughout your firm and takes a

deep dive mto a successful BIM workflow.

Chapter 5/ "Collaborating with a Team/" discusses the criticai tools for working with Revit on
any project team.

Chapter 6, "Working with Consultants," covers the basics of working with team members
outside your office.

Chapter 7, "JnteroperabÍlity: Workmg Multiplatform// detaíls the tools you/ll need to share

your Revit files with other team members who donrt use Revit as a design tool,

Chapter 8/ "Managmg Revit Projects// covers how to manage the Revit model to keep the file
running smoothly and efficiently.

Part 3: Modeling and Massing for Design
In this part/ you/ll delve into the use of Revit starting from the early stages of design through
analysis/ iteraüon/ and visualization.

Chapter 9, "Advanced Modeling and Massing// details the creation of forms and shapes with
the conceptual Revit tooüdt.

Chapter IO/ "Conceptual Design/' gives you an overview of conceptual design tools including
Dynamo and Formlt.

Chapter 11, "WorkÍng with Phasing/ Groups/ and Design Options// takes the next step after
Ü-ie initial design and analysís: iteration.

Chapter 12, //Visualization// takes the design work you've created and shows you how to

create stmmíng renderings and imagery of your design.

INTRODUCTION f XXXVII

Part 4: Extended Modeling TechnÍques
Part 4 takes the conceptual forms you create in Part 3 and expands them to the real world using

walls, floors, roofs/ and other building components to create the elements behind a building.

Chapter 13, "Creating Walls and Curtam Walls/' delves mto the use of the Wall and Curtain

Wall tools.

Chapter 14, "Modeling Floors, Ceilings/ and Roofs/' demonstrates a variety of ways to work

with the horizontal components of a building: floors, ceilings, and roofs.

Chapter 15, "Designing with the Family Editor," shows you how to work with parametric

families to create a host of content for the building design.

Chapter 16, "Creating Stairs and Railings/" demonstrates a variety of ways and techniques to

use the Stair and Railing tools—for their intended purpose and for others.

Part 5: Documentation
Once the building is designed/ it becomes necessary to create the views and documents needed

to build the project. This section shows you how to detail/ document/ and annotate the design.

Chapter 17, "Detailing Your Design/' works with the buildíng design you created in previous
chapters to add 2D components for documentation.

Chapter 18, "Documenting Your Design," works with the newly created views and helps you

organize thern on sheets.

Chapter 19, "Aimotating Your Design/' takes the next step in the documentation process and

works with keynotíng and dimensioning.

Part 6: Construction and Beyond
This section focuses on what to do once the design is resolved, taking it into the construction

process and working with presentation tools.

Chapter 20, //Working in the ConstructÍon Phase/" focuses on the tools Revit hás to keep track

of changes during construction.

Chapter 21, "Presentmg Your Design/' shows you how to take the completed design and

display the results in a variety cf 2D and 3D methods.

Chapter 22, "Design Analysis/" teaches you how to use new tools that analyze the energy

consumption of your proposed design and help optimize the buildíng/s energy footprmt.

Appendixes
Three appendixes supplement the chapters' coverage of Revit software features.

Appendix A, /'The Bottom Lme/" offers solutions to the "Master W questions in each chap-

ter's "Bottom Une" section.
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Appendix B/ "Tips, Tricks/ and Troubleshooting/" is just what the titíe describes—a collection

of tips and tricks for troubleshootmg and workmg effectively with Revit.

Appendix C, "Autodesk Revit Architecture Certification/' descríbes Autodesk's certifícation
exam for Revit Architecture and how Üús book can be used as a supplementary tool for test

preparation. Throughout the book, the icon shown here marks signíficant coverage of exam

objectives.

Contacting the Authors
We welcome your feedback and comments. You can find the authors on Facebook at Mastermg

Revit and on Twitter @MastenngRévi't.

We hope you enjoy the book.
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Ünderstanding the
Principies of BIM

In this chapter/ we cover the principies of a buüding information modeling (BIM) approach

within most offtce environm.ents and summarize some of the many practices used m today's

architectural workflows. We explain how you and your organization can achieve some of the

many possible benefits from BIM1 by sharing the processes that these technologies support. As

you will see/ these practices are oriented to mdustry BIM uses that provide advantages such as

more Üioroughly explored design concepts/ better coordinated documentation, and better

executed construction methods.

IN THIS CHAFTER/ YOU'LL LEARN TO

• Focus your investment in BIM

• Understand a BIM workflow

• Leverage BIM processes

The Fundamentais of a BIM Approach
Bmldm^mformation modeling is an integrated model-centric methodology that delivers
Fvalidated and coordmateci knowledge about a building project throughout plarmmg,desÏgn,

constructíon. and operation. WhCTLÜtifi rollahrTativ^jnterdíscipIinaryapprna^ is "pïüTiizeSLiL

can improve an orgardzation's operatimis_BrM provides designers/ cantractors/ and owners •with

aprocessjo improye clecisio_n-making^ qualiïy/ andjiniplinpç.c; A.t fhe core of this BIM approach

are model-centric ^yvnrkflows (geometric and data models) that support project execuüon and

asset lifecycle management These workflows determine the methodology for creating data-rich

geometries/ mtegrated deliverables/ and a model-based process to develop projects from- plan-

ning through the operation and management Ufecycle phases. BI1VÍ can be defined through
technology/ processes (its governance through standardization)/ and people. The technology

system Ís central to tíie processes of creatmg/ storing/ and using models. With processes/ the

success of BIM requires ali stakeholders in the project ecosystem to follow a series of steps/ both
as individuais and as a team. Ultimately/ the users of these techrdques and technologies are

committed to improvmg their design process by successfully integrating both geome-
try and data.

t
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If you are investíng in BIM today, understand that BIM hás been adopted by many in the AEC
(architecture/ engmeering/ and construction) industry. To succeed with these practices in the

current environment/ a business must make fundamental changes in the way it operates/ whether

by moving into a new market or by changing its methods of operation. It requires an alignment

of the organization/s activiües relating to its people/ processes/ and technology with its business

strategy and vision. Through collaboration and data management during an assefs lifecycle/

sharing mformation efficientíy and effectively can support better integration and interoperabüity

among ali project stakeholders. Along with this data comes the possibility of Íntegrated analysis.
By making these analyses easily accessible/ derivatives of this model-centric workflow can

provide a better understanding of design opportunities and decisions' consequences. With the

availabiUty of valid geometry-based data, 2D/ 3D (visualization/ clash detection), 4D (ume)/ 5D
(cost) and beyond are possible. Taking advantage of these capabilities is a must in keeping
architecture firms relevant in today/s market. Transformmg your organization's business quickly

and efficientiy willbe the difference behveen mamtaining your market share and taking that next
evolutionary step forward.

The Management People inside a BIM Project Team
The architectural marketplace hás changed/ and it influences staffing decisions as skills needed

for BIM projects can be different than traditional CAD skill sets. Some of your organization/s

leadership may be aware of this change and are organizing BIM teams aiíd resources to better

antidpate new processes. Others are unsure of how BIM may change how they plan projects/

from staffing to hiring. When lookmg to acquire BIM-skilled staff/ savvy firms look for process
experience m their new hires and no longer solely focus on hü-ing those with tool expertise. The

primary factor Ís always professional experience/ but having knowledge of BIM workflows
complements these professional skills.

When plannmg project staffing/ architecture firms generally focus on deliverables produced

by a project hierarchy of managers/ designers/ engineers/ drafters/ and interns. BIM roles and

responsibilities are based on availability within the project team/ rather than composing the best

fít based on model-based workflows. This does not constitute a project problem as much as it
decreases efficiency in two ways:

• Roles/responsibiliües are not clearly defíned/ and team members must adjust to BIM

project needs during the project. Managers, who are makmg staffing decisions/ may not

have the resources tojudge BIM experience levei or tool/process skïll sets/ other than

hearsay or previous project experience with similar circumstances.

• Though BIM managers have a better understanding of project workflows and needed

capabilíties/ they do not generally make staffing decisions for projects. There may be
project managers who know to confer with BIM managers at project startup; however/ m

many cases the BIM manager is brought in after project requirements and commit-
ments are made.

Typically/ professionals are hired based on project experience, education/ and certifications.

Historically for architecture firms/ BIM experience was considered as nice to have butnot

required. In today's market as BIM and BIM skills have become commoditized and in high

demand/ an increasing number of professionals have BIM experience on their resumes inthe
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of project experience and trained tools. Not havmg these skíll sets does not preclude staff

img successíul BIM project team members; it does impede the ability of managers with

BÏM experience to staff projects appropriatóly. It hinders theír ability to develop a plan m
ccordance with project requirements.

BIM project execution is fast becoming the standard project methodology. Regardless of your

role/ whether you are making staffing decisions or are a hardworking BIM project team member,

understanding how BIM workflows are changmg the plannmg and execution of projects is

important. We must accept that BIM is now essential/ and we must be prepared to address the

roles/ processes, and technology.

Staffíng for BIM
As the building industry's process of design and documentation Ís trarLsformÍng/ one of the

fundamental changes that teams need to address is staff plannmg in a BIM process. A common

misconception of project management is that staffing the BHVl project will be the same as it hás

been m CAD workflows. Unfortunately/ this is not the case. Because a BIM-based project can

signifícanüy alter the project workflow/ which now includes BIM-focused goals that are beyond

siinple documentation/ many of the standard timetables for task completion are no longer valid.

(See Chapter 8/ "Managing Revit Projects/" for further details.) Although fundamental delivera-

bles remain the same (drawmgs/ schedules/ etc.)/ the processes to reach these outputs are

different. For example/ in a CAD workflow/ a user can create a plan as a single one-off entíty. In a

BIM workfl.ow, the same user must develop a model before a floor plan can be produced. The

investment in the 3D model requires more time upfront/ and therefore the floor plan to be

produced necessitates a longer schedule. However/ once the model hás been developed/ many

other derivatives become expedient/ such as other drawing types (i.e., sections/ elevations/

callouts)/ schedules/ analysis/ and 3D renderings. To leverage this workflow/ the staff and

processes must consider the gathering of momentum early in the cadence of execution to

accommodate ali phases.
Years ago, Patrick MacLeamy/ who was then CEO of Hellmuth/ Obata/ + Kassabaum,

explained this workflow movement with a diagrammatical description of the shift of workload
and the ease of affecüng change m the construction process forward. The graph/ which hás come

to be known as the MacLeamy curve (Figure 1.1), is not simply intended to ünply a shift in labor
earlier in the design process; rather/ it stresses the importance of being able to make liigher-value

decisions earlier, before changes become too difficult or costly to implement. The x"axis of the

chart represents project phases from conceptual design through occupancy/ whereas the y-axis

represents the amount of effort m each phase.
Another important aspect of a BIM workflow is its ability to leverage decisions earlier m the

process. As shown in Figure 1.2, implementing BIM m initial project phases allows teams to

make and share better information earlier só that the entire project team can benefít. Based on

'BIM uses, a common Índustry term that we will refer to later m this chapter/ project teams may

need to adjust labor in the planning and design stages to support the development of the
geometric and data model. In a CAD workflow/ different project roles are assigned separate tasks

to move the design forward. A planner may be developing a program/ just as a designer may be

producing massing studies. In a BIM workflow/ these ïoles may be contmuing the same task, but

instead of working independently, they are workmg in the context of a single model/ allowing

them to mteract through geometry and information. Because of this mteraction and its ability to
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allow better decision making/ project teams may be deploying additional staff to help support
this collaboration in BIM. Depending on the BIM uses/ teams might mcrease staff to build a

model or to perform energy analysis; however/ deploying a BIM workflow will not necessarily

provide more proficiency or quality than a CAD-based project without proper planning and

governance.

FIGURE 1.1
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Ünderstanding Project Roles
It s also importanrtounderstand how th^signifícant changes to tools and processes provided by

BIM affect the roles and responsibilities of the project team. Project managers need to plan

staffíng and labor required to complete tasks in every project phase. BIM projects are supported

a few primary roles that will aUow the team a levei of predictability/ although the specific
effort and staffíng wül vary between offices (and even projects). Here are the primary roles that

should be considered on every BIM project:

Design Architect Generates design intent from the planning stage through early design

Technical Architect Produces the deliverables/ ensurmg the design intent is achieved

BIM Coordinator Directs the BIM workflow between design and production

These roles represent efforts and general tasks that you need to take into account on any BIM

project. For larger projects/ these roles could represent multiple people/ whereas srnaller projects

might constitute the same person fillmg multiple roles. For many architecture firms/ designers

and production staff may be tightly integrated and have few differences in responsibiiities. For
other firms, there may be a clear demarcation between the fírst two roles. Regardless of the

interaction between designers and production roles/ every BIM: project hás some coordination

responsibilities. We will next explore each of these m more detail and discuss how these roles

affect the project workflow.

THE ROLE OF THE DESIGN ARCHITECT

The role of the design arcHtect is to generate the design intent/ typically focused on the project
from pursuit through planning to design development. These staff may Ínclude licensed archi-

tects and mterns. Designers typically interact with the BIM process by first transferring their

conceptual ideas into digital form. For many planners/ this is going from 2D layouts to a 3D

model. For more sophisticated designers/ it might be to create a conceptual massing model based

on sketched geometry or somethíng as sophisticated as iterative design calculations. Whatever

the case/ designers start the modeling process on a project.

For some workflows/ designers may stay in a more traditional process/ and technical archi-

tects begin the BIM process based on their designs. As creative processes and digital capabilities

align/ designeis moving forward are more Ukely to use digital authoring tools for their work

rather than traditional ones/ such as hand sketching and physical modelmg. With this, the BINÍ
process will start earlier Ín the project time line. Followíng this workflow/ designers have the

capability to make better decisions for the project team earlier based on the intelUgence they
provide to their geometric-based designs. What becomes most ünportant at this stage is having a

workflow specifíc to design work in BIM projects that allows creativity but properly sets the
stage for production staff to develop the desígns üito buildable instructions. WÍth this irt mmd/

the typical responsibilities for a design architect include:

• Create initial design intent models through 3D geometry using conceptual massing or
iterative desÍgn processes

• Lead the creation of architechiral elements and building from within the model

• Design around code requirements and other buildíng logistics
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THE ROLE OF THE TECHNICAL ARCHITECT

The role of the technical architect is to ensure that the project is buildable. These staff can be a

wide-ranging group from experienced licensed architects and architectural íechnologists to

interns who are learning how buildings go together. As with design architects, technical archi-

tects have a role in the BIM process not because of their professional skill sets but because of their

responsibüities to the project workflow. As models are developed, technícal archítects solve

issues such as constructability/ wall types/ and managing the program of spatial and equipment

requirements/ as well as other issues involving code compliance and client relationships.

Primarily concerned with deliverables/ production staff marúpulates models to create the

needed outputs/ such as drawings and schedules. The role of these staff is to create sheets and

embeÜish associated views witi-i annotations or other details. This role applies standards to the

project (as in wall types/ keynotes/ and só on) and organizes the docnment set. Technical archi-

tects are responsible for the bulk of the work needed to document the project. In earlier stages of

the project/ this role is typícally assumed by either the architect or the modeler/ but as documen-

tation progresses into later phases of design/ tihis can quickly become the role of multiple people

on a larger project. This role indudes the foiïowing tasks:

• Validate the constructability and detailing aspects of the design

• Produce project deliverables from well-coordinated models

• Follow the established Levei of Development (LOD) or Model Development Specificatíon
(MDS) to ensure models comply with requirements of the stated BIM uses

• Ensure the models and valid data are passed to construcüon and operation phases of the

project lifecycle

THE ROLE OF THE BIM COORDINATOR

BIM coordinators supervise the overall project modelíng techniques and discipline-specific BIM

output through ali project phases. They are responsible for checking that aU models produced by
design and production staff comply with the standards set out by the BIM executíon plan (BxP).
They check that models are correctíy named and are the current version and that ali relevant

asset metadata hás been completed with appropriate values. They coordinate requests for

supplier information from the design teams and determine whether model details already exist

in the Ubrary of design objects. Where model components do not already exist/ they create or

delegate their creatíon in the context of standards ana set responsibüities. Their BIM
duties are to:

Author and maintain the techrdcal sections of the BxP

Determine project file organizatíon and model splittmg strategy

Define file sharing protocols for the project

Determine team training needs and organize training if needed

Assemble and mamtain any multidiscípline models

Manage publication of files

• Create project delivery output from assembled files matchmg ali the fírm's BIM standards

• Review models for adherence to project standards

• Maíntain the team/s access to the correct tools for BIM authoring, aggregation/

and analysis

• Oversee the application of BIM tedmologies and ensure that the model adheres to ali
internai and client-specific goals and standards

• Oversee the development of the content of a specific mod&t element to the LOD/MDS

listed for specified phases of the project

• Assist ali team members m BB1 processes at ali stages of the project

• Lead 3D coordination meetings

These BIM roles for architectural project teams generally work for most firms and buildmg
types; however/ it is ultimately up to each organization and its management to decide howteam

members share in the responsibilities of managing geometry and connected data specificaUy for

its needs. As long as there is an expectaüon set at the begümmg of Üie project and a workflow

defined dnrmg its phases/ any number of roles and responsibüiües should help ensure that the

project is completed successfully. In support of that, project managers have a responsibility to

help mamtain the integrity of this workflow. Although they may not be directly developing
models/ they are makíng important staffmg decisíons based on this workflow and have the

responsibility to ensure that the deliverables from this process meet contractual oblígations. With

that/ we suggest that project managers have enough knowledge of BÏM people/ processes/ and

tools to do the following:

• Understand the impact BIM hás on a project delivery schedule

• Allocate time as planned for BIM management activities for the BIM coordinator and any

BIM administration and support requírements

• Be familiar with BIM concepts and uses on a project só that they are able to effectively
manage the project team and communicate progress and requirements to the client

• Oversee the administrative and contract sections of the BD^I project execution plan

Establishing a BIM Executíon Plan
To optimize your results with BIM/ you need to start with the end in mmd. Although a lotof

tasks are possible with BIM/ before you draw your fírst waU, you will want to create a BxP. We go

into more detail about creating these plans and some resources for them m Chapter 6/ "Working

with Consultants/ but essentially a BxP helps to drive the direction of the modelíng effort and
modeling outcomes. How will your consulting team share models? WÜ1 your project need to

provide BIM deliverables such as a reference model or databases m the Constructíon Operations

Building Information Exchange (COBie) format? Does the owner have expectations for a model
deliverable for operations and management? Ali those possibüities and more are explored and

documented m a BxP. It gives the project team a defüútive outcome to develop and enrich

the models.
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Creating a standard BIM execuüon planning process for every project will help teams plan

and carry out the requíred processes to achieve the anticipated goals. By using a BxP template

and a planned methodology/ the project team members should actively pursue these concepts:

• Ali parties should clearly understand and commimicate the strategic goals for implement-

mg BIM on the project.

• Teams should understand and communicate their roles and responsibüities in the project
execution.

• The plan should outline resources/ traming/ or other competencies necessary to success-

fully implement BIM for the intended uses.

• The baseline plan should provide a goal for measuring progress throughout the project

• The plan should provide a benchmark for describmg the process to future participants

who jom the project.

Inexperienced teams trying to implement unfamiliar BIM processes without a BxP can carry

risk such as impact to project cost and schedule. To address this/ if the BxP is well planned and

communicated/ the project team will have set expectaüons of what is to be done and how/

thereby reducing the overall risk to the project. To ensure a successful project execution planning

process, the team should do the following things with the BxP:

• Modify the plan to meet the projecfs needs.

• Build the plan with the entire consulting team.

• Create a MDS and supporting LOD for model elements with the entire project team to
mclude consultants. This will facilitate model and staff plamüng.

• Review the plan early and often/ making needed changes as project experience grows.

For those who are responsible for developmg the BxP for a team/ begin the plan by referenc-

ing mdustry-based templates/ such as the Penn State Project Execution Plan or the Autodesk BIM

Deployment Workbook, that can provide you with shortcuts to a well-organized and consistent

BxP process. Determine what is needed by your project teams and then modify the plan to match

your requirements. Additional language specific to the type of facility and construction should
be added to the plan to make it more appropriate. A comprehensive BxP should mclude
these sections:

Statement of project goals and objectives

Intended BIM uses

Team structure and deUverables

Roles and responsibilities

Data transfers

Phase-based data requü-ements

Intended authoring/ analysis/ and aggregation tools

Governance information

doing these things/ project teams should have no problem developing a comprehensive

that will benefit them on a daily basis.

Optimizing BIM Processes
According to the National Institute of Building Sciences (www. n-i bs. org)/ BIM is defmed as /'a

diïital representatkm of physical and fimctional characteristics of a fadlity" that serves as a
"shared knowledge resource for information about a facility forming a reliable basis for decisions

during its Ufecycle from inception onward." Although ttís defines BIM as a noun used to

descrÍbe the electronic data/ the verb form of building information modeling is equally important.
BIM is both a tool and a process/ and one cannot realistically exist without the other.

Building information modeling implies increased attention to more mformed design and
enhanced collaborati.on. Simply relying on tools to replace your current processes without an

updated corresponding methodology mil yield limíted success In fact/ it may even be more

cumbersome than using traditional CAD tools to execute project work.

Regardless of the design and production workflow you have established in the past, moving
to BIM is going to be a change. Moving to BIM is a shift in how designers and contractors

approach the design and documentation process throughout the entire lifecycle ofthe Project,

from concept to occupancy. In a traditional CAD-based workflow/ represented in Figure 1.3, each

view is drawn separately with no inherent relationship befrween drawings. In this type of

production environment/ the team creates plans/ sections, elevations/ schedules/ and perspecüves

as standalone entities and must coordinate any changes between these views manually.

FIGURE 1.3
A CAD-based workflow

CAD Project

In a BIM-based workflow/ the team creates 3D parametric models to generate the drawings

necessary for documentation and analysis. Flans/ sections/ elevations/ schedules/ and perspec-

tives are ali by-products of creating a buildmg information model/ as shown ih Figure 1.4. This
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e^ïcedïepre.sentatíon methodologynot only aiiows for highly coordmated documentation bi,
also provides the basic model geotnelry necessary for analysrs/suchas~davÏïgh7nTsïudiesu" Dutl
energy usage simulatíon/material takeoffs, and só on. ' ' „ -..-o---^,

FIGURE 1.4

A BIM-based workflow BIM Projecf

Identifying and Planning BIM Uses
Weencourage^you to explore ongoing research from organizations such as Penn State Universit

ngSMART Intemational/and the UK BIM Task Group. Penn State (http :7/bi:m.psu'.ed"uT/
t a catalog ofBIM uses and project implementation guidetínes thathave been

adopted mto the National BIM standard-Úníted States Version3\°htt7:7/7iatTona\'bimstandard
'UL^W^eï ímportant aspect of supporting numerous BIM uses is the development <

^TheorgamzationknownasbuildmgSMART(www.bundingsmart.o^)pro™iï7

nt of such standards. The UK-based CDBB (Centre for Dirit
BuiltBritam) (^. cdbb. cam .ac. uk) is helpmg that region adopt BIM practicesïroufih buSdï

l educational support. Groups from several regional chapters around tíie°worldareG

genemtmg mformation exchange standards that wiU soon have a profound Ímpact onthewavsm

t we share model data with our clients and partners. The followmg are some oïthe"

• Industry Foundation Classes version 4 (IFC4)/ accepted as ISO 16739

• Construction Operations Building Informaüon Exchange (COBie)

• Specifiers/ Propertíes Information Exchange (SPie)

• BIM Collaboration Pormat (BCF)

FoiageneraÍoverview of theapproach to standardizing exchanges with informaüon delív
. (IDMs) and model view defmitions (MVDs), vïsit https': //techmcal"

.build-ingsmart.org/standards/lfc/lfc-schema-spec-ifTcat-i-ons.'

As the industry continues to build processes around fhe technology behind BIM, its potential
continues to grow. Many applications are possible usmg building mformation modeling. As more

benefits are achievable through BIM, teams fínd new uses to explore and develop.

'iffure 1.5 shows some of the potential opportunities that have been identified by the AEC
industry and clearly orgaiúzed by Penn State.

FIGURE 1.5
Service opportuníties

that BIM supports

Asset Management
Maintenance Scheduling

Space Management
Building Performance Analysis

Phase Planning
Construction System Design

Recorri Modeling

Programming
Slte AnaSysis
Visualization/Simulation
3D Coordinalion
Analysis

Code Comptiance
Digital Fabrication
3D Control & Planning

When you are trymg to plan and manage your organízation/s BIM and methodology/ it s

ünportant to think about the use of these processes and technology to achieve your project goals.

One of the primary ways of understanding this is through BIM uses. These many uses can be

organized mto five basic activities: gather, generate/ analyze/ communicate, and realize,

Gather To coUect and manage buildmg information

Generate To create mformation about the building

Analyze To examine aspects or components of the buÜding to make better decisions about

how to plan/ design/ construct/ or operate it

Communicate To collaboratively share information about a building

Realize To build or manage a physical element using building data

Understanding how benefits are derived from these uses will help focus your teams'1 efforts in

planning/ managmg/ and governing BIM processes.

Gather
As architects pursue work and plan awarded projects/ they gather information about budgets,

required functionality/ site context/ and anything else of signifí.cance that is required to make the

best decisions for the project. In an analog process/ this mformation may be gathered in the

building program/ a contract/ or even a cartoon set of drawings required. The advent of BIM

processes and technology is changing thís. BIM not only allows the acquisition of smartly

acquired contextual data about the project but also becomes an improved repository for Ínforma-

tion gathered in traditional ways.

One example of these traditional processes is the creation of the space program. Space

programs are usually developed by mterviewing user groups that are to occupy the building and

gathermg mformation about the things that they do and the equipment they need in the adjacen-
cies of the spaces they occupy. These processes are collected m a spreadsheet ür m graphical
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layouts that^explain their qualities. This type of data is typically used in paraUel with the desis
£lce!s/ -^ ? ï^yplalmers manually puliing mformation into computer-aided drawing i
LTÏ!<LWÍÜI BIM/ this process takes on a more evolved approach to cormecting designdatato
programmatic requirements. Using a BIM process, a designer can input spatialmformation

^Ïcti^mto?he ,model database even before conceptual massmg or área plans are generated.

IÏÍLalÏsrthldes,igner t? t?e directly from the Program information to lay out a design and
get .insta,nt feedback on whether it meets the requíred~'tolerances for these requirements?

AnotheL examPleof gathering mtelligent data could be in the form of lase±rscarmmg'. There

Ï!l?Ïticated tecímologies that auow/or the generation of point cloudsforpreexisTing'
spaces^The generation of these spatially located points can be used as an accurate underSy in

; conditions. WÍth miUions ofpomts available, designers have at their

fíngertips a massíve amount of data Ín which to begin to understand the contexïoftheïdesÍE
This hasmcredible applications for complex renovations or spatially chaHenged sítes oreven
hístorical preservation efforts.

Through this kind of informatíon gathering/ the qualifícation and quantification of data can
T^!r the desi§n team to "nderstand both the Ímplicit and explicit attributes of its projects.
T ?e_pr,ocesses.can al,so.help SUPPOrt estimatíng and cost-forecastmg efforts. Durmg the ea

design phases of a building, quantities may be generally estimated but becomemore certam as

?ÏLC.(mtract documents are created and construction processes proceed. AH aïong/ the stored
informaíion becomes more and more accurate with respect to design mtent

Toward the later part of the construction process and into operations and maíntenance,

pr.(x:esses?nhelp establish real-time performance measurements within faciliües to helpowners

^ÏÏ^nden.ergyus.ase/ ope^a.tíon c sts/ and many other metrics- For example/an integrated
operatlons_andmamtenance,(o&M) sysíem maybe trackíng electrical costs on an hourlyudail

weekly/monthiy, and yearly basis to help owners imderstand where they/re maxïmïzmR/thür7
energy ínvestments and where there is waste that can be reduced.

As iiïustrated m this section/ we hope that you see how information fíatherms can be imoor-
tant throughout the entire lifecycle of a BIM project.

Generate

One of the most common aspects of buÍIding information modelmg, and the one most accessible

to new users/ is the creation of inteUigent geometry. As users draw"a wall/ a mass, or a newïeveí

ü!eyareseneratmg not orúy form buí alsodata that helPS them make informeddesign*decisÏons'.

?I!xa.mple/,when a w,a11 is ?Yawn ín an authoring to°Í íhat object can immediateiy have
attributes such as length/ width/ and height. It may also have multiple materiais/ sïuctural and

h/ as well as cost and a fíre rating. In a CAD process/ the users must mamtain the inteiuïence

thatü'leyattribute to the.obJecfe theyare drawing. Tliey may be able to quicklygenerate7ou7
Imes torepresenta wall that could understand length and width/ but thafs wherethe'ïistinction

ÏÏt?Ies!i.cAD.drawi?ss/ althou,8? theycan contain additíonal information, are mherenüy
!ocusedonthe °utPut/whereas building míormation models inform the outputs. ÀwaU m a

?Ïid-a?!bÏse is thedesi§n-In CAD/ the outputs represent what the users concepíuaTly
maintain in their mind. As smart as we are as architects, we can/t maintain ali theÍnformation

needed to be communicated to the contractor m buílding our designs. That-s where BIM can
begin to support us by maíntaining the mformation for us.

.. Ïn^users8ener,ate ínformation about the Pr°Ject through both geometry and integrated
data/ they are prescribing attributes/ arranging elements/ and determining real-world

dimensions. WÍthin the context of the lifecycle of the building the designers during the plarming
and design phases are the primary generators of geometry and data. During the construction

ise of the project/ the subcontractors will manage most of the data in the modeis. For sophisti-

cated BIM projects/ the construction phase management of as-built data canbe created tobuild a

foundation for the operations phase where that information could be used to operate and

maintam the building. This database that they might maintain could be updated with new
infonnation throughout its entire lifecycle. This might include new equipment installed or

renovations made to existing structures.
As experts generate both geometry and data for the project/ they are specifying qualities and

generating design data. The planner of a building may define spaces m the building/jusï^ as a
structuralengineer may define a structural grid. Later in the project/ a contractor might defme a

sequence as attributes of materiais/ just as the owner's construction man-

ager may define the need for a specific piece of equipment. Because ali these Ídeas are generated

inside the building information model or linked systems that influence this database/ generation

of building data can happen in every phase.
As designeis make dedsions about the spatial configurations of the buildmg, they have a

range of elements in three dimensions. This is the begimúng of 3D coordination processes/ which

is a major asset to BIM practices in terms of collaboration and problem solving. This can begin

with the arrangement of spaces; move to an arrangement of structural systems, through mechan-

ical/ eïectrical/ and plumbing systems; and end with coordmation of frades that are constructing

thebuilding. Because of ali these aspects that occupy space and therefore have some relationship

with one another/ the model becomes a spatial organizer for this arrangement.

Before the opportunities that BIM provides, subcontractors could only determine technical

issues with installaüons as services were being installed. This might Ínclude a piece of ductwork

that does not quite have enough room to move around a beam or a doorway that does not have

enough clearance from the edge of the stair riser. Because BIM provides the ability to simulate

design conditions/ the spatial coordination between designeis/ engmeers, and consultants cai\ be

addressed prior to construction and mstallation. We now have the ability to find mistakes within

a simulated environment and provide corrective actions during the design phase of the project.

This abüity to solve problems earlier in the arrangement of these three-dimensional objects

affords designers and builders a terrific opportunity of designmg better outcomes with much

more cost-effective and timely solutions. In the end/ it's much cheaper to fíx Ít in the computei

than WL the field.
The sizing of geometry is also an important aspect to the generation of information in these

models. Justas spaüal organization is important, the ability to estimate the correct dimensional

aspects of building systems in the specification of equipment is important. Generating sizing

information in a 3D model might take the form of creating types based on standard industry

specifications. Being able to specificaUy model objects that have real sizes and tolerances helps

designers make the right decisions about specifying common building elements and complex

building systems. Typical authormg programs have tolerances built m for the levei ofdetail thafs

required to have buildings constructed accurately. Users have the capability of modelmg much

more accurately than they ever could in the fíeld. Of course/ the caution here is that teams need

to realize that though they can be more accurate in the model/ the ultimate purpose of the model

is to get the building built and mto operation efficiently and effectively. This means sizes should
be based on the requirements of the construction trades; any more information or accuracy

beyond that is not needed. However/ where BIM shines above typical CAD prpcesses is ÍÈS ability

to share truth. It is much more work to hide the true sizes than it is to display them accurately.
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This may frustrate some users who are used to applying their own dimensions/ until they realize

that the models represent what they designed/ whether it is to a standard dünension or not.

Analyze

The primary purpose for the authoring environment is creation and not analysis. Because

geometry and data are combined in a smgle database/ confídence in that interaction allows us to

begin to understand what it is and what it will create. Thís fírst step into analysis begins at the
planning stages. However/ it's common to pull mformation from the authoring environment into

one specifically built for analysis. Youfll find that many processes and tools specifically buÜt for
analysis work in parallel/ and sometimes perpendicular/ to model authormg. The real value in

BIM beyond design documentation is the ínteroperability of model geometry and metadata
between applications. Consider energy modeling as an example. In Figure 1.6, we're compari]

three energy-modeling applications: A/ B/ ana C. In the figure/ the darkest blue (gray) bar reflects

the time it takes to either import model geometry into the analysis package or redraw the design

wíth the analysis package. The lighter blue bar (gray) reflects the amoimt of time needed to add
data not withm the aufhormg environment/ such as loads/ zoning/ anid só on. The Üghtest bar

represents the time it takes to perform the analysis once ali the information is m place.

srns and allowing you to keep the buildmg tuned for optimized energy performance. The

^ppïication of this analysis comes m the Realize stage of BIM uses covered later m this chapter.

FlCURE 1.6

BIM environmental

analysis-tíme

companson

BIM Environmental Analysis Time Comparison

Geometry Manipulation M Adding Load Data El Simulation

In some instances, models authored in one platform may not work directly with analysis

platforms/ such as the example in A and B. This caused the re-creation of the geometry directly m

the analysis tool and also required time to coordinate and maíntain the design and its Íterations

between the two models. The trend of these tools is movmg toward better integration or addi-

tional analysis tools embedded inside the authoring applications. In application C/ model
geometry was direcüy imported mto the analysis package/ saving nearly 50 percent of the time

needed to create and run the full analysis. Using Üús workflow/ you can bring analysis to more

projecte/ perform more iterations/ or do the analysis in half the time.

The same workflow is true for daylighting (Figure 1.7) and other types ofbuildmg perfor-
mance analysis. By designing directly in the authormg tool/ designers are able to move away

from anecdotal or prescriptive design solutions and begín to rely on calculated results.

Buüdmg analysis can reach beyond just the design phase and into the whole building
lifecycïe. Once the buildíng hás been occupied/ the use of BIM does not need to end. More

advanced facilities management systems support tracking—and thereby trending—building use

over time. By trendmg buildmg use/ you can begin to predict usage patterns and help antidpate

future uses such as energy consumption or expansion. This strategy can help you become more

proactive with maintenance and equipment replacement because you will be able to perceive

how equipment performance begins to degrade over time. Trending wÍU also aid you in provid-

ing a more comfortable environment for building occupants by understanding historie use

pIfiOHBl-7
tingoverlayfmm

^5?3dsMax.

Communícate
Using BIM to better visualize a building is a powerful way to commimicate design mtent.

Creating documentation and visualizaüon using BIM gives teams the added advantage of being
able to communicate the design of the project in 3D/ where it is more accessible to project

participants. It Ís especially persuasive for those who are Ínvolved directly with theconslructíon

process but are stiU important decision-makers. Owners can benefit greatly from this type of

communication. In this/ visualization is a valuable tool for making design or construction

decisions. . . „. , . r ...„

Although 3D visualization was initÍaUy conceived as one of the "low-hangmg truits" ot a^

workflow/ this benefit hás led to an explosion of additional perceptions of the design/ mcludmg
isometric details/ renderings, animations, clash detection reports, and só on. This provides a

muchbetter way to communicate design opportunities and decisions between project

stakeholders.
Jxi the 1990s/ if you wanted to create a rendering/ a physical model/ a daylighting model/ an

energy model/ and an animation/ you would have had to create fíve separate models and use five

different pieces of software. There was limited ability to reuse model geometry and data between

model uses. One of the key uses of BD^I is the opportunity to repurpose themodel for avariety of

visualizations; you never have to re-create geometry between uses. Reuse also ensures that

you/re using the most current information m each visualization because it comes from the same

source. As the capacity of cloud rendering and analysis grows/ the feedback wíll no longer need

to process locally/ and you/ll be able to receive feedback faster.

This digital creation of the project hás given us a varíety of tools to communicate its aspects.

Because the model is a single source of truth/ it can be used in many different appUcations for

communicating. Models may be imported into a gammg engine for an intera£tive virtual
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expenence/ aiïowing clients to virtually tour the buildmg at their own pace/ to help understand

how this building wiïl acconunodate their functional and aestheüc needs. These same virtual

models can be physically printed through rapíd prototyping methods such as 3D printíng/
?,eatmg.,smau models ÍFigu];e L8)m a fraction of the time itwould take to build one by hand.
Many other forms of communicating through BIM are emerging as you read this book.

FIGURE 1.8

An example of rapid

protoíyping
using BIM data
Source: HOK

!^ consíder a broad spectrum of representations/ from tabular data to intelligentiy gener-

ated 2D documentation and 3D visualization/ our traditional design deliverables become

transformed. Schedules give you instantaneous reports on component quantitíes and space

usage/ whereas plans/ secüons/ and elevations afford you the flexibility to customize their

display using the information embedded in the modeled elements. For example/ the plan in

f?l?e l-9shows how color fíuscan be automatically applied to illustrate space usage by
hmction. Because this is live in the model/ changes can be made easily/ providíng confídence to

the communicators and the receivers of this information that what they are seeing is accurate "and
can be the basis of valid decísion-maÏdng.

. Ï_pa?ding<2D documentation to ínclude 3D imagery also gíves project teams the ability to
.TrlJ.share tl;eintent ofmore complex designs. It also hás a positive effect on constructionby

reducing translation errors with illustraüve documentation/ rather than ciyptic detailsand

notations. Figure 1.10 shows a basic example of a drawing sheet composed of both 2D and 3D
views generated directly from the project model.

Another obvíousbenefít to creating a complete model of the building is the ability to generate
^K^varifty of 3? imaSesfor prcsentation. These images are used noïonly to describedesign'
?tent_b,IÍt_al,so tomustrateldeas aboutproportíon/ form/space/ and functional relationships. fhe

ease with which these kinds of views can be produced makes the rendered perspective more of a

commodity. As shown in the left side of Figure 1.11, materiality may be removed to focus on the"

buiiding form and element adjacencies. The same model is used again for a final photoreaÏistic

rendermg/as shown in the right side of Figure 1.11. As the model contains information ofboüi

form and function/ it/s up to the commumcator to decide what information is shared. A plan/

pIGÜRE 1.9
Even 2D views can

evolve to illustmte and

analyze spatial

properties.
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tive, and schedule can share common informaüon. Because_they^mem^fe^f^s,
CiiS AÏc&oZ;^atio°n7anb"edÍ&.'rent.That is the .S^^boonofh^m8^mtí^
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FIGURE 1.10
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Source: HOK
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FIGURE 1.11
Two different methods

of using 3D presen-

tation víews
Source: HOK

By adding materiais to the BIM elements/ you can begin to explore the space in color and

light/ creatmg photorealistic renderings of the building. These üiÏages can convey informaUon
about both the intent and context of the design. Iterations at this levei are limited only by
processmg power and user mtent The photorealism allows for an almost lífelike expÍoration of
color and light qualitíes withm a built space even to the extent of allowing analyüc brightness

?_?TS to, re.veal tl,le exac,t ?evels of ught withm a space/but with the added benefít of being
derived directly from the working models. In this case/ renderings can be an embedded process

or a perpendicular instantaneous output. The fírst option would be rendering within the

authoring tool This would produce timely renderings based on the current models but may not

be of the qualíty needed for presentation purposes. More high-end renderings used for market-

mg would normaiïy require exports from models brought into specifíc rendering tools. These

renderings can be more stylized or photorealisüc; however, they are a snapshot in time of the

worlang model and take additional preparation to be useful. Thís in effect ends their BIM
connectivity.

The next logical step is taking these elements and adding the element of time. In Figure 1.12,

you can see a still image taken from a phasmg animation (commonly referred to as a 4D símula-

tion) of a project Not only do these simulations convey time and movement through space/ but

they also have the ability to demonstrate how the buildmg will react or perform under real
lighting and atmospheric conditions. AU of this fosters a more complete understanding of the
constructability and performance of a project before it is realized. This is aÏso a common method

when trying to understand construction sequencing by contractors as they are planning the
buildíng of the facility.

Realize

pie use of BIM can potentially remove the direct human mput to develop specific elements of
the facÜity. Using the data generated through BIM-based planning and design processes to
fabricate or manage buüding elements of the facility allows facílity owners to reaUze some of the

most beneficiai aspects of the entire endeavor. Using BIM for facility management can enable

owners to take advantage of the faciUty data throughout the building's lifecycle to support safe/

effective/ and efficient environments. The maintenance of this data can improve efficiencies

through havmg accuiate as-builts. It can promote the optimization of operation and maintenance

of the facility's systems to reduce energy usage. Let/s explore two mam concepts of BIM realiza-

tion: assemblage and contrai.

FICÜRB l.l2
AstiUfromanamma-

tionshowingaccurate

pbysicalconditíons

forthepwject
Source: HOK

Assemblage By developmg building information modeling/ you can replan buildmg
elements way before they are actually fabricated and assembled. This can mclude the specifi-

cation of existmg systems or the design of custom systems to be mstaUed in the faciUty.

Examples include picking a water pump that fíts both the functional requirements and the
spatiaÍ requirements of a mechanical space or the opportunity to prefabricate a custom

receptionist desk for a highly designed lobby space. Durmg the projects' early phases/ these
processes can be used to generate multiple design schemes. For construction these processes

can help the contractors to imderstand the process of bringmg materiais on-site and how and

when they should go together. It might also inform them how to pre-assemble custom

systems for delivery to the project site/ preventing cumbersome storage or barriers to success-

fui assemblage such as poor weather or mÍsmterpreted documents. Bemg able to assemble

systems withthe aid of machines, such as CNC (Computer Numerical Confa-ol) systems/ can

reduce not only costs but also the time needed to install components in the facility. Examples

of prefabrication might mclude wall systems/ ductwork/ and curtamwaiï.

Contrai Building information modeling also allows operators of the facilities to help
manage and maintain the equipment and systems once they are installed on-site. If a database

was created during the plaiming, design/ and construction phases of the project to ensm-e that

ali as-built systems are well documented with specifíc properties associated with each system,

operations and maintenance stakeholders not only wül have a better knowledge of what

systems they have but also may have some automated processes that conld schedule mainte-

nance requests or connect in with building system analysis tools. When you do ananalysisof

the life span of a building/ you wiU see most of the time is m the occupancy stage. This really
means that most of the money spent on the facility is running it. If BIM can help reduce the

costs of operatmg and maintaming a faciUty, this becomes a huge benefit to owners that can
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. rfa ^ throygh a building information modeUng process. Architects are the primary
origin of this mformation that can help owners achieve these benefíts. A good model-based

database can help an owner solve mamtenance issues more quickly/ may be able to find

potenüal issues more readüy/ and can help with plannmg future construction much more

easüy.^The use of this data to regulate facility systems potentially allows facitíty operators to

optimize their operations. It is even possible that in the fuhire/ buüding systems could be

?.utom?ted,be/cause °lmformation generated by Bm. Being able to plan Üie system integra-
tions ahead of time allows for more intelUgence built into the facüity. An example of this is

na thermostat ls programmed to modify the settings of the HVÀC system in response to
£^PrSsraI?med rules byits connection to an intelligent monitoring system/ enabledby the
BIM. Benefits such as these can really help owners optimize the operations and mamtenance

oí tí-ie facÜities and demand more services from its designers/ such as yourself.

Integrating Tools inside a BIM Workflow
As you have read with the explanations of people and processes involved with BIM/ the last
aspect to discuss is the technology. Without the technology/ you would not be here; it supports ali
the other things that make buildmg information modelmg possible. The Üüng you may not
realize is that even though it is the foundation of ali these other great opportunities and benefits,
it is still a lesser aspect of the entire BIM ecosystem. This may confuse some readers, but in ow

!xperience/ ^e,fmd that the most meanmgful changes happen with the people deploying these
Fir?essesi ïd the methodolosy they takem transforming their work. The tools that people use m
their workflows to generate geometry and data change only slightly from year to year.

Tecímology is constantly being improved, made more efficient/ and better integrated with other

to? ?,m IIÏa?et"Yc>u as,an índividual user have litüe influence over Üús. Understanding the
existmg capabílitíes of tools is important; however/ change in the technology sense is muchmore
limited than improvements to your process and skill sets.

The purpose of this book is to cormect your knowledge as a person with the best understand-

mg ofan authormg toors capabilities. That specifíc authoring tool/ of course/ is Autodesk®

Revit®. Commg to tNs realization/ the user must understand that an expert of the software is not

an expert in BIM. Many people know the fimctions of the tool based on learning or experience

but stiU do not have a grasp on why they should do something and when they should do it.That
comes with having a better understanding of not only why BIM is beneficiai but also how aU-

Í TeitMn?^me.together to crea.te an architectural zeitgeist. Throughout this volume wehope
to make contributions to your understanding of ali three'and to help"you make the connection

between opportunities in the applicatíon and a methodology to deploy them/ with theoveraU
sense of what it means to your project and to your organuation.

What Is Revit?
Reyit is a BIM application for authoríng parametric 3D models that generate geometry with
embedded information for the design and construction of buüdingsand mfrastruchire. It is from

these mteUigentmodels thatplans/ sections/ elevations/ perspectives/ details/ and schedules—all

ÏlI,teSess?ry lnstrumentsto document thedesign of a buildmg—can be derived. Drawmgs
created using Revit are not a coUection of 2D lines and shapes Üiat are interpreted to represent a

building, but live views extracted from virtual buildmg models. These models are a compiÍation

of mtelligent components that contam not only geometric attributes but also data informing

decisions about the building at every stage of the process/ includmg occupancy.
Elements in Revit models are managed and manipulated through a series ofparameters that

^vewill discuss m greater detail throughout this book. These elementshave bidirectional

associativity/ aUowÍng the user to change the 2D views to change the 3D model or to change the

3D model to change the 2D views. If you move a dooï in a plan, that door is moved in ali the

elevations/ sections/ perspectives, and só on/ m which that object appears. In addition/ ali

th.e elemenfs properties contain information intemally, which means that mtelligent annotations

are directly linked to the objects. These tags dísplay the objecta data directl^ ratherthan a
inanual erítry interpreted by the user. When contrasted with traditional CAD tools that store
eïement information only in the annotation/ Revit gives you the opportunity to more easily mput,

manage/ and export your project data for project coordination and execution.

The Bottom Line

Focus your investment in BIM. Since using Revit is a change m workflow/ it is also impor-

tant to'understaTLd the change in staffing and who is needed to perform what roles on

a project

Master It What are the three primary roles m a Revit project/ and what are the responsi-

bilities of those roles?

Understand a BIM workflow. Understand how projects are completed in BIM and how the

use of Revit on a project can change how mformation within a project is created.

Master It Explain one of the primary differences between a more traditional 2D CAD-

based workflow and producing documents using Revit.

Leverage BIM processes. Understanding the levei of risk your firm is willmg to take in new

technologies will help you establish goals for your future use of BIM.

Master It Using the three áreas of firm integration (visualization/ analysis/ and strategy)/

define how those áreas overlap for your firm or project.



Exploring the UI and
Organizing Projects

After more than a decade in the architecture, engineering, and construction (AEC) industry, Revit

continues to be unique in its combination of powerful features and ease of use. Revit may not be

the absoluto best tool to design and document every imaginable building type/ but its features

and functions make the vast majority of production tasks much more efficient and accurate.

Revit is a completely bidirectional/ multiuser working environment/ unlike other 2D com-

puter-aided drafting (CAD) or 3D buÜding infonnation modelmg (BIM) tools. Instead of talking
about layers and vectors, you will be using terms such as projects, componenis, and pa.rameters along

with tools such as Wall/ Doar/ and Floor. The concepts and terminology should seem familiar if

you have experience m the buildmg industry; however/ transitionmg to them can be a daunting

task if you are more familiar with draftmg terms than construction. This chapter provides an

overview of the Revit user interface (UÏ) as well as the key aspects of data organization within
a project.

IN THIS CHAFTER/ YOU/LL LEARN TO

• Understand the user interface

• Understand project orgardzation

ünderstanding the User Interface
The UI is based on the Windows ribbon íramework that is also found in software applications
such as Microsoft Office. Within Revit/ you will fínd many commands and tools that use similar

dialog boxes and workflows. For example, you will not fínd disparate dialog boxes for door

properües versus window properties. Persistence of tool location is another key to Íncreased

usability. Even though tools remain contextually exposed or Hdden/ the majority of them can be

found in the same place relative to the overaU UI.

As you re learrúng the interface/ keep in mmd that the interface presents a tooltip for every

element. This tooltip hás two stages. The farst stage/ which appears when you first mouse over

the tool/ provides the name as well as an option to find out more mformation from the Help

menu by pressing the Fl key. Most tooltips provide a second stage that gives you an additional
description about what the tool is typically used for. A new user can learn a lot just by mousmg

over various parts of the interface.
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You have the ability to access ali three disciplines of the Revit suite—Architecture/ Structure.

and MEP. This functionality is addressed in the "Gettmg to Know the Ribbon" section of
this chapter.

Figure 2.1 shows the Revit UI. To íllustrate some different project views/ wefve tiled four vieív

types: plan/ elevation, 3D/ and sheet. In the following sections of this chapter, we will review üie
major components of fhe UI.

FIGURE 2.1

The Revit UI

Accessing and üsing the Application Menu
Cfíck the File tab just under the big R in the upper-left comer of the UI (Figure 2.2) to open the
Application menu and access commonly used commands such as New/ Open/ Save/ PrÍnt,
and só on.

In the upper-left comer of the dialog/ there are two icons for both recent documents and open

documents. Recent Documents lists the last several fíles Üiat youfve opened/ no matter the

Ipcation. Open Documents shows you ali the files you currently have open/ as Revit allows you

to load multiple fües at once This is a great tool in case you have many views open and you

want to quickly go to a specific file you/re working on. New to Revit 2020 is the Home button,

located to the right of the big R. Clicking Üiis wiU toggle over to the Home screen that appears at
the start of Revit 2020/s launch (Figure 2.3). It wiiï list recent model and family files as well as
common fíle commands. Clickmg the Home button agam will toggle back to the ribbon UI.

Many of the tools that allow you to open or save multiple formats Ínclude flyout menus that

help you specify dífferent options. For example/ when you have a project open and you choose

Save As/ you can save your project as a typical Revit file or as a template to be used as a basis for

future projects. Dialogs like this will also limit you to Üie operations that you can do currently. If

you have a project file open, you cannot save it as a famüy file; Revit wÍU gray that option out/

visually informing you that this is not a valid operation. These dialogs are nice in that you can

customize locations for opening and saving certain file types. When you open the Open dialog,

you'11 see a list of shortcuts to the left that give you quick access to your desktop, favorítes/ and

even the history of your most recent navigation. What/s nice about this dialog is that you can also

create additional locations based on your current workflow. Creating a shortcut to a Úbrary of

components or to your project folder will help save you time when you're navigatmg between

files. The Export option allows you to take your existing lnodel and conyert to anew format

formais/ DWF/DWFX/ FBX/ gbXML/ IFC/ and ODBC database). Use the Close command

to quickly dose a project or family without closmg every open view.

FIGURE 2.2
.TheApplÍ"tionmenu
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-when.arcessmg some of the flyout commands m the AppUcation menu/ be aware that ther.

3e additional commands or optíons on the flyout that are hidden. This-is mostevidentl

í command flyout/ m which you must scroU to the bottom of the flyout-to accesT

expOTÍmgoptions for Industry Fo^dation Classes (IFC) and others. If you click thebutton
^g the ÏÏyout/ you are choosing the default option.

Using the QuÍck Access Toolbar

ïh€.QmckAccess toolbar (QAT).allows y"u to keep frequenüy used tools at your fingertips.
some.commonly used commands are mcluded by default in the QAT/ïut youTanaStom^e it
meet your own needs. - - . ^ -- —-. --^^^^^

Right-dickjmybutton in one of the ribbon tabs/ and you will fínd the command Add To
Quick Access Toolbar. By clickmg the small/ down-facmg arrow to-thefa7nghtlofThïoATUvn.'i,

fmd thattooh, may be further customized/ grouped/ or removed fromthe tombar Íie^e2/J
íefauïthe QAT bar is above the ribbon/ but you also have the °Pti^ toïow^heQXÏbeW0
the ribbon.

FIGURE 2.4

Customizing the QAT
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Wíth the QAX you alsohave the option of temporarily híding quick access tools based on the
flyout arrow on the fa^-right side. With this/ you could quickly âeckorunchecFQATto^^^^^^
on your current workflow/ without having to re-create the shorteut.

Using the InfoCenter
To the far right of the QAT is the InfoCenter (Figure 2.5).

||,I6URE2.5^
foeInfoCenter

Froni left to right/ you have the abÜity to search for help solutions/ sign in to Autodesk A360
to access onlme services that integrate with Revit, open a website to the Autodesk App Store ^

Revit and then open the help content.
Because Autodesk continues to move toward more cloud ser^ices/ we recommend making

sure you have a login for your system. This helps with other things such as collaboration/ and it

is going to make it easier for you to take advantage of aU the capabilities that the software

hás to offer.

Getting to Know the Ribbon
The ribbon is the primary location for accessing the commands and tools you will use in the

application (Figure 2.6). Every program usmg Microsoft/s ribbon interface is different, and some

software developers and compames develop their own unique interfaces and ways of working.

Revit is a great example of this. You can laimch commands and tools by selecting icons in the

ribbon/ or you can create customized keyboard shortcuts as an alternaüve. Refer to Chapter 3,

"The Basics of the Toolbox/' for more Ínformation on keyboard shortcuts. Throughout this book,

we will refer to the ribbon frequently/ só you should be familiar with its basic parts: tabs and
paneis. Tabs are the categories of tools, and paneis are the subcategories orgarúzed into icons.

FIGURE 2.6
The ribbon
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The organization and size of the icons withm each panei on the ribbon wÜl change sUghÜy as
you scale the size of your application window. As the application window gets smaller/ the icons

will decrease in size and will sometimes stack, or the descriptions will be hidden.

TOURING THE TABS

Tabs are the highest levei of organization and are used to select from among the various groups

of functionality. There are up to 14 tabs along the top of the ribbon. We/ll take a moment to

briefly describe them.
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File^The RevitFile tabcontains ali the feahires for the AppUcaüon menu/ as previc

i. (See "Accessing and Usmg the Application Menu//)

tchulTe;stmcture/ or sysíems when you msta11 Revit/ you will have access to the t
^treLdeso^dróciplm^ you cancontr01 the visibiÏityoftheïe^MArïute^^^^^

ïmciure^nd sy^;ms) from the °ptions dialog box(^^

^lnKiT^LI^as.becom^c0^^^^^
lm^TO^"ab°rati°n-Note'asofReïIT20ï9^

l^püonLThese tabscontam tools you will use to create or place contenïspecÏfiïto ^T
d£s^à'scipïwe-AtthÊend of the tabs bar/ there isatoolïhïaÏÏowsl

Ianatíons.ofd?playmg tabsand Panels-This is really u^l only ifyouare^ymstorn
the real estate that is available to your working views.

FIGURE 2.7

Setting the UI options
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Inserí.The.Insert tab is usedto Iink or imPort external ^s (2D/ 3D, image/ PDF. and other
RCT"^^wth.the/ile,^mamRW):TO'ta:e^^^
L;oadFamüy command írom this ^ however/ this same-commTnd7isavLaiÍable^°m^

^S^™.andlmAlróntextual tabof the ribbon.LeammorTaboutÏnlang^^
^chTl^^workmswith^^^ and "sÍngotherfíleformatFmChaptS ^'

T: Working Multiplatform/' " ~ -- -"~r ~" ''

Annotate The Annotate tab contains many of the tools necessary to annotate/ tag/ dimen-

sion/ or otherwise graphically document your project. Learn more about these tools in

ter 17, "Detailing Your Design/" and Chapter 19, "Annotatmg Your Design."

Analyze The Analyze tab contains the tools necessary to modify energy analysis settings
and to run an energy simulation via Autodesk Insight®. This feature requires an Autodesk

Subscription account to access the online analysis engme. Leam more about conceptual

energy analysis m Chapter 22, "Conceptual Design and Design Analysis.

Massing & Site The Massmg & Site tab contams the tools necessary to add massmg and
site-related elements such as toposurfaces and property lines. Leam more about modeling site

context in Chapter 3 and in Chapter 9, "Advanced Modeling and Massing/'

Collaborate The Collaborate tab contains the tools that you/U use to coordinate and manage

the project within your own team as well as across other teams and theü- linked files. Learn

more about worksharmg m Chapter 5/ "CoUaboratmg with a Team/ and interdisciplinary

coordination in Chapter 6.

View The View fab contains the tools that you'U use to create ali your project views/ 2D and

3D/ as well as schedules/ legends, and sheets. You can also modify your UI from this tab,

including your keyboard shortcuts. Leam more about creating mnltiple project views and

sheets in Chapter 18, "Documenting Your Design."

Manage The Manage tab contains tools to access ali your project standards and other

settings. You will also fínd the Design Options and Phasing tools on this tab. You can find
additional tools such as Review Wamings and Select by ID on the Manage tab that will help
keep your project rurming smoothly.

One of the most important settmgs that you'11 use during your project is Object Styles on
the Manage tab. Selecting this option wÜl allow you to manage the global visibility settings
for just about everything in your project: how it projects/ how it cuts, and its associated color

and pen weight. Leam more about this and other project settings in Chapter 4/ "Configurmg

Templates and Standards."

Add-Ins The Add-Ins tab appears only when additional extensions have been installed. It

contams the tools that can do a variety of things based on additional applications created

through the API (Application Programming Interface). Many third-party companies/ such as
Ideate/ BIMobject/ and even Autodesk/ have written additional applications that supplement
the functions of Revit. These may include enhanced analysis or management processes.

Modify The Modify tab contains the tools used to marúpulate the content you/re creating m
your project. You'U find tools such as Cut, Jom, Move/ Copy/ and Rotate/ among many ofhers.

Learn more about common editing tools in Chapter 3.

Contexhial Tabs Contextual tabs are revealed when specific elements are selected or

element creation commands are launched. For example, the Modify | Walls contextual tab

(Figure 2.8) is displayed when a wall is selected. These unique tabs are usually colored green
to help you distinguísh them from other static tabs in the ribbon.
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FIGURE 2.8
Example of a con-

textualtab
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A simple/ yet important/ setüng that may be exposed on the contextual tab when pladng

model content is Tag Qn Placement. Modeling commands such as Door/ Wmdow/ and

Component allow you to enable automatic tagging to reduce overall documentaüon time. If

you are workmg in an early design phase/ you may want to disable the Tag On Placement

setting/ unless you have separate presentation views created.

PLACING PANELS

Within each fab in the ribbon are groups of tools and commands referred to as paneis. li you want

to make any panei consistently avaÜable for easy access/ you can pull it out of its tab and arrange

it anywhere onyour computer screen. To relocate a panei/ drag the panei out of the ribbon usmg

your mouse pomter on the panei title bar (Figure 2.9). The panei wiU snap to alignment with
other paneis you have previously dragged from the ribbon if you hover over other floatíng
paneis while dragging. These changes are persistent beyond a session of the software andwill

retain their new position every time you restart Revit until you choose to change them again.

FIGURE 2.9

Paneis can be relocated

anywhere in the UI.

To retum a panei to the ribbon/ haver the mouse pointer over a floatmg panei and the panel's

border will appear. Click the arrow in the upper portion of the gray bar at Üie right of the
floatmg panei.

On some paneis/ you will fínd that settmgs can be accessed from the panel's title bar. You can

see an example of these feahires on the Aimotate tab of the ribbon. In Figure 2.10, the small arrow

on the Text panei is known as a dialog launcher and will open the Type Properties dialog box for
Text (not shown in Figure 2 10). Clicking the down arrow on the Tag panei exposes sinexpanded
panei that displays the Loaded Tags And Symbols command.
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Üsing Other Aspects of the ÜI
Now that we've covered the fundamental elements contained in the ribbon/ lefs look at other

important aspects of the UI.

OPT10NS BAR
The Options bar is located directly below the ribbon and is a contextuaUy sensitive área that

feedback as you select tools and objects. In Figure 2.11, you see the options available

Eelowthe ribbon when the Wall tool is active. You can also use the Options bar when an object

already placed in a project or family is selected.

FIGURE 2.11
Options appear in a bar

•below the ribbon.

An especially important and frequently used option is mcluded with any armotation symbol:
the abüity to include or exclude a leader. TNs will help you place tags in the clearest location
within your documentation whüe maintaming a parametric relationship to the associated model

element. Look for this option when you use the Tag By Category command from the Annotate

tab in the ribbon.

PROPERTIES PALETTE, PROJECT BROWSER

The Properües palette contains the parameters of whatever youfre currentlyworking on and

shows the instance parameters by default. In this palette/ you wiU fínd the TypeSelector/ a

selection fílter/ and the Edit Typebutton (Figure 2.12). Yourll learn more aboutfiltering selected
objects in Chapter 3, as well as much more about parameters in Chapter 15, "Designing with the

Famüy Editor.
The Project Browser (Figure 2.13) is a hierarchical listmg of ali the views/ legends, schedules/

sheets/ families/ groups/ and Imks in your project. You can expand and collapse the project tree

by selecting the + and - icons.
You can search for elements by ríght-cUckíng any item in the Project Browser and selectmg^

Search from the context menu. The simple search function wiU highlight any view/ sheet/ family/

or type with the matching text in its name.
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FIGURE 2.12

Properties palette

FIGURE 2.13
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FlGDRE 2.15
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3Ject views and assemble them in this working space (Figure 2.16). Zooming in and out is
fluid/ and you/re not limited to the extents of one drawing área.
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As of the last release of Revit 2019, views are no longer constrained wifhin the boundaries of

the Revit (UI). You can completely undock a view and drag the window to a different área of
your monitor or to a second monitor. Prior to this/ the only way to work on Revit across multiple

monitors was to stretch the UI. To undock a view/ click the appropriate view tab/ and drag away

from the UI. To redock the view/ click the appropriate view tab and drag back withm the con-

straints of the UÏ; you will see a highlighted blue boundary notifying you that it is gomg
to re-dock.

VlEW CONTROL BAR

The view contrai bar is at the bottom of every view and changes slightly dependmg on the type
of view (Figure 2.17). For example, sheet views have only two buttons/ and perspective views do

not have a scale option. Figure 2.17 shows three view windows tiled to iüustrate some of the

differences in the view contrai bar. From top to bottom, you can see the view control bar for a

sheet view, a plan view, and a 3D perspective view.

?IGURE 2.17
ÍView contrai

|;bar examples

Some of the buttons in the view control bar are just shortcuts to view parameters that are also

available from the Properties palette. Scale/ Detail Levei/ Crop \riew, and Show/Hide Crop

Region are found in botih the view contrai bar and the Properties palette. The Visual Style button
allows you to select from a short list of graphic display modes that can be customized in detail
with the Graphic Display Options m the Properties palette.
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Other buttons in the view contrai bar are unique commands and sequenced from left to ri(

• Temporary Hide/Isolate

• Reveal Hidden Elements

• Worksharing Display

• Temporary View Properties

• Show/Hide Analytical Model

• Reveal Constraints

The Temporary Hide/Isolate command helps users more readüy see specifíc elements while

working m a view. When you select an object in a view wmdow/ use tí-ús button to select from

various tools to hide or isolate eÍÜier the selected objects or the entire category of objects.

Temporary visibility states do not affect printing/ and the view window will display with a
turquoise border untiï the temporary visibility is reset.

The Reveal Hidden Elements button highlights any elements that are hidden in the current
view/ either temporarüy or through other methods. When in this display mode, the view windoivl

hás a magenta border until the mode is disabled.

The Worksharmg Display button is available only on projects where worksharing is enabled.
This mode can be enabled and configured in any view to illustrate Checkout Status/ Owners/

Model Updates, and Worksets. When in ti-ús display mode/ the view wmdow will have an

border untíl the mode is disabled. Refer to Chapter 5 for a detaÜed explanation of these visibil-
ity features.

The Temporary VÍew Properties command when invoked is mtended to allow a user to make

temporary graphic changes to a view such as visibility graphics/ scale, and view templates. Whï

in this display mode/ the view window will have a purple border until the mode is disabled.
the next section for more details.

The Show/Hide Analytical Model button allows you to quickly display analytical graphics
that are commonly used by the Structural or MEP tools in Revit. Fmally/ the Reveal Constraints

button temporarily displays ali the model-based constraints visible m the current view. This is

useftd for troubleshooting model elements that might not be behavmg as expected.

TEMPORARY VlEW PROPERTIES

You may also temporarily modify view properües or apply a view template. When you click the
Temporary Víew Properties ícon in the view control bar/ you wül have a choice between two key|

options/ Enable Temporary View Properties or Temporarily Apply Template Froperties, as shown]
in Figure 2.18. Because these applied properties are only temporary/ when prmtmg the view,

Revit provides an option to print with or without the temporary settings. The Temporary View

Propertíes will not be saved with the project.

If you select Temporarily Apply Template Properties/ you can select from any view template
tabÍished m your project. Once a view template is applied to the view with tíus tool/ the view

wül be highlighted with a purple boundary/ as shown in Figure 2.19. Refer to Chapter 4 for a

detailed review of view templates.
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pïOpertiÉSâF

Purple Boundary denotes
active Temporary View
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FIGURE 2.18

Temporary View
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TemporariiyApiiïÍyTemplatePfopcrfe".

Referring to Figure 2.19, you wiïl notice that any recently appUed view templates will appear
in tíie Temporary View Properties menu. Thig allows for rapid application of templates to
increase your productivity when manipulatu-ig views for various working scenarios.

The other command selection is Enable Temporary View PropertiËS. This mode allows you to

change any view properties manually. The result Ís the same as temporarily applying a view
template/ but you can tweak any setting to your needs. For example/ you might want to tempo-

rarüy hide ali the furniture in a view.
To remove the temporary settings, you can simply wait until you dose the project file because

the temporary settings are not saved. Otherwise, click the Temporary View Properties icon again

and select Restore View Properties.

GRAPHIC DlSPLAY OPTIONS

The Graphic Display Options dialog box gives you access to some of the same settings you can
select in the view control bar; however/ more refinement options are available. From the

Properües palette/ click Edit m the Graphic Display Options property fíeld/ and explore the
graphic settings you can customize for the current view (Figure 2.20). As an altemative/ you can

click the Visual Style icon (the smaU box) in the view control bar and choose Graphic Display
Options from the pop-up menu.

Many graphic options are available/ mcluding customized backgrounds/ photograpNc
exposure/ and a transparency slider. Experiment with a variety of the settmgs to see which ones

meet your presentation and documentation needs. By savmg them as view templates/ you can

group various settmgs for better comparison and contrast You will learn much more about

graphic styles m Chapter 12, "VisuaUzation."
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Graphk OÍsplay Optíons
WORK PLANE VlEWER

Most modeling tools and commands require an active work plane on wHch to place geometry.

When you are working in a piau view/ the work plane is usually set to the current levei associ-

ated with the view. In a 3D, section/ or elevation view, the defírútion of an active work plane may

be a bit more confusmg. In addition to leveis/ work planes can be defined as reference planes/ a

structural grid/ or a surface of another object To help you visualize an active work plane/ a work

avaílabíe in Revíf. Be aware thaf an active work plane could be perpendicular to

orientatíon if the view is adjusted three dimensionaUy.

The Viewer option is located on the Work Plane panei of the Architecture fab. This viewer is

available from ali model views when you're in the project enviromnent. By default/ the work

)lane is based on the active work plane of the last active view. But when you enter Sketch mode

(for example/ when you are creating a floor or a roof), the active work plane is that of the sketch

re 2.21). Só even if the project window shows a 3D view/ the viewer shows the plane of the

sketch—and you can sketch directly in the work plane viewer! This is useful for working on

sloped surfaces such as roofs.

ÍJPICVRE 2.21
ISketch mode with active

Iwork plane

Navigation Methods
One of the chaUenges of any 3D modelmg software is creating methods of navigation that are
mtuitive. If you have used more than one modeling applicaUon/ such as Rhino/ SketchUp/ or

Digital ProJect/ you will know that there is no standard 3D navigation functionality. As is fhe case
wíth Revit/ Autodesk hás consistent navigation tools across most of its mdustry-based applica-

tions such as AutoCAD® and Navisworks®. These mclude the VÍewCube® tool/ the

SteermgWheels® tool/ and basic mouse controls.
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VlEWCüBE
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FIGURE 2.22
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STEERINGWHEELS

^oïer,mithodofnayigation that is unique to Autodesk software is the SteerinsWLeeJs tool.

^:'r^^£t^^^ï?k^^^
tThlsTmgwheelswmfollowyourmou^pom^

Stop when the mouse movement slows, allowingyou to hove7thTmo^e;o^e7o^Ze"'oIf'the

^mand áreas on the wheel. As you hover fhe mouse pointer over a navigation command'

-idhoïdthe left mouse button while moving the mouse to activate the corresponding

Te^ionmethod^There are many ways to custoinize the SteeringWheels/ ali accessible through
^eel menu m the lower-left side of the tool. This iseasier to demonstrate than explainm

^t/"sofeeÍïee to try the various modes of the SteeringWheels tool as you continue through

If vou use a laptop or mobile workstation without the benefit of a mou?/ the SteermgWheels

canbe a welcome substitute for traditional pointer-based navigation. The touchpads^or

;sticks on most laptops do a poor job ofemulating the press-and-drag motions of a
iïlong with simultaneous keyboard button combinations that drivenaüye navigationm^

^Tiïyoïre struggÏÍng without a mouse connected to your laptop/ try the SteeringWheels tool

and you míght thank us!

NAVIGATION BAR
Access to the most common navigating tools is also provided m the Navigatun bar located ^ the
2ghïside ofïediawing área. From here you can launch any of the SteeríngWheels and ali íhe

zoom/pan commands ft-om the flyout buttons.

NAVIGATING WITH THE MOUSE
As with most modem design applications/ the mouse can also be used to navigate in any vïew.

Youarïnotconstramed tousmgthe ViewCube, SteeiingWheels, or Navigation bar. Vou might

hawaÍready fígured out that pressing the left mouse button selects objects and Pressm^the riSÍ
mouseïutton accesses context menus. We discuss selection methods with greater detail m

ter 3. For now/ lefs review how you can use the mouse to navigate the views in Revit.

r view/ press and hold the wheel button on your mouse while moymg ^rolmd

se pad. Holdthe Shift key and use the wheel button on the mouseto orbit aSDview^
The mouse wheel can be used to zoom m and zoom out of any view/ but the zoommg may be

somewhat choppy. Hold the Ctrl key and press the wheel button while movmg the ^ouse
forwardto zoomout (pushing the model away) or backward to zoom m (pullmgthemodel
toward you). Vou wilÍ also notice that the views wiU zoom m and out with a focal point based on

the locatíon of the mouse poínter.
"In camera views, zoommg works a bit differently. Scrollmg the mouse wheel zooms in and out

but mcÏudes the vieWs crop region. To adpst the view withm the crop region/ only the

SteeringWheels and the ViewCube can be used.
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Defíning Project Organization
If you have experience with 2D CAD soítware, you are likely familiar with many of the ^
and concepts related to desigrúng and documenting a project/ but not ali of Üiem have exact

equivalents in Revit You may be comfortable with thinking in terms of what needs to be dra^

and coordinated: plans/ sections/ elevaüons, details/ schedules/ and só on. Such information is

likely stored in a plethora of separate files that must be linked together m order to reference

parts of a building design. For teams collaborating in the design process/

accustomed to allowíng only one person in one file at a tíme. With this/ maintainmg aliyour

project settings and standards is a struggle across só many disconnected files.

Working m the Revit environment affords you much more control and effíciency in managinJ

these issues. From within a smgle/ bidirectional database/ Revit organizes these project organiza

üon aspects: datum objects/ content/ views, and management Figure 2.23 shows what we like to-

think of as a Revit organizational chart/ which gives you a visual description of these four

categories and what these categories contam. In the following sections/ we/ll discuss each of

these categories and describe its particular role in your RevÍt project environment.

Introducing Datam Objects
Data (plural) are sometimes referred to in Revit as datum objects and consist of references/ grids,

and leveis (Figure 2.24). Datum objects establish geometric behavior by controlling the location
and extents of your content (the buildíng/ the stuff that goes m a building, and the stuff you need,

to document your biúlding).

Reference planes can be created in any 2D view from the main ribbon tabs (Architecture/

Structure/ or Systems)/ but once created/ they may not be visible Ín 3D. After you add reference

planes to your project/ they can be set and seen from the Work Plane panei. This will allow you to

work with respect to the desired work plane.

Grids are used to locaíe structural elements in your project You are not required to include

grids Ín your project/ but they are quite useíul in managing structural walïs and columns. Like

reference planes/ grid línes can be added to any 2D view. Keep in mind that grids can be perpen-

dicular only to leveis. Fuïthermore, gríds are visible only in views that are perpendicular to the

grid. Só, if the grid is m a north-south orientation/ you'11 be able to see it only in plan and from

the east-west orientation.

Leveis are datum objects that are parallel to the ground plane. They serve several purposes.

Pírst, they are the main method for placmg and managing the elevation (or Z-location) of

content. Virtually ali content placed in a Revit model hás a Levei parameter. You can even move

objects from one levei to another simply by changing this property in the Properties palette.
Leveis also functíon as constraints for objects such as walls and columns. These objects have top

and bottom constraints that can be set to leveis só that they wíll automaücally update if the leveis

are adjusted. Leveis may be seen and created only in elevation and section víews; therefore/ you

can't create leveis in plan view, and they can/t be diagonal to the ground plane.

iRevit Organizational Ctiart|

7Represertations)J flUlanagement (Restrictions}]
patum (ReialionsHip^) (COTteirt tRe^titiof.i
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FIGURE 2.24

Datum objects

Creating any datum is easy. Simply select the desired tool from the Architecture tab and then

pick two pomts to defíne the start and end locations. Despite their two-dimensional appearance/

ali datum objects have three-dimensional extents that help you manage their appearance

throughout a project You will explore this further in the section "Explaining 3D and 2D Datum
Extents" later in this chapter.

CREATING AND DUPUCATING LEVELS

In the prevíous section, we discussed the overall purpose of datum objects; however/ there are

special conditions related to the creation of leveis. First/ you should understand that a levei does

not always require an associated plan view. Leveis that have plan views wilï have a blue graphic

symbol at the end (double-click it to go to that view)/ whereas those that don't will have a black
graphic symbol. The blue represents hyperlinked data/ which you can fínd on leveis/ section

heads/ and other annotations. When you create a new levei, you have the option to create a

correspondíng plan view by using the Make PIan View option from the Options bar.

Copying an existing levei will not create the corresponding plan víews. This is useful if you
are workmg on a larger project/ such as a high-rise, and you want to quickly configure multiple

leveis without creating them one at a time. You might also want to use leveis just as a reference

for content but not for a specifíc plan/ such as for an intermediate landing or mezzanme.

Although it is easy to create many leveis by copying or arraying, only create the leveis that are

necessary to manage major parts of your project and that need to be shown in your documenta-

tion. You do not need to create a levei for every slab/ stair/ or floor offset/ as objects can be shifted

in the Z direction offset for any levei. Too many leveis can have a negative impact on your

projecta and your performance/ as they take resources to manage.

Lefs explore the creation and duplication of leveis with an exercise. First, download and open

thefilec02-Levels-Start.rvtorc@2--Levels-Start-Metnc.rvtfromthisbook/s

.wiley.com/go/mastenngrevit2020.

Then follow these steps:

l. Open the exercise fíle and make sure the Project Browser is open—remember that it may

be in a tabbed palette with Properties. Expand the Views tree and then expand Elevations.

Double-click South to activate that view m the drawing área.

You will see two leveis that are usually present when you create a new project using the

default template.

2. From the Architecture tab in the ribbon/ find the Datum panei and click the Levei tool. In

the Options bar/ ensure that the Make Plan View option is selected.

3. From left to right/ draw a new levei exactíy 10'-0" (3000 mm) above Levei 2.

When you hover the mouse pomter anywhere near either endpomt of the existing leveis,

you will see alignment guides (dashed Unes) that help keep the extents of the datum
objects consistent.

4. Click the Modify button or press the Esc key/ and you will notice that the new levei hás a
blue target. Double-cUck the target for Levei 3/ and the Levei 3 floor plan will open.

5. Return to the South elevation view and select Levei 3. Prom the Modify tab m the ribbon/

click the Copy tool. In the Options bar/ select the Multiple option.

6. Create two copies of Levei 3: one that is 2'-Q" (600 mm) above Levei 3 and one that is 9'-0/'

(2700 mm) above that one/ as shown in Figure 2.25.

7. You can change the names and elevations of leveis by selecting a levei and then clickmg

the name or the elevation value. Rename Levei 3 to Levei 2B/ Levei 4 to Levei 3/ and Levei

5 to Roof. If you are prompted to rename the corresponding views/ click Yes.

TIP If the levei names overlap and you want to see them clearly, adjust the scale from the defauk

1/8" - 1'0" to 1/4" = ro".

As we stated previously/ plan views are not created for leveis that are copied or arrayed. This

gives you the flexíbility to quickly generate leveis for taller buildings without ali the associated
views that may increase your project file size unnecessarily. Although this workflow may be

beneficiai for you m early design phases, what do you do when you need ali those floor plans
and ceiling piaus for that high-rise design?
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FIGURE 2.25
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If you want to convert a levei that doesn/t have a view to one that does/ find the Create panei

on the View tab and then select the Plan \^ews flyout and then the Floor Piau command. This

opens the dialog box shown m Figure 2.26. You can select among ali the leveis without corre-

sponding views in your project. Only the leveis you copied m the previous exercise are listed in

the dialog box.

You can also use Ü-úg command to create duplicate views of existing leveis. Clear the Do Not

DupUcate Existmg Views option at the bottom of the dialog box to see ali the leveis in
your project.

Select the Roof levei and click OK. A floor plan will be created for the Roof levei/ and that
floor plan wiU be opened. It is important to note that every plan you create with this method will
be opened as you complete the command. Use the Close Inactive Views tool (available in the

Quick Access toolbar) to avoid slower performance in your work session.

EXPLAINING 3D AND 2D DATUM EXTENTS

Datum objects—specifically grids and leveis—have two types of extents: 3D (analyüc) and 2D
(graphic). These extents are expressed as grips that are shown at the endpoints of the grids and
leveis in plans/ sections/ and elevations. The analytic grips control the extents of the datum across

the entire project and ali views. The analytic grip is shown as an open circle/ and the indica tor

displays as 3D, as shown in Figure 2.27.

FIGURE 2.27
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If you want to adjust ttie 2D extents of your datum m only the current view/ click the 3D icon/

and it will change to 2D. You can then modify the 2D extents of the datum object without
affecting the 3D extents. We will explore tNs further in an exercise later m this section.

Datum objects are visible only m views that intersect their 3D extents. The elevation in

Figure 2.28 shows four grids and four leveis. Grid lines 3 and 4 are not visible on Leveis 3 and 4

because their 3D extents are not mtersecting those leveis.

You can use the 3D and 2D extents to your liking m any view. In Figure 2.29, for example, the

3D extents of the grid lines extend through Levei l and Levei 2/ but the 2D extents are set above

Levei 2. This means the grid datum would stiU be visible m both leveis/ even though it looks like
they do not mtersect the leveis.

When you move a datiun object, one way or another, content is going to respond. If you move

a levei/ walls and fumiture are going to move accordingly. If you move a grid, structural ele-

ments associated with the grid will relocate. And if you move references/ the elements associated

with them will update. Therefore, you wÜl often constraüi or pin datum objects in arder to

restrict their movement as your project is startmg to develop.
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FIGURE 2.28
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Let s continue with the exercíse from the section "Creating and Duplicating Leveis" and edit

the 2D extents for one of the leveis you copied. Remember that although this exercise uses levels|
these methods can be applied to grids as weU. Here are the steps:

l. Open fhe South elevation view again, and you/ll notice that the label for Levei 3 is slightly|
overlapping the label for Levei 2B because they are relatively dose. You/ll need to adjust
the 2D extent of Levei 3.

DEFINING PROJECT ORGANIZATION

2. Select Levei 3, and you'11 see two items at the right endpomt with which you'11 need to
interact the 3D indicator and the lock symbol. First, click the lock symbol to unlock the
right endpomt This wül allow you to move the endpoint for tíie selected levei without
affecting ali the other leveis.

3. Click the 3D indicator só that it changes to 2D. Now you are ready to modify the 2D
extents of the levei.

4. Drag the 2D extents grip (the solid circle) to the right. The result should look like the
image shown in Figure 2.30.
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5. As a final option, you can choose to break the end of a levei or grid line só that the tag or

label wÜl clearly display. Click fhe Add Elbow symbol near fhe label at the right endpomt
of Levei 3. We have mdícated the location of tHs symbol in Figure 2.30.

6. Use the additional Une grips to adjust the levei endpoint só that Ít resembles the image
shown in Figure 2.31.

IGURE 2.31
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PROPAGATING EXTENTS

Quite often you will adjust the extents of datum objects that need to be replicated in several other
views. Fortunately, there is a tool to help you accomplish Üüs—Propagate Extents. The premise

of this tool is simple/ but you must be aware of the subtleties m applying it to a three-dünen-
sional model.

The Propagate Extents tool pushes any modifications you apply to a datum object from one
view to other paraUel views of your choosing. This tool does not work well on leveis because the

parallel views are essentially mirrored views of each other. For example/ the orientation of the

South elevation is the opposite of the North elevation; therefore, if you make a change to the
extents at the right end of a levei in the South elevation/ those changes would be propagated to
the left end in the North elevation.
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The best use for the Propagate Extents tool is to adjust the 2D extents of grids. Why
2D extents? Because changing the 3D extents affects the datum object throughout the project
mdependent of any spedfíc view. Lefs examine this behavior with a quíck exercise:

l. Download andopenthec@2-Gr-ids-Start.rvt file fromthisbook/swebpageandthf

activate the South elevation.

You wíll see three leveis and four grids.

NOTE The Une weight of the grid lines hás been increased for claríty.

2. Select grid 3 and click the 3D indicator at the bottom endpoint. Notice that the lock
symbol turns off automatically, allowing you to immedíately adjust the graphic extents
of the grid.

3. Drag the 2D extent of grid 3 up toward the top. Repeat tí-ús process for grid 4 só that the
result looks like the ünage shown in Figure 2.32.

FIGURE 2.32
Adjusting the 2D
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Before you continue/ open the Levei l and Levei 2 floor plans and observe that grids 3 and^
4 are stiU visible. If you had adjusted the 3D extents of the grids in the South elevation
view/ those changes would already be reflected in the other views. We/re using Üús

method because we want to maintain the 3D extents but modify the 2D extents only Ín the
South elevatíon view.

4. Return to the South elevation víew and select grids 3 and 4 while pressmg the Ctrl key.

From the contextual tab m the ribbon, click the Propagate Extents button/ and the dialog

box wiU appear as shown in Figure 2.33.

5. In the Propagate Datum Extents dialog box/ select the North elevation víew.

6. Click OK to complete the command and then activate the North elevation view. Observe

that the 2D extents of grids 3 and 4 now match the modifications you applied m the South
elevation view.
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You can use the Propagate Bxtents command to easily copy datam settings to any parallel

views in your project. TNs is especially effective for propagatmg grid extents to many plan views

in high-rise buildmgs.

RESETTING OR MAXIMIZING 3D EXTENTS

Two commands you might need when adjusting datum object extents are ones that give you the

ability to reset or maximize the 3D extents. These commands are available m the context menu

when you have a datum object selected (Figure 2.34).

FlCURE 2.34
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The Reset To 3D Extents command allows you to reset any graphic extent modifications back

to the analytic extents. Let/s apply this command in the continued exercise fíle:

l. In the c02-Grids-Start file, return to the South elevation view. Right-cUck grid 3/ and

select Reset To 3D Extents from the context menu. Repeat this step for grid 4.

2. You will see the grid lines return to their ongmal condition; however, this hás been

changed only m the current view (South elevation). Acüvate the North elevation view to

observe this behavior.
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3. Return to the South elevation view and select grids 3 and 4; click the Propagate Extents

button in the contextual tab in the ribbon, and select the North elevaüon view.

4. CIick OK to dose the dialog box/ and the reset 2D extents will be applied to the grids in
the other views.

The other command in this pair serves a similar purpose in dealíng with datum objects,

Maxímize 3D Extents is most often used if your leveis or grids are exhibitmg strange

behavior. There are various reasons why this happens/ but you 11 realize it when it does.

You can use this corrunand to set the analytic extents of a datum object to the outer

boundaries of your project geometry.

Contmumg in the exercise füe, activate the Levei l fíoor piau and notice that grid line C
seems to be displayed like ali the other grids. Now activate Section l from the Project
Browser or by double-clicking tihe section head shown in the floor plan. You/U notice that

grid line C is not visible in the sectíon view. This Ís because someone mistakenly pulled

the analytic (3D) extents far to the left in plan view while the graphic (2D) extents
remained consistent with the other grids. Let/s continue the exercise and repair

this problem.

5. Actívate the Levei l floor plan and select grid line C. Right-cUck and, from the context

menu, choose the Maxrmize 3D Extents command.

6. It may not seem like anything happened, but activate the Section l view and you/ll now

see that grid line C is visible.

7. Return to the Levei l floor plan/ select grid line C again/ and then click the 2D indicator at
the right endpomt só that it indicates 3D.

USING REFERENCE PLANES

Objects in the Revit model can maintain relationships with other objects; however/ you may not

always have other model elements (like walls, floors/ and roofs) to relate to other geometry. This

is why datum objects are só important.

If you have been using Revit for a reasonable amount of time/ Ít seems obvious that leveis and

grids would contrai content/ but reference planes aren't often appreciated. Here/s a simple

exercise to demonstrate this special kínd of relationship between reference planes and walls:

l. Download and open the file c02-Walls~Start. rvt from Üús book's web page. Activate

the Levei l floor plan/ select the wall segment/ right-click/ and then choose Create Similar

froin the context menu. Use the Tangent End Are option from the Draw panei in the

contextual tab of the ribbon to create a series of concentric walls starting from the left

endpomt of the provided wall/ as shown in Figure 2.35.

2. Go to the South elevation view. From the Architecture tab in the ribbon, click the

Reference Plane tool and add two angled planes (dashed lines)/ as shown in Figure 2.36.

Í,fiüBB2.3^
K^icwalls

ÍIGURE 2.36
lÏleference planes and
leveis shown in elevation

Levei 1 ^f'\
o'-o" '-y

3. If you move Levei l/ you/U notice that the walls ali move with it. You don/t have to select

the walls; it/s in the properües of the walls to maintain a relationship to the Levei l datam.

You could make the top of the walls mamtain this same kind of relationship to Levei 2.

You can also create a relationship to the reference planes. To do só, simply select ali the

waUs (just hover your mouse over one wall, press and release the Tab key, and then

left-click to select'the chain of walls) and then click the Attach Top/Base button m the
ribbon. Note that Attach Wall > Top is the default selection in the Options bar/ só fírst pick
the upper reference plai-ie. CUck the Attach Top/Base button again/ make sure Attach WaU

> Base is selected m"the Options bar/ and then pick the lower reference plane.

Figure 2.37 shows the resulta in a 3D view after you've attached the top and bottom of the

walls to the upper and lower reference planes.
Try moving and rotating the reference planes/ and notice Üiat the wallswÍU mamtain their

relationships to the planes. Thís is shown in a section view of the waUs in Figure 2.38.

Although you can use leveis, grids/ and reference planes to customize model elements/ there

may be situations where you need to establish relationships with nonplanar geometry.
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FIGURE 2.37
Finished walls

FIGURE 2.38
Sectíon view

Using Content
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, information about fmishes within a project. Take a look at the properties of a room/ and you

tïu ^nd Floor Finish/ Base Fmish/ Wall Firúsh/ and Ceümg Fínísh.
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WORKING WITH TYPE AND INSTANCE PARAMETERS

Ali content m an Revit project hás parameters, which are simply the information or data about

something. Farameters can afíect many different aspects of an object, such as visibility, behavior/

size/ shape/ and material.
To develop a fundamental understandü-ig of parameters, you must note that there are two

kinds of parameters: type and mstance. Type parameters control information about every element

of the same type. For example/ if the material of a piece of furniture is designated as a type
parameter and you change-it, the material for ali the furniture of Ü-iat type will change. Instance

parameters control only the mstances that you have selected. Só if the material of the piece of

fumiture that you have selected is an instance parameter/ you will be editmg only the

selected elements.
Instance parameters can be constantly exposed m the Froperties palette. Selecting something

mitíally displays the instance parameters. Figure 2.40 shows the instance parameters of a waU

that contrai the relative height, constraints, and structuial usage.

By clickmg the Edit Type button/ you expose the type parameters (Figure 2.41). These param-
eters contrai values such as the structure/ graphics/ and assembly code.

This section provided you with a basic overview of families and parameters; you wiU learn

much more about these concepts m Chapter 15.

Working with Views
Views are the means by which you wÍU interact with/ perceive/ and document the projectAs you

can see m the Revit organizatíonal chart shown previously in Figure 2.23, there are both 2D and

3D views. Two-dimensional views are oriented to specifíc coordinates such as plan/ elevation,
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, THE COMMON PROPERTIES OP VlEWS

E?'i/7tir.t review/ m detail/ some of the properties that apply to most views. AU of these are found

ELe!'?s^operties'palette when no objecte are selected; however, some properties may also be
lip tnc^'in~the view control bar. The most common view properties are as follows:
ii &CC6SÍ

;ion With the exception of schedules and drafting views/ the extents of ali yiews
FlSuted usmg crop regions. The visibility of the crop region itself can be turne^ but

^nlcanchoo~se"to-£deall crop regions m the Print Setup dialog box when using the Print
Ïirnand. Although you mi^it feel the need to keep crop regions visible to allow easier

L'use the Reveal Hidden Elements tool inthe view contrai bar to temporarily

^owNdden crop regions. Buttons to enabïe/disable and show/hide the crop region are

available on the view control bar.

yiew Scale The víew scale is the proportional system used to represent comPonents Df

n^easured drawings. The scale of aview not only controls its piinted size/ but also^utomatl-

c^fycontrols the relative weight of Ime work as well as the size of annotations such^ ,text/
^ensions/ and tags. The view scale is displayed on and can be modified from the víew

control bar.

iraphics The Visibility/Graphic Overrides dialog box (Figure 2.42) aUows
^m:d^'ofa'^iew's elements m two essential ways: visibUity (tum object categories on/of

and graphics (customize line thickness/ color/ and fill pattem).
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Detail Levei The Detail Levei parameter can be set to one of three predefined choices:

Coarse/ Médium/ or Fine. A representation for each settmg is defíned durm^ the component' s
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construction and sets the levei of detaü in each view levei. It can help improve model

mance and avoid cluttered views by lüïtiting the visibüity of smaller model elements.

Levei can be set with a button on the view contrai bar.

View Template View templates are a selection of view properties, which can mclude

properties that change the scale/ detail levei/ and visibüity of objects m the view. As an air

standardization/ view templates can help you organize common view settmgs and a]

to groups of views throughout your project and other projects within your office or fírm. -y-

templates are covered in detail in Chapter 4.

CREATING AND DüPLICATING VlEWS

You can create views in various ways in order to work with your

your needs. Although creating views is quick and easy/ you should avoid populating your

project file with too many urmecessary views. An overabundance of unused views will increasei

the amount of management your team will need for the projectas organization. Víews that do ne

have a specific purpose are just another object to mamtain/ search through/ and store. Keep it

simple/ and routmely purge valueless views. Let/s review the procedures to create different vie\

types and see how to contrai their extents after they're created.

New views can be generated from the Create panei on the View tab of the ribbon (Figure 2.43!
and the process is quite simple. Click one of the buttons/ and a new view is activated and storedl

in the Project Browser.

FIGURE 2.43

Creatingnewviews from

the ribbon 3D SKtic
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Caltouí P San Eleva ti on Scheduie

BQX

Another quick way to create new views Ís to right-click a view name in the Project Browser

and select one of the Duplicate View commands (Figure 2.44). You can also duplicate the current,

view by using the Duplicate View button in the Create panei of the ribbon.
As you can see in Figure 2.44, there are three choices in the DupUcate View flyout command:

Duplicate, Duplicate With Detailing/ and Duplicate As A Dependent. Let/s take a quick look at
what each of these options means.

Duplicate This command will create a copy of the selected view but will not replicate any ofj
the annotations in the view. Use this command when you need a fresh copy of a view in

which you will create a new annotation for a different documentation purpose or even a

working view without clutter.

Duplicate With Detaílíng As its name suggests/ this command will create a copy of the
selected view with ali the annotation in the view. We don't recommend using this command

too often because replicated annotation is often a sign of an inefficient production process.

Duplicate As A Dependent This command allows you to create a series of partial views that|
assume the properties of one parent view. Usmg dependent views does not mean you can

have a parent view with a larger scale like 1:100 and then create dependent views atlarger

es such as 1:50. The parent view hás ali the same properties astiie dependents/ but you^

iuthecropregionsand settings from the parent view. This isused most commorúy

^th"large°plans and elevaüons that cannot fit on the projecfs standard sheet size.
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CREATING ELOOR PLANS AND CEILING PLANS
ou learned m the section "Creatíng and Duplicating Leveis- earUer in this chapter^whenyou

clrea't7ak"v^nandevationorsectionuview, you have Àe option tocreate a piau view for t^

le^intheOptions'bar"Íf'youhave leveis without corresponding plan views, you can also use

the Plan Views tool from the ribbon to create a plan view. ^ _ ^ ^
"Th^verTicaI ^tents'ofplansand ceiling piaus are controlled by the V^ew Range settings. The

ViewRange"s"ettÍngs/ as shown m Figure 2.45, defme the vertical range^ú[e^ew_ ^ ^
ties^can bedifficult to understand, só we created a diagram to illusfcrate

rmcïpïes"ÍhüFiguire2.46/ you will see that the primary range is thezone youusuallysee^a
decfauU>fl^roïucei£gpU^Ífan'ob}ect cresses thecut P^/^eobjecfsCutvaluesarcus^. l

rheobjectïsïelowï crut plane butabove thebottor^ the objecfs Projection values are used.

Cut and Projection values can be found m Visibility/Graphics.
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FIGURE 2.45

View Range dialogbox
View Range

FIGURE 2.46

View range proper-

ties explained

View Detíh

For most views/ the Bottom and View Depth parameters are set to the same plane. Therefor

objects below the bottom of the view range simply won't appear. Só/ what happens ïf you needj
Íos.^ °bJects on a lower terrace for reference in Üie current view? When you set VÏew Deptii:|
Levei Below or Unlimited/ objects that are below the bottom of the view range but withm Se
view depth will be overridden with the <Beyond> line style.

Perhaps you only need to apply a different view range setting to isolated áreas of a view.'

can be accompUshed with the use of the Plan Region tool. Vou can find this tool in the Create
pia^Ïof ,the VIFW tab ^long with üle other plan view tools-The plan Region too1 allows you to l
Íet. bomldarywithm which the view Range dialog box will be avaiïable to make specific
changes You can use this method for áreas such as wmdows that might be placed in a wall aboj
the cut plane but need to be shown on the plan for documentation. / 1

Another usefyl property ofplans is known as an underïay. Although this property may
function more like a tool/ it is found in the Properties palette along with the other view proper-

ties. An. underlay allows you to use any other levei as a reference m the current view. You can u|

the imderlay to display ceiling soffits in a floor plan/ to display fumiture layouts in a ceilíng pia
or to use another levei as a reference for replicating partition layouts.

CREATING ELEVATIONS
. the Elevation tool on the View tab creates elevations of various types.You'11 also^notice

Lplace'anelevation tag, the elevations automaticaUy orient towalls (Figure 2.47). If

^ íiohCTSt element nearby to reference, they/ll automaticaUy orient to the left.

ÍRB 2.47 ^ ^ ^^
l^ntagorientation

Selectmg the center of the tag wiU allow you to create additional elevation views (more

typicaÏlydone for interior elevations) by selecting the unchecked boxes that surround the

elevation tag (Figure 2.48).

GURE 2.48
latíng addiüonal

?aüons

y x x x

. select the directional point of the elevation tag/ you will see a blue Ime Üiat defines the

ÏLrmmsoÏtiieïutpïane for the elevation as well as adashed line that defmesthe sideand rear
extents (Figure 2.49). This allows you to contrai the analytic extents of the elevationwithout

movmg^graphictag/ which is useful if you want the tag in a particular location but you want

the cutting plane to start somewhere else.

IGURB 2.49
levatíon extents
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Finally/ there are three types of elevations m Revit project: exterior/ interior/ and framing. T^J

differences are more than graphic. Exterior elevations, by default/ do not have an active crop

boundary, only a starting cut plane. Interior elevatÍons have their crop boundary on by defau^

attempt to fmd boundaries of host elements/ such as walls/ floors, and ceilmgs. Framing elevaíiof

can be placed onïy along a gríd Une/ and their cut plane corresponds to the respective grid.

CREATING SECTIONS 1

Selecting the Section tool on the View tab creates sections. By default, three types of sections arg

avaílable from the Type Selector: Buildmg/ Wall/ and Detaíl. Ttís allows them to be grouped TVH.},|
better clarity in the Project Browser/ but there are also other important propertíes.

Unlike elevations, the cutting plane of a section must correspond with its graphic line.

Figure 2.50 shows the instance propertíes of a Building section. The far and side cut planes of a

section can also be controUed. This goes for both BuÍIdmg and Wall sections.

PlGURB 2.50
Section properties

and extents
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Building and Wall sections must be created in a perpendicular orientatíon with respect to
leveis. But after you create them/ they can be rotated in elevation. However/ doing só could lead

to confusion in your project. Qnce rotated/ the section wouldn'tbe displayed m plan víew

because the section cuttmg plane would no longer be perpendicular to the plan view.

A DetaÍl section will have a different graphic symbol by default/ although you can customize
this to your líking. (We díscuss this form of customizatíon m Chapter 4.) Beyond the differing

RcïA^gEi

ï:"!

.#501
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FIGURE 2.53

Detail callouts can be set

to show in inter-

sectíngviews.

a caUout using tine same type as the parent view/ the callout view wül also have

contrais as the parent view, In the floor plan example^ you will stiÜ have view

^nerties such as Depth Clipping and View Range. In a Detail callout/ the property called Far
tings can be set to either Independent or Same As Parent View.

Take a moment to note the grips on the boundary of a callout when one is selected. You can

these grips to change the size ofthe calloutboundary/butthis also modifíes the crop region
^nthin the callout view. As you might assume, if you modify the crop region in the callout view,
the caiïout boundary also changes.

Callouts can be created either in a simple rectangular shape or m any custam sketched shape.

You will see these two tool options in the CaIÏouf flyout butfon in fhe ïibbon/ but you can always
edit a rectangular callout by first selecting a callout and then selecting Edit Crop from the
contextual tab in the ribbon. Vou can also return a custam shape callout to a simple rectangular

shape by clicking Reset Crop in the ribbon.

ÜSING DRAFTING VlEWS

Not every view needs to be connected directly to the model. Drafting views give you the ability
to draw without first creatmg a reference to something m your project. They may contam Detail

and Repeatmg Detail components and any other annotation content. Draftmg views are great for

dckly documentmg typical conditions that donft require an actual model geometry.

Once you create a drafting view/ you can refer to this view when creafing an elevation/ a

section, detail/ and só on/ that would normally rely on an actual view of the model. As you start

to create a standard project view/ simply select the Reference Other View option from the

contextual tab of the ribbon (Figure 2.54), and then you'11 be allowed to select a reference view
from ali the other like views m your project as well as any drafting views. You can even use the

search bar to easily locate specific view names instead of scrolling through an extensive list of ali

project views. Drafting views can also be saved out of the project as common reusable details.

This will be covered in more depth in Chapter 17.

ÍURE 2.54
the search bar with

tReference Other

option.

USING LEGENDS

Legends are views in which you can display samples of model elements that will not affect
schedules and quantity takeoffs. There are two types of legends: legends and keynote legends.

Regular legends are used to assemble analytic views of content in your project/ graphics/

geometry/ tags/ and só on—anything that Uves m your project. Legends may contam Detail/

Repeating Detail/ and Legend componente, which are live representations of 3D model elements.

Legends are urúque m that they are the only graphical view that can be placed on more than

one sheet. '
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A Legend component (Figure 2.55) is a special live representation of a system or com.Dnn^_ 1

family that may appear only in legend víews (not draftmg views). If you make a change'to^anl
element m your project/ the representation of that element in Üie legend will change as Wetl"1!

When you are creating a legend view/ the Legend Component tool is located m

flyout button on the Detail panei of the Annotate tab in the ribbon.

FIGURE 2.55

Legend components

Keynote legends are special schedules. When creatmg a keynote legend/ you will be prompi
much the same way as you are when creatmg a schedule (Figure 2.56). These types of legends,

meant to be placed on either one sheet or multiple sheets. If the legend is placed on every she(

in which keynotes are used/ the Filter By Sheet option should be selected on the Filter tab of
Keynote Legend Properties dialog box. With this option selected/ only those keynotes that app^
in views placed on a sheet will appear in the sheefs keynote legend.

FIGURE 2.56
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KEYNOTE LEGEND

061000.01
061000,02

061000.04

074600.01
077200.02

092100,01

096800.01

096800.02

238100.01

FRAME EXÍSTING OPENING TO MATCH.
DOOR LANDING - TREATED WOOD
STRUCTURE, TREX RAILS AND STEPPING
SURFACES
COMPOSITE RAILING SYSTEM, TIMBERTECH
RADIANCERAILORSIM.

VINYL SIDING OVER 1/2" RtGID INSULATION
BREAK-FORMED ALUMINUM FASCIA OR
COMPOSITETRIM(WHITE)
1/2" GYPSUM BOARD, PAINT BY OWNER fTYP.)

LAMINATED WOOD FLOORING (FURNISHED
AND INSTALLED BY OWNER) OVER 3/4"
PLYWOOD SUBFLOOR ALIGNED WITH EXIST.
SUBFLOOR
MARMOLEUM OR VINYL FLOORING
(FURMISHED AND INSTALLED BY OWNER)
DUCTLESS HEATING AND COOLING UNIT

ÜSING SCHEDULES

Ali model elements have mformation about theír properties such as size/ materiat and cost. In

Revit/ a schedule is a Ust of any type of element in a project or Imked models and the element

attributes. You can report and interact with this mformation in tabular views known as sched-

yles. There are sbc types of scheduïe views that can be accessed from the Create panei in the View

fab of the ribbon: Schedule/Quantities, Graphical Column Schedule/ Material Takeoff, Sheet List/
Note Block, and View List.

Schedule/Quantitíes This is the most commonly used schedule type/ allowing you to list
and quantify ali the element category types. You would use this type to make door schedules/

waU schedules/ window schedules/ and só on. These schedule types are usually limited to

scheduling properties within the same category; however, you can create a multi-category

schedule or use some fíelds from other elements. For example/ many model elements can refer

to the properties of the room in which they are placed.

Graphícal Column Schedule This schedule is different from the other schedule types and is
commonly used by structural engineers. Structural columns are displayed accordmg to their

grid intersections/ mdicating top and bottom constraints as well as offsets.

Material Takeoff This type of schedule lists ali the materiais and subcomponents of any
family category. You can use a material takeoff to measure any material that is used in a

component or assembly. For example/ you might want to know the volume of concrete withm

the model. Regardless of whether the concrete is in a wall or floor or column/ you can tell the

schedule to report the total amount of that material in the project. Material takeoffs will report

material properties across multiple categories.

Sheet List This schedule allows you to create a list of ali the sheets in the project.

Note Block This tool creates a unique schedule that lists the properties of a generic annota-

tion symbol used in a project.

View List This schedule shows a list of ali the views in the Project Browser and their
properties. A view list can be a valuable tool to help you manage your projecfs views

effíciently.

One important aspect that we want to reiterate is that schedules are derivatives of the model.

Often, if the schedule is not accurate, the model is not accurate. A schedule can also deal with the

tolerances the team hás set in the units of the file and may be based on the template.

USING SHEETS

Printed contract documents are still a common deliverable that architects and engineers are paid

to produce. You will use sheete to organize views and other annotation for the purpose of Íssuing

printable (physical or digital) documents. Sheet borders can be customized/ but the important
fact to realize is that sheets are always scaled at 1:1. The important thLng to remember is that you

are not going to select a scale when you pïint a sheet; it/s really more like prmtmg than plotting.

If you need your sheet to be smaller or fit on the desired page, these options are available/ and

using them is litüe different than prmting from a word processing application.

You will learn more about creatmg sheets in Chapter 18.
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ÜSING 3D VlEWS

Two kmds of 3D views are supported: orthographic and perspective. The Default 3D view is

orthographic/ whereas the Camera and Walkfhrough views are in perspective (Figure 2.57). Yo,

can right-cUck the ViewCube and select the Perspective or Orthographic option to toggle
between the 3D view types. We/ll also cover 3D views in detail in Chapter 12.

plGÜRE 2.58
;ing camera and

eargetorígms

FIGURE 2.57
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Orthographic views wíll always show parallel edges along Cartesian x-, y-/ and z-axes.

Orthographic views are best if you need to show model information to scale. Many people do not

realize that it is possible to dimension and detail in Revit inside a 3D orthographic view. For a
more thorough explanation of annotatmg a 3D view, refer to Chapter 21, //Presentmg

Your Design."

Create camera views by placmg the starting point and endpoints of a camera (typically from a
plan view). The first point you select in plan view is the point from which the view will be taken,
but the second point is also the rotation origm for the view (Figure 2.58). TMs is important
because if you select a second point that is far beyond your view/ when you open the view and

attempt to modify it/ it will rotate around a target that doesn't seem to make sense. Thafs

because the target location of the view is off in the distance.

A perspective view will not be to scale/ but it can be made relatively larger or smaller by

selectmg the view/s crop region and then selecting the Size Crop button from the Modify
Comera, tab. Once you do thís/ you will have the option to change the view size and field of view,

proportionally or not proportionally (Figure 2.59). You can also simply drag the nades of the
bounding box.

Camera extents are defíned by the Far Clíp Offset option/ accessed in the Properties palette for
the view. If the Far Clip Offset is too shallow/ the view may resemble the image shown in
Figure 2.60. Geometry that you/d expect to see will be //clipped// in the view.

FIGURE 2.59
Modifying the view size

andfieldofview

FIGURE 2.60
The Far Clip Offset is

too shaiïow.
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Simply mcrease the Par Clip Offset value to show more of the model. You may also do this

graphically by returning to a plan view/ right-clicking the camera view in the Project Browser.

and then selecting Show Camera. Once the camera is shown m your plan view/ you can seler

node at the far end of your dippmg plane and manually drag the nade to extend the far cln
offset of your view só that the perspective becomes similar to that shown m Figure 2.59.

Fmally/ the extents of 3D views (even waücthroughs) can be custoimzed with the use of

section boxes. You/ll find the Section Box option in the Properties palette for a 3D view. This \vi

allow you to contrai how much of the project is shown (Figure 2.61) and is helpful for creatii
cutaway visualizations in real time or in renderings.

FIGURE 2.61

Sectíon box applied
to a 3D view

To cover ali aspects of project m.anagement in this one chapter would be overwhelmmg;

therefore, you can find more detailed mformation about the following topics throughout

this book:

• For object styles/ Ime styles/ fill pattems/ Ime weights/ and view templates/ refer to

Chapter 4.

• For worksets and worksharing/ refer to Chapter 5.

• For phasing and design options, refer to Chapter 11.

• To learn about locations and shared positiorúng/ refer to Chapter 3.

The Bottom Une

Understand the user interface. In addition to understandmg how your project is organized/

to use the Revit well, you must understand how the UI is organized. Once you grasp both of

these concepts, you wiU be ready to move ahead.

Master It The "big" áreas of the UI are the ribbon, Üie Properties palette/ the Froject

Browser/ and the drawing área. How do these áreas work together/ and what tabs corre-

spond to an iterative design process?

Understand project organization. The compelling advantage of being able to design/
document/ and manage your project across multiple disciplines—the architectural, structural/

and mechanical disciplines—is something that you can do m Revit projects/ and understand-

ing project workflow is key to getting off on the right foot.

Master It Thinkmg back to the Revit organizational chart shown in Figure 2.23, what are

the main components of a Revit project/ and how can you apply them to your design

process? How do these categories directly affect your design workflow?

Qnce a section box is enabled in a 3D view/ you can select it to stretch ar rotate it according to

your needs. The section box is not considered a crop region/ and therefore it is not affected when

you use the Show Crop Region command. If you want to hide a section box/ select it and then
select Hide Elements from the View panei in the ribbon.

Managing Your Project Model
Project management involves ali the settings that contrai (and therefore restrict) the graphic
mformation previously described in this chapter as relationships/ repetition/ and representations.

Returning to the organization chart in Figure 2.23, you'11 see that a Revit project is managed with

settíngs such as line styles, phasing/ and view templates.



The Basics of the Toolbox

The road to mastering Autodesk® Revit® 2020 will always mclude reinforcement of fundamental

skills. Just as an accomplished musician will practice her scales, here you will '"practice" by

reviewing the fundamental selection and editing tools throughout the Revit program.. There are

many tools that can assist you in refming your models and project designs. Some are simple

geometry-editing functions/ whereas others possess more powerful capabÜitíes.

IN THIS CHAFTER/ YOUfLL LEARN TO

• Select/ modify, and replace elements

• Edit elements interactively

• Use other editing tools

• Explore A360 features for collaboration

• Create sife context for your project

Selecting, Modifying, and Replacing Elements
Knowing how to select, modify/ and replace elements effícientíy is fundamental to working

productively in. Revit. These interface operations are the foitndation on which you will build

skills to create and edit your project models. In the followmg sections, we wül review methods

for selectíng, filtering/ and modifying properties.

Selecting Elements
Revit was one of the first programs that had the ability to highlight elements as you hovered the
mouse pointer over them/ before actually clickmg to select. Not only does this give you a clear

idea of what you are about to select/ but it also displays information about that object in the

status bar and in a tooltíp near the mouse pointer. When you haver over any element in Revit/ it

hlghlights; click the highlighted element/ and it tums blue/ indicatmg that it is selected.
Once an element is selected/ the ribbon changes to Modify mode, wheie consistent editmg

tools are located on the left side and context-sensitive tools appear to the ríght. Notice the subtle

differences in the ribbon/ as shown in Figure 3.1, when a roof/ waU/ and floor are selected.
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FIGURE 3.1
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CHANGING SELECTION COLORS

You can customize the defáult colors for selection, pre-sekction, and alerts to vour own m1nr.

• etï'ro do?ï ?ick tïle ?le tab and selectoptions-In Üie Options dialog box/select the GraphiJ
Qptíon on thé left to edit the settings for colors.

Wlule selecting an element is a seemingly simple task/ Revit provides you with a few ways 1
perform a selection:

Add or Subtract You can build a selecüon of individual elements by using the Ctrl and SI
keys on your keyboard. To add elements, press and hold the Ctrl key, fhen dick an element"

To remove elements/ press and hold the Shift key, Üien click an element. Notice that the mot

pointer indicates a plus sign (+) when you hold the Ctrl key and a minus sim (-)
hold the Shift key.

Window To select a large number of clemente m a. view window/ you can click and drag •

mouse to form íwo different types of seíection windows. Cück and drag from íeft to righf/ i

onlythe elementscompletelywithin the window will be selected~this"implied window is |
displayed as a solid line. Click and drag from ríght to left/ and any element within or crossii
fhe window will be selected—i-his implied window is displayed as a dashed line. To activafe|
either window-selection tool, you must begin by dickmg m a blank área (not on an element)!
within the view wmdow.

Chain Chain-select is an intelligent method for selecting connected eleiïients such as walls|

Unes, sketch segments/ and line-based components. To actívate this mode/ hover (but don't

cUck) your mouse over one linear element that is connected to several other linear elements. |

While the element is pre-selected/ press the Tab key once and the connected elements will be]

pre-selected. You can then click to select the chain of elements. When selecting objects/ use •

Tab key to cycle through ali available objects near your mouse pomter. If a floor edge happens

io be near the edge of a wall that you are trymg to chain-select/ you can skip the chain of walls

and select the floor. Be sure to look at the status bar; it will indicate "Chain of walls or Imes"

when you have selected correctly.

Select Previous Command A Uttle-known feature allows you to select elements you had

isly selected. Either right-click and choose Select Previous from the context menu or

press Ctrl and the left-arrow key on your keyboard.

Selection Options
You have the ability to choose elements that will be mcluded or excluded when you select

elements in a model. For instance, you can choose to select elements that are within a linked file.

Or not There are two ways to adjust these settings/ as shown in Figure 3.2: cUck the drop-down

menu under the Modify button in the ribbon or use the icons at the right end of the status bar.

Note that the icons in. the status bar wÜl change slightly to mdicate the status of each option.

When a mode is disabled/ a small red X will be displayed on the icon (the first/ second/ third, and
fourth icons show that X in Figure 3.2b). One of these selection options is Select Elements By

Face, which allows you to select elements simply by picking any face of the element.

,ÜRB 3.2
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Filtering Your Selection
Once you have elements selected/ a count of selected objects is displayed at the right end of the
stahis bar. You can also fílter the selection into object categories by clickmg the Filter icon in the

status bar or ribbon. Just as when selecüng folders in Windows Explorer, you can select multiple

categories while holdmg the Shift key or add a single category by holding the Ctrl key. This tool
allows you to select large numbers of elements and then focus your selection by removmg

categories you don't need/ as shown in Figure 3.3. For example/ if you window-select an entire

floor plan, you will have a selection set of many different categories. Using the Filter tool/ you

can limit the selection to just the Doors category—or perhaps Doors and Door Tags.

You can also use the Properües palette as a filter; see the section "Using the Properties Palette'

later in this chapter for more infoimation.
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FIGURE 3.3
Use the Filter dialog box
to fine-tune your

selections.

üsing SeIection-Based Filters

If you need to save a selection of elements for future editing/ you can save a selection-based

When you have a number of eíements selected/ cUck Save at the far right of the Modify j
Multi-Select contextual fab of the ribbon (Figure 3.4), and you can create a named selection set

the model. To load or edit any saved selection-based fílter/ go to the Manage tab m the nb- Í

bon and locate the Selection panei. Click the Load button to activate any of the saved selectio^
sets/ ana then you can use other toais such as Temporary Hide/Isolate to continue your task

work. These selection sets remember the items selected within the categories and will not selt

additional items made after the selecUon set was created. You may update the selection set by.

adding new items or removing items by clicking Edit Selection, located immediately below tín
Load icon. When the Edit Filters window appears, click a saved selection set you want, then cl

the Edit button. Tíús will take you to the Edit Selection Set contextual ribbon. Use the availabli
tools to add or remove elements/ then click Finísh Selection when the operation is complete.

FIGURE 3.4
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Selecting Ali Instances

Another fast and powerful method for selecting objects is the Select AH Ihsfances function. WIij
you right-click a single object m the drawing área or a family in the Project Browser/ the Select^
Instances tool gives you two options: Visible In View or In Entire Project. Selectmg the Visible:
View option wül select only those items you can see m the current view. This wül not select

elements that have been either temporarüy or permanentíy hidden in the view.
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Use the In Entire Project option carefuUy because you could modify elements m many places

1 that vou did not intend to change. Always remember to look at the selection count in the status

use Select Ali Instances. Here are some common situations where you might use

tbistool:

Viewports—When updating graphics for ali views

Walls—When switching from generic to specífic types across the entire model

Titíe blocks—Moving from design to detail documents for aU title blocks

Viewports—Useful when trying to purge unused viewports

fIP Note that Select AU Instances does not work on model lines or symbolic lines. This limitation

exísts because Unes not only are drawn in project views but also are integral parts of other objects

such as fíUed regions and shaft openings.

Üsing the Propertíes Palette
The Properties palette is a floàtmg palette that can remam open while you work wifhin the
model. The palette can be docked on either side of your screen/ ar it can be floated to any

location or a second monitor. You can open the Properties palette usmg any one of the following

methods:

• Click the Properties icon m the Properties panei of the Modify fab m the ribbon.

• Select Properties from the context menu.

• Press Ctrl+1 or PP on your keyboard.

As shown in Figure 3.5, the Type Selector is located at the top of the Properties palette. When
you are placing elements or swapping types of elements you've already placed m the model/ the

palette must be open to access the Type Selector.

When no elements are selected, the Properties palette displays the properties of the active

view. If you need to change settmgs for the current view, make the changes in the Properties

palette and the view wül be updated. For views, you do not even need to use the Apply button to

submit the changes—sünply move the mouse out of the Properties palette/ and the changes will

automaticaUy be accepted.
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FICURE 3.5
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per category, as shown m Figure 3.6. Select one of the categories to modify the parameters for the

respective elements. This process is different £rom the Filter tool in that the entire selection set is

mamtained/ aiïowmg you to perform multiple modifying actions without reselectmg elements.
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Fmally/ you can also use the Properties palette as a filtermg method for selected elements.

When you select elements from different categories/ the drop-down list below the Type Selector

displays the total number of selected elements. Open the list and you will see the elements listed
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Matching Properties
Located on the Modify tab of the ribbon in the Clipboard panei/ the Match Type Properties tool
allows you to select one element and apply its type and instance properties to other elements of

the same category. Once you select one element/ the bmsh icon near the mouse pomter appears

filled. Each subsequent pick on elements of the same category will replace the selected element

with the properties of the first element picked. Clicking in an open space wÜl clear the bmsh icon
and allow you to pick a new source object wiüiout restartmg the command.

If you want to use the Match Type Properties tool for multiple objects in a more controlled
manner/ click the Select Multiple button in the contextual fab of the ribbon after the source object
is selected. Proceed to use any of the usual selection methods described earlier in this chapter.

When your selection is complete/ click the Finish button on the ribbon.

Be careful when using this tool with walls/ because not only does Ít change the wall type/ it
also changes the top and bottom constraints of the walls being matched. One best practice for

changing wall types without affecting height constraints is to pick a waU and use the Type

Selector to modify its type.
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Üsing the Context Menu

The context menu that appears when you right-click m the view wmdow contains several

options^ You^can activate the last command or select from a Ust of recent commands/ as shown ,>

Figure 3.7. The context menu will also show you the shortcuts for any commands that have a

shortcut assígned. In Figure 3.7, you can see the shortcut for the wall command is WA (shown 1.
parentheses).

FIGURE 3.7
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In addition to the other right-dick commands listed throughout this chapter (such as Create
Similar)/ zoom commands, mcluding Previous Pan/Zoom, are on the context menu. There are

also useful commands when you right-cUck views in the Project Browser. Por example/ activate a

plan view and then try right-dickíng a 3D view m the browser. Select Show SectionBox/ and you
can edit the extent of the 3D view's section box while in a floor plan.

Editing Elements Interactively
Revitprovides a range of options to edit elements in the modeÏ interactively. The most obvious

are selecting elements and then dragging them on the screen or using the blue control grips to

extend walls, lines/ shape faces/ and region boundaries; however/ you often need more precise

ways of moving and copying objects. Let/s look at some ways to do that.

MovÍng Elements
You can move elements m several ways/ ranging from choosing traditional tools to using

interactive dünensions that appear on-the-fly when you select elements. Become familiar with

each method and determine what is best for your workflow.

ÜSING TEMPORARY DIMENSIONS

You have likely noticed by now that dimensions appear when elements are selected or newly

placed. These dimensions are called Temporary Dimensions and are there to mform you of the

location of the elements relative to other elements in the model/ as well as to help you repositíon

them. Clicking the blue dimension value (the text representing the distance measurement) makes

it an active and editable value. Type in a new value/ and the selected element will move relative

to the element from which it is dimensioned. Remember that when you are editing the position

of an element via the dünensions/ it will always be the selected element that moves. You canft

modify a dimension value if an element is not selected.

If a temporary dímension is not referencing a meaningful element, you can choose a different

reference by dragging the sm.all blue dot on the dünension/s witness line to a new/ parallel refer-

ence/ which will highlíght when the mouse moves over it (Figure 3.8). For example/ if you want

to position a door opening at a specific dimension from a nearby wall/ you will need to drag the

grip of the temporary dimension that references the center of the door to the side of the opening.

Then you can edit the value of the dimension as required. When you are draggmg the grip of a

temporary d-imension/ you can also use the Tab key on the keyboard to cycle through available

snapping references near the mouse pointer. To learn more about how to add references to

families/ refer to Chapter 15, "Designing with the Family Editor."'

.FIGURE 3.8
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If you click a blue grip, it cycles to the next possible reference m the element. For exarnple

clicking the grip of a dimension to a door or window cycles between the left and right open^ ^
and the center reference. The same applies to walls: try clicking the grip on the temporary |

dimension extendmg from a wall and see how the dimension cycles through the various refgj

ences in the wall (interior face, centerlme/ exterior face). Note that when you drag a temporc

dimension reference to a different position, the new reference is remembered when yc

the element for future editing.

You can also change the default behavior of temporary dimensions using the Temp<

Dimension Properties dialog box/ shown in Figure 3.9 (on the Manage tab, click Additional
Settmgs and then select Temporary Dünensions). Here you can specify how temporary dimen-

sions will mdependently reference walls/ doors/ and wmdows.

OFFSET UNPIN/PÍM

FIGURE 3.9

The Temporary

DÍmension Properties

dialog box lets you
define default behaviors
based on your modeling

needs.

You can modify the font size and transparency of temporary dimensions in the program

options. To customize these values/ click the Application menu and select Options. In the Optic

dialog box that opens/ switch to the Graphics category and locate the Temporary Dimension T^
Appearance settíngs. Adjust the text size and transparency according to your needs.

If you have several elements selected at the same time or select an element withm the pró?

ity of many other elements/ temporary dimensions sometimes don/t appear. Check the Optioi

bar for the Activate Dimensions button; clickmg it will make the temporary dimensions appea^
in the view.

BÉHAVÏORS FOM MODIFY TÜOLS

As in Autòdesk AutoCAD software, you have the optioTi to activate the Modify tools without»

elements-selected. If yo,u choose.this.method, you.must press the Enter key after selectitig

objects yoú intend to modify. , .

Yòu can-aïso switch between any of the-Modify parLel tools while-you have elements selected.

example, ifyou initially chóse Mírror - Pick Áxis and selected an element during the command,

can simply açtivate the Mirïor ~- Draw^Axis command without reselecting thè elements.

IRROR-BFiEAK

Í\-À
AL1GN

MOVE -

•RÜTATE'. • . -; -DELÉTE :

USING THE MOVE TOOL

To relocate elements with more precision/ use the Move tool rather than simply draggmg the

element. The tool allows you to type in values or use temporary dimensions as helpers to

ïly locate your object.

MovÍng elements is a two-click process. First/ you define a start point; then/ you cUck to define

a destination. If you know you need to move something a specific distance/ it does not matter

where your two picks take place. Ali that matters is that the distance between the two clicks is

the specified distance and m the specified direction. Alternatively/ you can guide the mouse

pointer in the desired direction of the move and key in the desired dimension value.

There are a few options on the Options bar to be aware of when the Move command is active:

Constrain When thís option is selected, it constrains movement to horizontal and vertical

directions relative to the view. Deselectmg it allows you to move the element freely as long as

the element is not hosted. Hosted elements/ such as windows or doors, always move in a

constrained manner parallel to their hosfs axis.

Disjoin The Disjoin option is helpíid when you need to move elements and eliminate any
jommg relationships the moved elements might have with other objects. This is particularly
useful with walls in some circumstances where you may be rapidly iteratmg through design

scenanos.

You might also attempt to use the Disjom option to move a hosted element/ such as a door/

to a new host. Don/t use the Move tool to perform this action; instead/ you must select the

hosted element/ and from the contextual fab in the ribbon/ click Pick New Host. The object

will be relocated to the new host you select. Thís method is also preferred over deletmg and

re-creating because it m-amtains the data associated with the original element instance.

Multiple The Multiple option is not active for the Move tool. This option is available only
when you switeh to the Copy tool.
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NUDGING ELEMENTS

Nudgmg is a simple way to push things aiound quickly/ as you would in software programs
such as Adobe Photoshop. When elements are selected/ you can use the arrow keys on the

keyboard to move the elements horizontally or vertically in small increments. Each press of ^

arrow key nudges the element a specific distance based on your currcnt zoom factor. The closçi.|

you zoam/ the fmer the nudge. Note that your snap settmgs do not affect the nudging distances

set by the zoom levei. However/ holding the Shift key while using the nudge tool increases the
distance of the nudge.

MOVING WITH NEARBY ELEMENTS

A simple way to constrain freestanding elements is to use the Moves With Nearby Elements

option. THs settíng is designed to capture logical relationships befrtveen elements without

establishü-ig an explicit constramt. When furnishing a space, for example/ you probably want to|

align the bed or dresser with an adjacent wall. If you change Üie design of the space/ you want

the furniture to follow the wall to the new location. For tNs purpose/ select the furniture and

then select Moves With Nearby Elements in the Options bar, as shown in Figure 3.10.

FIGURE 3.10

Once an object is
selected, it can be set to

move with nearby

elements: (a) select the
furniture and then select

the Move Wíth Nearby
Elements tooï; (b)
note that the
elements keep their

relationships.

12'-9" 12" - O"

(a) (b)

By settmg this option/ you create an invisible relationship between the bed and the wall só
that each tüne you move the wall/ the bed moves with it. To clarify the difference between tNs

approach and other constraint relationships/ you could create a wall-hosted family/ but that

would limit your placement options and would subject instances to deletion if the host is delet
You could align and constrain the fanúly to its host, but too many explicit constraints will
adversely affect model performance.

The Moves With Nearby Elements option is also a simpler altemative to usmg a hosted fai
When a component family does not need to cut or carve the host geometry/ consider using a

freestanding family or just a face-based family in conjunctíon with the Nearby Elements optionj
Refer to Chapter 15 for more mformation about hosted versus non-hosted values.

Copying Elements
7he Copy tool is another modifying tool that is nearly identical to the Move tool/ but it makes a
copy of the selected element at the location of the second pick. This tool doesn/t copy anything to

the Clipboard; it copies an mstance of an element or selection of elements in the same view. If

change views while using this tool/ your selection is lost.

To activate this tool/ choose elements you want to copy and then select the Copy tool in the

Modiíy tab m the ribbon; alternatively, activate the Copy tool fírst, select elements you want to

copy/ and then press the Enter key to start the copy process. Using the Options bar/ you can

choose to make multiple copies in one transactíon by selectmg the Multiple option.

An alternative to using the Copy tool is to use standard Windows accelerator keys to copy

elements. To quíckly copy a single element without the precision of the Copy tool/ click and drag
an element whíle pressing the Ctrl key on your keyboard. This technique is useful for quickly
populatmg a quantity of elements in a design without the required precision of the multiple
picks of the Copy tool.

COPYING ÜSING WORKSETS

If.you are workirig Ín:'a model m which worksharing is enabled,. be çareful when perfonning any •

fiïf^thòd òfcõpymg.Jhesé méthods includç pasting from the CUpboard, mirroring, and arraying, as

:weU às ,usmg the- Cbpy 'tool, Çopied eleiiients will always be placed on the active works;et, nbt •the

'wofkset. of the .original objecï. For .example, if you are copying chairs that have been plaCed. on,

<the Woïksetnamect-Furíuturebut your active workset is Structure, the copied chairs wiUbe assigned

»tüthe;StrucÈürewoïkset. For more mformation, refer to Chapter5, "Collaboratmg with a Team." : :

Rotating and Mirroring Elements

When refming or expanding your building design/ you will likely find a frequent need to rotate
or mirrar one or more objects. Just as wíth moving or copying/ there are a few methods for these

types of mteractive operations. We wül review these methods in the following sectíons.

ÜSING THE SPACEBAR

You can use the spacebar to rotate an element, both at the time of iniüal placement and after it

hás been placed. In addition to rotating an object m 90-degree increments, pressing the spacebar

will locate any nearby non-orthogonal references (walls/ grids/ or reference planes) as rotation

candidates. This is a great time-savmg command to become famüiar with because you can forgo

the necessity of using an additional tool/ such as Rotate or MÍrror/ after placing an object. Here

are a few examples:

Doors and Windows If you have a door with its swing in the wrong direction/ select it and

press the spacebar. You can cycle through ali four possible orientations of the door using the

spacebar. The same holds true for windows; however, many window farmlies only let you flip
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the window from mside to outside because many wmdows are symmetrical m elevat,,

you are creating an asymmetrical window family/ be sure to add flip contrais to the u^^J

family during its creatíon. These controls allow the spacebar to work on hosted eleinen^0

Walls ^ If you select a wall pressing the spacebar flips the element as if it were bein^ m^

aboutits length. Walls flip based on their location line/ which often isnrt the centeriinç
assembly. If you aren't sure which direction your wall is facmg/ select it and look for

flip-control arrows. These are always located on the exterior síde ofwalls (Figure 3.:

can also use the spacebar to flip the direction of an object. Simply select the object and hÏ+
spacebar to toggle through placement options while you/re locating a component.

FIGURE 3.11

The flip arrow is another

way to reorient an

element. For walls, it

is always found on the
exterior side.

Freestanding Elements If you select a freestanding element, the spacebar rotates the

element around the center reference planes defined in the family. Dependmg on how the

family was built/ the rotation origm may not make the most sense. If you decide to edit

a family to change the location of the geometry relatíve to the center reference planes, be

careful: when the family is loaded back mto a project/ ali instances of the family will Jump to <
new location based on the change you made relaüve to the reference planes.

USING THE ROTATE TOOL

To rotate an element, select it and click the Rotate tool m the Modify panei. Remember, you can

also activate fhe Rotate tool first/ select one or more elements/ and thenpress Enter to beginthe

operation. This is a two-click operation similar to the Move and Copy tools. The default i-otation

pomt is based on the center of the selected elements; however/ you will most likely want to

designate a more meaningful center.

To choose a new center of rotation/ you have a couple of options. You can drag the center icon':

to a new location before clicking to set the starting reference angle. Note thatyoumight have to

zoom outin order to find the center icon. The second option is to select elements youwant to

rotate and then use the Flace button m the Options bar to simply place the rotation point in the
desired location without dragging. Once the center is established/ begin mtating the element

usíng fhe temporary dimensions as a reference or by typing in the angle ofrotation explicitly.

^=SÏS5ï7i;Ï=^^^^^^^

plumbing fixtures.

|°£toÍt,andbath
lures are mirrai
Cdthecenterlineof

ichasewall:
Iselectíngtheaxis;

|itheïïiirrored

lents.

Lte^ottes^^ï^^^^^^^^^a^^s^^^^^^^^^^'
BEING CARBEÜL WHEN MlRRORXNG

T,e Mi^tools shouldbeu^ca^^^^^^^^^^=c?:EEEï^^^^^^^ .
o^rationtosuTt a design maydi|torta,pr,od^m^o^T^ ^^d •
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You can create two types of arrays: Unear and radial. Linear arrays are set as the defaul^

because they re the most common. As you would expect/ a linear array creates a series of

elements in a Ime. Each element in the array can be given a defined distance from the previf

element (Move To 2nd option) or can be spaced equally based on a defined overall array !<
(Move To Last option). Figure 3.13 shows a linear array where the M.ove To 2nd option was

selected to define a fixed distance between each mstance in the array. ThÍnlí of this type of a,

as additive and subtractive: if you change the number/ the length of the array increases or

decreases.

FIGURE 3.13

The Move To 2nd option
is used in the Array tool
to set a fixed distance

between instances:

(a) setting the array
distance; (b) changing
the number of

elements in the array.

^ l' /'

/ /

;
l
V-

r

1
l

(a)

(b)

If you want to arrange elements in a fixed space and the exact spacing between elements is

less important/ use the Move To Last optíon. Figure 3.14 shows an array where the location of it

last element was picked and fhe elements were placed equally befween the first and last ele-

ments. With this opüon/ the length is fixed and the array squeezes elements within that con-

straint as the number changes.

A radial array uses the same options as a linear array, but it revolves around a center point.

The Move To 2nd and Move To Last options function as angles instead of distances in a radial

array. You can specify the instance angle or overall array angle with two pícks, or you can enter

spedfíc value. Wíth this type of array/ elements auto-rotate só that each element faces the centerj

of the array/ as shown in Figure 3.15.
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The radial array is a Uttle trickier than a linear array. Here is how to achieve the example

shown m Figure 3.15:

l. Downloadandopenthefilec03-Array.rvtfromthisbook/swebpageat ^ ^

www^w7leyycom/go/fflaster1ngrevit2e20.ActivatetheLevellfloorplan.Toassistm
s"tartingïeradiararray, we provided a detail line to help locate the intended center of

the array.
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2. Select the chair and activate the Array tool from the Modify tab in the ribbon.
Options bar/ select the Radial opüon button/ change Number to 6/ and choosp ^WSÏ
Lastoption. ~ -—uleM^

3. In the drawing área/ click and drag the grip indicating the center of rotation i

element to the endpomt of the detail Une provided.

icudí-themous.Ï^ defmeany startmg point An exact startmg point is not importantl
because you will be defínmg a complete circle in the next step.

5. Do not click a second time; mstead/ go to the Options bar, type 360 in the Angle oDti,
and press Enter on the keyboard. UFUO^

6. Press Enter or click any open space in the drawing área to complete the command.

Enablmg the Group and Associate option allows you to treat an array as a group tha

modified later to adjust the number and spacing of the array. If this option is uncheckecL
array is a one-off operation and you have no means of adjusting it after it is created. l

As shown preyiously in Figure 3.13 and Figure 3.14, when an element in a grouped arravl

selected/ a contrai appears/ indícating the number of elements in the array. Editing^that numtí

changes the number of elements in the array. This tool comes in handy when you^are creatin]

certain families because the array number can be associated with a parameter or drii

mathematical formula. See Chapter 15 for a detaíled exercise.

GROUPING ARRAYS OV DATUM ELEMENTS

When developing a project for a multistory building, you may find that using the Array toóÍ

quick and easy way to generate many leveis and grid lines. We recommend. not using the Group,

Assodate option w^hen arraying datam elements. Maintaining grids and leveis inside groupsj
cause problems with elements that refer to those data. -

Scaling Elements

The Scale tool lets you scale certain lines and graphic elements in 2D that are appropriate for
scaling such as imported raster images and 2D line shapes. Although it/s not an obvious optio|

. e too1 can be used m sketch mode for any type of sketch-based element in a project or f|
solid and voíd geometry sketches in the Family Editor.

Keep in mind that you are working with a model made of real-world objects/ not abstract

primitive forms. You cannot scale most elements because itrs not practical or meanmgful and

may cause dangerous errors in scheduling and dimensions. For example/ you shouldn't scale 1

size of a door, wall/ or sink because they represent real assembUes and scaling them would meè

resízing ali their components. This would lead to impractical results/ such as a sink being

displayed as a fraction of its achial manufactured size.
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AlÍgning Elements
i/ve been using Revit for any amoimt of time/ you have likely discovered the power of the

Hgn.tool. It can supplant the need to use many of the tools we have already discussed, such as

lSp. andRotate.TheAUgntool lets you line up elements in an efficient way that works on

almost ali typesof objecta
'With this tool, you explicitly align references from one element to another/ rege

?f either object. For example/ you can align windows in a facade só that their centers or

openings are ali in alignment. To use the Align tool/ activate it from the Modify tab in the ribbon
id fírst select the target reference—a reference to which you want to align another element.

Next/ select what you want to align to that reference—the part or side of Üie element whose

,ition needs to be modified. The second element picked is the one that always moves mto

t. This selection sequence is the opposite of the other editmg tools we/ve discussed só

far"so remember/ destÍnationfirst, then the element to align.

As soon as you make your second pick and the aligned element is moved, a lock icon appears/

allowing you to constram the alignment. ïf you click the icon/ thereby constrainmg the aUgn-

ment/ the alignment is preserved if either element moves. Figure 3.16 illustrates the use of the

Align tool to aUgn multiple windows in an elevation view using the Multiple Alignment option

on the Options bar.

URES.lfi
IcanusetheAlign
S^to Une up edges of
llowsinafacade,
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The Align tool also works witHn Filled Region model patterns/ such as brick or stone on

surfaces of model objects. Select a line on an object such as the edge of a wall and then selec

Une in the surface pattern. Use the Tab key if you cannot get surface patterns selected vvi\

fírst mouse click. Note that the Align tool will also rota te elements m the process of aligny

to objects that are not parallel. ThLs is a real time-saver compared to moving and rotatiní

Trimming or Extending Lines and Walls
You can trün and extend lines and walls to one another using the Trim/Extend tools on the

Modify fab of the ribbon. There are three separate tools in the ribbon: Trim/Extend to Cornprl

Trim/Extend Single Element/ and Trim/Extend Multiple Elements. Witih the Trim/E?
you first activate the tool and then operate on elements in the model/ selecting two lines or w^

that need to meet in a comer or at a T-intersection.

The Trim/Extend tools are used frequently for editing sketches of floors and roofs because]
easy to end up with overlapping lines that need to be trimmed to form a closed loop. Keep m|

mind that with the Trün/Extend tools, you are selecting pairs of elements to remain, not to

remove. Although the Single Element and Multiple Elements tools are similar to the Bxtend

command in AutoCAD/ the behavior of the Trun/Extend to Cornei tool in Revit is more like

of the Chamfer or Fillet command rather than its TrÍm command.

The Trim/Extend tools for extending a single element or multiple elements function m a

slightly different way than Trim/Extend To Comer. To extend a. wall or line/ first select a targl

reference; then select the element you want to extend to that target (Figure 3.17). Using the Til

Extend Multiple Elements tool/ you first select the target reference; then each subsequentpicl

extends the selected element to the target reference. You also have the ability to use a selectiol

box to trim multiple elements.

FIGURE 3.17
Extend walls to

references by (a) picking
the target and then

(b) the waU to extend.

ÜSING TRIM/KXTEND ON LINE-BASED COMPONENTS

You can use the Trim/Extend tools on line-based families that are either model or detâil coi

nents. Try this using a line-based detail component for batt insulation or gypsum waJlboard-j

Trim/Extend tools will help make your detaitíng process much more effícient and fun!
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Splitting Unes and Walls
The Split Element tool operates on walls and lines and lets you divide an element into two

pieces. To cut an element, activate the Split Element tool from the Modify tab in the ribbon and
place the mouse pointer over the edge of a wall or Une. Before you click, you will see a preview

of the split line. The split line will automatically snap to any adjoining geometry.
The Options bar displays a nice feature called Delete Inner Segment that removes the need to

use any of the Trim toais after a splitting operation. In the example in Figure 3.18, the middle

section of a wall needs to be removed só that you end up with a clean set of wall joins. Using the

Split Element tool with the Delete Inner Segment opüon checked, you can accomplish this with
two clicks and get a clean condition without having to retum with any of the Trim commands.

feüRB 3.18
[igtheSplitElement

^IwiththeDelete

lerSegment

tion checked

SPLIT WlTH GAP

The Split With Gap tool aUows you to spedfy a gap distance and pick a smgle point on a wall.
Alfhough the wall is divided into two separate segments/ the gap distance is mamtamed with an
automatic constraint To use Split With Gap/ follow these steps:

l. Go to the Modify tab/ and from the Modify panei, select Split With Gap.

2. Specify the Joint Gap distance m the Options bar. Note that this distance can be set only
between 1/16" (1.6 mm) and l'-0" (300 mm).

3. Move the mouse pointer over a wall and click to place the gap.

Once you have successfully split a wall with a gap/ select the wall and notice the constraínts

(locks) on the gap and between the two parallel wall segments (Figure 3.19). Try to drag either of
the wall ends separated by the gap/ and you will see that the gap distance is maintamed. Try to
move the waU in a direction perpendicular to the waU segments/ and you will notice that the two

wall segments remain aligned.

iURE 3.19

ig the Split
Gap tool
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ïf you would like to rejoin waUs that have been split with a gap/ follow these steps:

l. Select a wall that hás been split with a defined gap.

2. Click the constraint ícon in the gap to imlock the dimension constraint.

3. Select each wall segment and cUck the Allow Jom icon near the end of the wall tha
was split.

4. Select the other wall and repeat step 3.

5. Drag the waU end grip of one wall segment to the end of the other segment. The \vs
should join.

Note that on walls with smaller gaps, the segments may automatically join as soon as •

select Allow Join; however/ rejomed segments may not form a smgle segment. If you have

trouble joinmg two paraUel wall segments into one/ try to drag one of the wall ends

the other and release the mouse button; then drag the segment back to the other end.

Offsetting Lines and Walls
Offsetís simüar to the Move and Copy tools in that it moves and makes a copy of an elemená
offsetting it parallel to an edge you select. You can fínd the Offset tool in the Modify fab of'ï]
ribbon. Vou can also speciíy an ofíset distance as an option m the Options bar to give an offsp

distance or choose the Graphical option if you want to manually locate the offset element.

This tool is especiaUy useful in the Family Editor when you are makmg shapes that have;

(ïr?,iÏïrtí thÍck^ss.m pfofile/ such as extruded steel shapes. The Offset tool hás a Copy opti|
avaÜable m the Options bar that determines whether the offsetting operation generates,
the selected elements or simply moves them.

Remember that you can Tab-select a chain of elements and offset them in one click/ as shol

in Figure 3.20. When the Offset command is active/ Üw dashed line appears on the side ofthe
element to which the offset will be created.

FIGURE 3.20

Use OfFset with

Tab-select to copy a

chain of elements.

Preventing Elements from Moving

In some cases/ you may want to make sure some elements in the model never move. An exí

of this is when you work on a renovation to an existing building. For obvious reasons/ you

would not want to move existing waUs. Other examples ínclude ímported drawings/ grids/

leveis/ and exterior waUs. There are two ways to deal with this and lock certain elements/ thi
preventing them from moving.
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plMNING ELEMENTS
Vou ca" restrict an elemenfs ability to move by pmning it with the Pm tool. Use thís toolto lock

jown criticai elements that need to remam fíxed for extended periods of time As one examPle/

^s is a valuable tool to use on referenced CAD files becauseit is easy to accidentally select a
id drag it or move it. This kmd of accidental modification can lead to coordmatíon

Íoblems/ even in a BIM envü-onment. Also, a very common practice is to pin grid Imes and

leveisibecause you certamly do not want to accidentaUy relocate those either.

This tool is in the Modify panei of the Modify fab in the ribbon. Select one or more elements
for which you want to prevent movement and click the Pin tool. If you try to move the element/

noti-ung will happen—you will not even get a preview of a potential move. To impm an element/

elect itand click the Unpm tool, which is also located in the Modify panei. You can also unpin
aneÍement by clicking the pin icon that appears near a pinned element when it is selected.

Revit helps you avoid accidentally deletmg elements. Instead of permitting the deletion and
yvidmg awaming/ Revit wiU warn you that the element is pinned and insü-uct you to unpin

the element before using Delete. If you select multiple elements (some pü-med and some not

Ímned) for deletion/ Revit deletes the elements that are not pinned and warns that you must

unpin the pinned elements before deleting them.

Combining the Fin tool and the selection filters will allow a BIM coordinator to create a
selectíon set for pümed items. By loading the selection set/ the coordinator can double-check that

the items are indeed pmned.

CONSTRAINTS
Constraints aren/t as rigid as the Pin tool but they do allow you to create dimensional rules in

the model só that elements remam fixed relative to other elements. You can create a constramt

using dimensions or aligmnents and then cUck the lock icon that appears upon creation of a

dimension or completion of an alignment operation.
A simple example of using constraints is maintaining a fíxed distance between a door and a

side wall. If the wall moves/ the door will also move. If you try to move the door/ the software

wül not let you move it. Look at Figure 3.21; the door hás been constramed to remain 4"

(100 mm) from the wall face.
This type of constraint is accomplished by placing a dimension string between the doorjamb

and the face of the wall and then dicking the lock icon on the dimension. Note that the dimen-

sion can be deleted while preserving the constramt. If you delete a constrained dimension, an

alert will appear, givmg you the option to unconstrain the elements or simply delete the dimen-

sion whUemamtaming'the constraint (Figure 3.22). Note that you can determme where con-

straints were by creatmg new dimensions; constrained relationships wÜl still display with the

lock icon.



98 | CHAPTER 3 THE BASICS OF THE TOOLBOX EXPLORING OTHER EDÏTING TOOLS | 99

FIGURE 3.21

A door constrained to a

waU can't be moved

independently
ofthewaïï.

FIGURE 3.22

Deïetíng a constraíned
dimension generates

an alert.

You can view these relationships when a constrained element is selected. Simply hover th|
mouse pomter near the constraint icon/ and you wiU see the dünension constraint representei

a dashed dimension string. Another option to see what is constramed in your model is to usej

Reveal Constraints tool on the view control bar. Selectmg this will toggle a setting allowing y|
to see what elements are constrained in the model (Figure 3.23).

FIGURE 3.23

Showing constrained
elements using the

Reveal Constraínts tool

Ín the view control bar

Reveal Constraints tool

/

gyploring Other EdÍting Tools
other editmg tools are available/ and we will cover them m subsequent chapters when

id in specific operations. However/ there are a few you should know about now

because they are generic tools you can put to immediate use on any project.

Üsiüg the Join Geometry Tool
: walls to floors and roofs creates dean-looking drawings, and Revit will attempt to create

Íese joins automaticaUy; however/ m some cases, elements don/t look nght untíl they are^

expUcltiy Joined. This is where the Join Geometry tool comes into play. This tool creates joins
between Óoors, walls/ ceilings/ roofs/ and slabs. A common use for this tool is Ínbuilding

sections/ where floors and walls may appear overlapped and not joined. Figure 3 24 shows a

fioormtersectmg with some walls that aren't Joined. Using the Join Geometry tool/ you can clean

these conditions nicely.

IRB 3.24
Isecüons at Levei 2

Ibeenjoíned:
Injoined; (b) Joined.

/

/

l

/
/
/

-Lwel-2-X.í
-10r-0" i-evel 2wí2-

7. o"

(a) (b)

You might notice that some joms—especially in a view set to the Coarse detail levei—<:ontain

a thin dividing Une betvveen frwo elements. This is usually because the two elements you joined

consist of differing materiais. Ensuring consistent material application will give you increased

graphic quality in your project views.
You should also be aware fhat joinmg large host elements to many other elements may

degrade model performance. One way to avoid this is to apply a black solid fill to elemente^in the
cutplane of your coarse view sectíons and avoid overall manual joining; then selectively join for

médium and fine views. Vou can do só easily by selectmg the element in question (wall, floor,

ana só forth) and choosing Edit Type from the Properties palette. By default/ the Coarse Scale Fill
Pattem is set to No Pattern. Set this to SoUd Fill; in ali your coarse views, your elements will

show as solid black (Figure 3.25).
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FIGURE 3.25
üsing Solid FUI to show

walls, floors, and

roofs as joined in a

Coarse view setting

Using the Split Face and Paint Tools
Occasionally/ you may need to apply a thin material to the face of an object without makü
new type of element. You may also need to divide an overall surface into smaller regions to|

receive dífferent materiais. You can use the PaÍnt tool to apply materiais and the Split Face tc

divide object surfaces. Wíth the Pamt tool/ you can apply altemative materiais to the exteriol
faces of walls/ floors/ roofs/ and ceilings. This material hás no thickness/ but you can scheduf

with a material takeoff schedule and annotate it with a material tag. A typical use case for

two tools is the application of a carpet or thín tile to a floor. See Chapter 14, "Modeling PlooJ
Ceilmgs/ and Roofs/" for a detailed exercise on this topic.

Copying and Pastíng from the Clipboard
Copying and pasting is a familiar technique used in almost ali software applications/ and Rei
provides the basic features you would expect (Ctrl+C to copy and Ctrl+V to paste). It also ha
some additionaÏ time-saving optíons that are specific to workmg on a 3D model.

To copy any element or group of elements to the Clipboard/ select them and press Ctrl+CJ
paste/ press Ctrl+V. In the majority of cases, the software pastes the elements with a dashed |

bounding box around them. Vou then determine where to place the elements by clickmg a p|

to define its final position. In the Options bar/ you will fínd a Constrain option that when cli|
will only let you defíne the location of the pasted content orthogonally to the origmal elemÉ
With the elements copied to the Clipboard, you'11 also find some additional tools on the
CUpboard panei of the Modify tab.

EDIT PASTED

Immediately after you select a point for the location of the pasted content/ you wíll fínd a nej
panei in the ribbon called Edit Pasted (Figure 3.26). You can click Finish to complete the pastj
action or start anotíier command. If you are unsatisfied with the pastmg action/ select Cance|
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3.26
actions are

gwben
elepien"-

oo^ Erfit PEBted Finish
EiementE;

EdÍtPa^ted

w select Edit Pasted Elements/ a special mode wül be started with the Edit Pasted tools
;aïthe top left of the drawing área (Figure 3.27). In this mode/ only the pasted clemente

a^editaHe"You can use the Select Alfor Filter button to refme tilose elements withm the Pasted

seÏection. When your edits are completed/ click the Finish button.

13.27
stedmodeallows

|onalmodification

Sitedelements.

:i R

Filtw Ssteet FÍnaÍKe Finfeh Cancei
AÈ! Seteetedi '

EditPastecf

PASTE ALIGNED
[ to paste elements with greater location control/ pasteAlignedoffersoPtionsto_make,

i simple and efficient. These options allow you toquickly dupUcate elements from one

vieworone levei to another while maintammg a consistent location in the x-coordmate^an^

yÏoordinate planes. After selectmg elements and copymg them to the Clipboard/ fínd the Paste

button in the CUpboard panei, as shown m Figure 3.28.

EftB 3.28
l-Aligned options

Five options/ m addition to the Paste from Clipboard option, are available whenyou cfíck the
Paste drop-downbutton. Depending on the view from which you copy and what kinds.of

3'ucopy/ the availability of these options will change. For example/ if you sele^t^
model element in^a plan view/ you wiU not have the Aligned To Selected Views option. These

options are as follows:

Aligned To Selected Leveis This is a mode you can use to quickly paste copied_elements to

m^yâfferent leveis simultaneously. When you select tMs option/ you choose leveis from a
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list in a dialog box. This is useful when you have a multistory buildmg design;
copy a furmture layout that repeats on many floors and selecting levei graphics in a sectjf

elevation would be too tedious.

Aligned To Selected VÍews If you want to copy view-specific elements, such as draftin^

Unes/ text/ or dimensions/ Ü-ús option allows you to paste them by selecting views from a lu

of views in a dialog box. In the list available for selection/ you do not see leveis listed but

rather see a list of paraïlel vÍews. For example/ if elements are copied from a plan view, au

other plan views are listed. Likewise/ if you copy from an elevation view/ only elevation viel

are listed.

Aligned To Current View This option pastes the elements from the Clipboard into the açt
view in the same spatial location. For example/ if you copy a series of walls in one view,

switch to another view in the Project Browser/ and paste with the AUgned To Current View

option/ the software pastes the walls to the same x-coordinate and y-coordinate locatíons m;

the view you switched to.

Aligned To Same Place Ttís option places elements from the Clipboard in the exact place:
from which they were copied or cut. One use for Üús tool is copying elements mto a design

option; see Chapter 11, //Workmg with Phasmg/ Groups/ and Design Options/" for an explanj

tion of design options.

Aligned To Ficked Levei This is a mode you can use to copy and paste elements between |

different floors by picking a levei in a section or elevation. Although you can cut or copy

elements from a plan view/ you must be m an elevation or section to paste usmg this option.|

You might use this paste option to copy balcordes on a facade from. one floor to another.

Using the Create Similar Tool
Rather than hunting through a list of famÍUes or rnaking copies you/d have to edit later/ try usi

the Create Similar tool to add new mstances of a selected element to your model.

This tool is available in the Create panei of the Modify tab of the ribbon when an object is
selected or from Üie context menu. To use this method, select an existing instance of the same

type of element you/d Uke to create/ click the Create Similar tool, and you will ünmediately be:

a placement or creation mode according to the type of element. For example/ if you use Create

Similar with a floor selected/ you/re taken direcüy into Sketch mode/ where you can start

sketching the boundary for a new floor.

Keyboard Shortcuts (Accelerators)
ir productivity even further, you may like to use keyboard shortcuts to speed up

commands and minimize interruptions to your workflow. When you hover your mouse

róinter over any tool m the ribbon/ the keyboard shorteut is mdicated to the right of the tool

name/ as shown here.

'.f&ste.s.a ntsn-síífüdura^wslih-íthebüfldmg mtiáei,

'ress M ?r fiNife

You can customize the keyboard shortcuts assigned to ali commands. To access this tool/ go to

theView tab m the ribbon, fínd the Windows panei/ and select^User Interface > Keyboard

Shortcuts. When the Keyboard Shortcuts dialog box appears (Figure 3.29), you can search for

commands in the Search box.

FlfiORB 3.29
Istomizekeyboard
icrtcuts for commonly

Ised Revit commands.
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Once you fínd a conunand to which you'd like to assign a shortcut/ select it and typg

shortcut in the Press New Keys box. Click the Assign button/ and you will see the
added to the selected command. CIick OK to dose the dialog box/ and the keyboard shoT

will be ready for Ímmediate use. If you choose to modify the shortcut/ Ít is recommenderi il

commands unique. Though Revit 2020 allows for multiple commands to be associated tr

identical keyboard shortcut/ a wammg message with instructíons on how to cycle bettvp^ï

multiple commands notifíes you that this is the case. As an example/ if you use the shortf

for both AÏign and Angular Dimension/ a Revit helper tip next to the cursor notifies yc
fhere are other associated conunands that can be cycled with the arrow keys.

Double-Clicking to Edit
Revit allows you to double-click families and components to launch the respective editint

Although this may be the epitome of editíng efficiency/ you also have the ability to customi;
behavior—even completely disabling it. From the File tab menu/ click the Options button.

Options dialog box/ select the User Interface settings/ and then click the Customize button!

Double-Click Optíons. In the Customize Double-Click Settings dialog box/ you will see the
to which you can customize the behavior to your likmg. Note that any of the actions can be

Do Nothing and some can be set to Edit Type or Edit Element.

ISkefccheáÊfement

EinsiifeVrews/ScherfulesonSbeets

l Outsíde Views on Sheets

lAïsemblÍës

[Groups
!Staífi

Ëdit Eiemení

Activats Vísw

Deaeíivate View

Edtt Eiement

Eáít Efement

Etfit EÏemerit

Sharing Models with the Cloud
Another tool in your Revít toolkit is A360. This is Autodesk/s cloud platform that allows you toj
visualize models and share content with other team members, regardless of whether they are

using Revit. A360 is a doud-based applicaüon. You can find the site at htíps: //A360 .autodesj
com. If you have purchased an Autodesk product, you have an account on A360. The default

account comes with 5 GB of storage space as its only limitation. When you visit the site/ it will

allow you to either log in or set up an account if this is your fírst time using A360. The default

„ best in Google-s Chrome browser and looks like Figure 3.30. There is also . compamon

llte^J^nd"iPhone/iÏad app you can download.

1.30
&A360site

po, fhe sake of famUiarizmg you with the site »d^capabmties, we-re going to set up a new

p^ct^dupload a sample model. To do this/ follow these steps.

l. Select the Create Froject button on the main page after you/ve signed m.

" ï^^s^s^x^ss^-S^td'Snagewoe beetlï?usto^eïeP'^"Choose Create Project when

youfre done.

companion website.

'Fl£u^3c32L<shíw7the defa"ult3D view with a wall element selectedândltePWP^
^iSïeÏST^aTeZÏbmty"^^^^ °" -Y a5Pect of the
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model. Usmg the tools at the bottom of the screen/ project team members can leave conu^çj

about the design or other aspects of the model.

FIGURE 3.31
The project view in A360 j ^ -' e_" >ls^n"^

M^tenns Rcvic ArchiíQtture

FIGURE 3.32

TheA360
default 3D view

As a last tool to explore/ select the 3D box icon at the upper-left comer of the site. From

expanded menu/ you can select and view any of the views that are already defined m the mo^

You can open up sheets/ 2D views/ and 3D perspectives. If it's in the model/ you have the opt

to view it on A360! Figure 3.33 shows the view of the buildmg section'. Note that you also havj
of the web tools available to zoom/ select elements/ or create markups.

WMle the A360 site gives you a lot of versatility/ you nüght want to curate the content forj
what is viewable (or not viewable) on the site. Dependmg on who you/re sharing the contentj

with/ you might only want them to see views that are in a more finished state, or you núght •

to exclude design options and other "works in progress.

[3.33
yofthe
.gection

Managmg the content can be done direcüy in Revit. Simply open fhe same model and choose

the Collaborate fab. Here you can select the Publish Settmgs tool from the Manage Models panei.

This wül open the Publish Settmgs dialog box and provide you with an entire list of the views
and sheets that are currently in the model. Here you can assign Sets to the views for further

organization as well as selectmg or deselecting the views you want to show in A360 (Figure 3.34).

EWE 3.34
|agingtheA360
mt from Revit

•N3rsieEfe«aíion;l>ioEtíj SriertSrti
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The dialog box even gives you the opportunity to preview the view you/ve selected só

can see what it wíll look like once it is uploaded to A360. Once your changes are made,

Save & dose to save your settmgs. The next time you upload a model to A360/ only th(

views will be visible on the site for your larger team.

Modeling Site Context
In the previous sections of this chapter, you learned about the fundamental tools for editino-

modifying model elements and viewing project files online. Other tools you should becoine
familiar with are the site tools. They allow you to create a context wiüiin which your buildii

models can be situated. For example/ a toposurface will create a hatched área when you viei

your building in a section/ and it will function as a hosting surface for site components such

trees/ shrubs/ parking spaces/ accessories/ and vehicles (Figure 3.35).

FIGURE 3.35

A toposurface can host

components, such as

trees, people,

vehicles, and other

entourage.

The site tools are intended for use only in the creation of basic elements, indudmg topogra-j

phy/ property Unes, and building pads. Although editmg utiliües are avaÜable to manipulate
site elements/ these tools are not meant to be used for civil engineermg like the functionality

found inAutoCAD® Civil 3D®.
In the following sections/ you II learn about the different ways to create and modify a toposi

face/ how to generate property lines with tags/ and how to model a buÜding pad wittín a
toposurface.

:aToposurface
iggests, a toposurface is a surface-based representation of the topography context

l^r^ttins'a pï°Ject- n is not modeled as a solid/ however/ a toposurface will appear as if it were

ÏÍirHna 3D view with a section box enabled (Figure 3.36).

|3.3®
lÍ^cewül

lasolidina

ronlyifa
Iboxisused.

You can create a toposurface m one of three ways: by placing points at specific elevations/ by

usmg a linked CAD fíle with lines or pomts at vaiying elevations/ or by using a points file
generated by a civil engineermg application. We'11 examme these techniques m the following

exercises.

TURNING OfN AKtójOl^ TABS

Ífypu don't séé the Mâ?síng'&;Sité àib,,jpst navigate to the File tab menu and choose Qptions From:

tï^e, âeleçfctheÜser Interfi^ëçategory. Here yóu cafa'turn onand offariy ofthe tabs from the ribbpn^, ^

CREATING A TOPOSURFACE BY PLACING POINTS

The simplest way to create a toposurface is by placmg pomts in your Revit project at specific

elevations. To create a clean outer edge for your toposurface/ draw a large rectangle using detaü

lines in your site plan. When you are creating a toposurface by placing pomts/tiiere are no

line-based geometry tools; however/ points can be snapped to the detaíl lines. The following

exercise wül show you how to create a toposurface by placing pomts:

l. Begm by opening the fíle cQ3-S-i te-Tools.rvt or c03-S-i te-Tools-Metr-i c. rvt, which

can be downloaded from this book's companion web page.

2. Activate the floor plan named Site/ and you will see a rectangle created from detail Unes.
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3. Go to the Massing & Site tab/ and from the Model Site panei/ click Toposurface. ]^oti,

the contextual fab in the ribbon that the default tool is Place Point.

4. Notice the Elevation value in the Options bar. Set the value of the points you are

about to place.

Also note that the elevation values are always related to the Revit Project Base Point.

do not relate to the elevation of any shared coordinates.

5. With the Elevation value set to O'-0ff (O mm), place a point at each of the left comers ofl

rectangle.

6. Change the Elevation value to 20'-0" (6000 mm) and then place a point at each of the ril
corners of the rectangle. You wiU notice the contour Unes of the surface begin to

after the tMrd point of the surface is placed.

7. In the contextual tab of the ribbon, cUck Finish Surface (green chèck mark) to complet
toposurface. Activate the Default 3D view/ and you wÜl see the sloping surface, as sho^

in Figure 3.37. And keep m mind that this will be a thm surface/ not a solid. Notice üial

3D view in this project already hás the section box property enabled. To adjust the sect
box/ activate the Reveal Hidden Elements tool m the view control bar.

8. Save the fíle for use m a subsequent exercise in this chapter.

FIGURE 3.37

A simple toposurface

created by placing
pomts
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following exercise/ you will download a sample DWG file with contour polylines. Vou

file into your Revit project before creating the toposurface:

mloadand open c03-S'ite-L-ink. rvt or c03-Si'te-Link-Metnc. rvt fromthís

book/s websíte.

pownload the file c03-Si te- L-i nk. dwg from this book/s web page.

Activate the Site plan m the ProJect Browser.

Go to the Inseri tab in the ribbon and click the Link CAD button. Select the c@3-S'i te-

L-i nk. dwg file and set the foUowing options:

• Current View Qnly: Unchecked

• Import Units: Auto-Detect

• Posítioning: Auto-Center To Center

• Place At: Levei l

• Correct Unes That Are Slightly Off Axis: Unchecked

5. Click Open to complete the insertion of the CAD Imk. Open a Default 3D view to examine
the results (Figure 3.38).

13.38
: CAD file as seen

.,.,/''

CREATING A TOPOSURFACE FROM IMPORTED CAD DATA

A conunon workflow you may encounter involves the use of CAD data generated by a civü

engineer. In this case/ the engineer must create a file with 3D data. Keep in mind that Revit

models are in real-world units (feet/ mches/ meters, and só on)/ só any content you bring mto|

model from other sources/ like a civil engineer/ would also need to be modeled in real-world j

urdts. Blocks/ circles/ or contour polylines must exist in the CAD file at the appropriate elevati

to be used in the process of generatmg a toposurface m Revit.

6. From the Massing & Site tab m the ribbon/ click the Toposurface button. In the Tools panei

of the Modify | Edit Surface fab on the ribbon/ select Create From Import and then Select
Import Instance.

7. Pick the linked CAD file, and the Add Points From Selected Layers dialog box will appear
(Figure 3.39). Click the Check None button and then select the layers C-TOPO-MAJR and
C-TOPO-MINR.
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FIGURE 3.39

Select onïy the layers
containing 3D contour

information.

8. Click OK to dose the dialog box. It may take a few seconds to senerate the ünin^ â
on the^contour polylmes in the linked file, but they will appearuas blacksquraïeLs^l

ali been placed. ' ^ ----i~"^o wuç

9. If you would ïike to use fewer points to defíne the toposurface/ click the SimDlif
, in the contextual ribbon and enter a larger value/ such as lf-0" (SOOnírO;

^ick theFinish surface button m the contextual ribbon fab to complete the topos J
• the visual style of the view to Consistent Colors to examine your resuÍts."

10.

Creating a Toposurface from a Points File

A!ess-.commonmethodfor creatmê a toPosur^ce/ although equally effecüve whenusir

ita, is usmg a poínts file. A pointsfile is a text file that is usually generated from a dv

engmeermgprogranLlt must be a comma-deUmited file (TXT or CSV format) in which"the1
^ z-coordinates of the points are the first numeric values in the file. In the foUowmïexerc

^provided asample points ffle that was exported from AutoCAD Civil 3D usSigÏe
(comma-delürdted) format settmg;

l. Open the file C03-S-Í te-Poi nts-Start. rvt/ which can be downloaded from this
:/s web page.

2. Download the fíle c03-Poi nts. csv from this book/s web page to your local compute

3. Activate the Site plan in the Project Browser.

FrTthe Massing& site tab on the ríbbon/dick the Toposurface button. In the Tools!
Edit Surface fab/ select Create From Import and then choose Specify |

Points File.

5* Navigate to the CG3;points •csv me and dick Open. Note that if you were using a:

e/ you would change the Piles Of Type option to CommaDelmúted Text
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it dialog box, select Decimal Feet. It is important to understand the nnits of

in the points file to ensure that the toposurface wíll be created af fhe correcf

!SlI.aicl<OKtodose the dialogbox.

Finish Surface button m the contextual ribbon to complete the toposurface. Open

uit 3D view to examine your results. You may have to use the Zoom to Fit

' tíïmmand to see the extent of the new ÍOP°surface-

IrtFYINC THE SURFACE WITH SUBREGION
ile example in the previous exerdse represents a section of terrain across Lake Mead/

TOM wanted to define an área of the toposurface with a different material but not

Cpthe geometry of the overall surface/ you would use the Subregion tool. In the followmg

lïe/~you will use this tool to create a region that will represent the water of the lake:

DownloadandopenthefilecQ3-S-ite~Lake.rvtfromthisbook/swebsÍteandthen

activate the Site plan from. the Project Browser. In this víew/ there are dashed detail lines

l" that represent the edge of the water.

l. Go to the Massing & Site tab in the ribbon and click the Subregion tool.

Switch to Pick Lines mode m the Draw panei of the contextual ribbon.

Í4. Hover your mouse pointer over one of the dashed detail Unes on the left side of the

surface/ Tab-select the chain of lines/ and then click to select them. You will see a purple

sketch Ime appear.

|5. Repeat step 4 for the dashed detail lines at the right síde of the surface.

^6. Switch to Line mode m the Draw panei of the contextual ribbon and draw a Ime connect-

ing each open end of the water edge lines/ as shown in Figure 3.40.

boundary tor y%%/-/Mi";;/
'/'^ '//f/fl J // / r'/ ?

iimust be a '\í/./-////lílií\\ \ \

>ut can

[;edge of

•íH^/W/^\\!.\íu!i//////:!//!^
•^W^//:/Mil/ík

•^W/i//!/!!!.!l^í^

^;^/ï;.%^ÍífflÍ
^^w^:i'y-:ssi

7. CUck FÍnish Edit Mode m the contextual ribbon to complete the subregipn.

8. Activate the Default 3D view and select the subregion you created m the previous steps.
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9. In the Properties palette/ select the Material parameter, and click the ellipsis button l

open the Material Browser dialog box. Locate and select the material named Site

Note that you can easily find this material by typing Water in the search field at thp
the dialog box.

10. Click OK to dose the Material Browser dialog box; you will see the results in the ?lhl
as shown in Figure 3.41.

FIGURE 3.41

The subregion is
assigned a different
material for

visualization purposes.

When you use the Subregion tool/ the geometry of the original surface remaíns unchang|

you no longer need the subregion/ you can select it and delete it. Be aware that topographic|

surfaces cannot display surface pattems assigned to materiais.

USING THE SPLIT SURFACE TOOL

If you need to divide a topographic surface into separate parts for the purpose of editing the
geometry/ you can use the Split Surface tool. With this tool/ you can sketch a single line aloi

which the surface will be divided into two editable entities. These separate entities can be
recombined later usmg the Merge Surfaces tool. In Üie followmg exercise/ you wiU split a

topographic surface and edit some of the points. Remember that you can also use Split Surf^
to delete a portion of a topographic surface. Here are the steps:

l. OpenthefilecQ3-S1te-Tools.rvtorc03-S-ite-Tools-Metnc.rvtyousavedintt

Creating a Toposurface by Placing Points" exercise.

2. Activate the Site plan in the Project Browser.

3. Go to the Massing & Site tab in the ribbon and click the SplitSurface tool. Remember
you should use the Subregion tool if you plan to assign a different material only to
split region of the original surface.

lecf the topographic surface/ and you wiU enter Sketch mode. Using the Line mode m

panei of the contextual ribbon/ draw two lines that overlap the edges of the

surface/ as shown in Figure 3.42.

3.42
tóstbatoverlap

^ofthe
obic surface.

5. Click Finish Edit Mode in the ribbon/ and you will see the split surface highlighted in blue.

6. Activate the Default 3D view from the Quick Access toolbar or from the View tab.

7. Turn off the Section Box option in the Properties palette.

8. Select fhe split surface/ and click the Edit Surface tool in the Modify | Topography fab of
the ribbon.

9. Select the point at the outer comer of the topographic surface, and change the Elevation

value m the Options bar from 20/-0" (6000 mm) to 10'-0" (3000 mm).

10. Click the green check (Finish Edit Mode) m the contextual ribbon/ and you wÜl see the
result shown in Figure 3.43.

ÍURB 3.43
)lit region after

Íting the elevation of a
ler point

11. To illustrate the difference between a split surface and other topographic surface edits/

select the main surface and clíck Edit Surface in the contextual ribbon. Select the pomt at

the upper comer opposite from the splít region and change the Elevation value to 10'-0"

(3000 mm). Notice how the topology of the smaller spUt surface remams the same but the
larger surface area's grading changes to conform to the new Elevation value (Figure 3.44).
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FIGURE 3.44
Compare the difference
between (a} an edited

split region and an
(b) edited point directly

on the surface.

Creating a Building Pad
A bwlding pad in Revit terminology is a unique model element that resembles a floor with a
underneath it. ït can have a thickness and compound structure/ it is associated with a levei.

can be sloped using slope arrows while you/re sketching its boundary. The building pad is
dífferent from a floor because Ít will automatically cut through a toposurface/ defíining the outi
for your buüdmg/s lowest levei or basement.

The process of creating a buildmg pad is virtually identical to that of creating a floor. Let/s:
through a quick exercise to create a building pad in a sample project:

l. Open the file c03-S-ite-Pad . rvt, which can be downloaded from this book/s web pap

2. Actívate the floor plan named Site in the Project Browser. You will see an existmg topo-

graphic surface and property line. Notice that reference planes were created to demarce

the required zonmg setbacks from the property Ime. Foundation walls have been creafe

within these reference planes.

Note that you don't have to create a property line and walls before creatíng a building

pad. You might create a building pad before any other buildmg elements. Just realize th|
you can use the Pick Walls mode to associate the boundary of the building pad with the|
foundation walls.

3. Activate the Basement floor plan from the Project Browser.

4. Go to the Massing & Site tab in the ribbon/ and click the Building Pad button. In the
Properties palette/ change the Height Offset From Levei value to 0.

5. Switch to Pick Walls mode in the Draw panei of the contexhial ribbon and then pick the
inside edges of the four foundation walls. You can use the Tab-select method to place all|

four línes at once.

6. Click the Fmish Edit Mode button in the contextual ribbon to complete the sketeh and
then double-click the section head m the plan view to examine yout results. Notice that

the top of the building pad is at the Basement levei/ and the poché of the topographic
surface hás been removed in the space of the basement (Figure 3.45).
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are working on a project that hás a complex site condition that might require several

at different elevations/ you should be aware that the pads caimot overlap; how-

ever they can share common boundary edges. To help avoid tíús situation before you get too

'mvolved in modeling any of the pads m your project/ try using detaü Unes in your site plan to

lay out the pad design fírst.
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^ Asyoucan;.seem t:his dialp-gíiox, you can.cËtange^líe Sectíon Cut Material and the BÏevatj|

', Poche-Base settings.. Note-tliat the^evation vâlüe is m. rèlation .to.the Project Base Point. YJ

als,9.adjust£ii@ displa^fonnat ofíídntou^Unessh.Qwn oh tópío^-aphíti Súrfaces, as well as thll
',. dísplayed by^property línes,' ' . • ;';'."~ •ï':' '• \ ,;;'•• • '

Generating Property Unes

Property Unes are used to delineate the boundary of the lot within which your building -wi]
constmcted. These special types of lines are different from símple model lines or detail Unp

because they can be tagged with standard property Ime labels that will display segment lerjj
along wíth bearmgs. The property líne object can also report its área in a special tag.

Vou can create a property line in one of two ways: by sketching lines or by entering diste
and bearings m a table. In the followmg exercíse/ you will create a simple property linï

sketching and converting the sketched property line into a table of distances and bearings fe
companson:

l. Opence3-S-ite-Prop-L-ines.rvtorc03-S-ite-Prop-L-ines-Metnc.r-vt/whichyoi

download from Üüs book/s companion web page. Activate the Site plan view in the

Project Browser.

2. Go to the Massing & Site tab and click the Property Line button. When prompted by i
Create Property Une dialog box/ choose Create By Sketchmg.

3. Switch to the Rectangle tool in the Draw panei of the contextual ribbon and draw a

rectangle measurmg 120' ?< 70' (36 m x 21 m).

4. Click the Fmish Edit Mode button in the contextual ribbon to complete the sketch.

5. With the property line still selected, click the Edit Table button in the Modify j ProperJ
Lmes tab of the ribbon. You will be prompted with a warning that you cannot retum

Sketch mode once the property line hás been converted to a table of distances and

bearings. CÏick Yes to continue.

You will now see each vertex of the property Une expressed as a distance and a beariï^

shown m Figure 3.46.

6. Click OK to dose the Property Línes dialog box.

TAGGING PROPERTY LlNES WITH ÁREA

In standard construction documentation/ it is customary to annotate each vertex of a propertyj

Une with its distance and bearing. There are two different types of tags you can use to annotaÉ

property Unes. In the followmg exercise/ you wül load these two types from the Revit default |
library and tag each segment of the property line/ as weïl as display the área contained wit

l. Go to the L-isert fab of the ribbon and click the Load Family button. Navigate to the P£\
default library; double-click the Annotations folder and then the Civil folder.

2. Locate the followíng fües and select Ü-iem both by pressing the Ctrl key (the equivalentj
metric library famÜies are shown m parentheses):

property L-ine Tag. rfa (M_Property L-ine Tag.rfa)

^ property Tag - SF.rfa (M_Property Tag.rfa)

Click Open to load both families.

Go to the Annotate tab of the ribbon, click Tag By Category/ and then deselect the Leader

option m the Options bar.

Click each segment of the property line to place the tags mdicating the distance and

bearing/ as shown in Figure 3.47.
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Now that you have tagged the individual vértices cf the property line, Ít is Ume tn ^.

área withm the property Une This process is not the same as applying an área tag bec^iï1
área object doesn/t exist for the property Ime. Instead, the annotationfamily Proper

- SF.rfa (M Property Tag. rfa) is designed to apply to the property lines when alï^
ments are selected.

Vou can try this with tíie property Ime you created earlier. Go back to the Annotate tah J

ribbon and click Tag By Category. Insíead of picking a single vertex of the propertyi^
your mouse pomter over one segment and use Tab-select to highlight the entire díain of\
line segments. Click to place the properfy área tag. CUck the question mark above the arJ?
change the name of the property line/ as shown in Figure 3.48.

FIGURE 3.48

Use Tab-select to place a

property área tag for
au segmenta.
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Cut/Fill Schedules
As we mentioned earlíer/ Revit site toais are not meant to replace civil engineering software

programs. We have shown you how to create a topographicaï surface in a varietyof ways as -

as some methods of modifying these objects. There is also a way to quickly quantify how mui
earül ls displaced by proposed changes to existing topography. This is commonly referred to i
cut/fill schedule.

One easy way to demonstrate the use of a cut/fill schedule is through the creation of a

buüding pad that automatically modifies the topographic surface. Let/s go through a quick
exercise to examine thís process:

l. Open the file c03-Site-Cut-F-i 11. rvt/ which can be downloaded from this
book/s web page.

In this file/ open a Default 3D view, select the toposurface/ and you will notice that the;

topographic surface hás been assigned to the Existing phase m thé Properties palette.

2. From the View tab in the ribbon/ click Schedules and then select Schedule/Quantities •
open the New Schedule dialog box.

Frorn- the Category list/ choose Topography/ set Phase to New Constmcüon, and

then click OK.

In the Fields tab of the Schedule Froperties dialog box, choose Name, Projected Área/ Net

Cut/FÍll/ Fhase Created/ and Phase Demolished/ clicking Add after each one. CUck OK to
dose the dialog box.

g. WhÜe you are still in the working view of the schedule, go to the Properties palette and set

the Phase Filter value of the schedule to Show Previous + New. This will allow only the
modifica toposurfaces affected by the Graded Region command to appear in the schedule.

The complete existing topography will not be listed in the schedule.

6. Activate the Basement plan from the Froject Browser/ and create a building pad in the

same way you created one earlier in this section.

After you complete the creation of the buildmg pad and the topographic surface is
modified/ notice that the Net Cut/Fill values in the topography schedule still have a value
of 0. This is because the Graded Region tool must be used on a surface to generate the

differences required to calculate what volume must be cut versus filled in the pro-

posed design.

7. Tile the open Revit windows só you can see both the Default 3D view and the topogra-

phy schedule.

8. On the Massing & Site tab/ click the Graded Region tool/ and you will see a dialog box
appear with two options to continue the command. Choose the option Create A New

Toposurface Exactly Like The Existmg One. This option creates overlapping existing and
proposed surfaces, which wül allow the software to schedule the differences between the

two as cut or fíll volumes.

9. Select the existing toposurface/ and you will see the volume values in the topography

schedule update to reflect how the excavation for the building pad affected the overall
soil. Note that this type of calculation does not account for various construction methods/

such as backfilling.

10. Click the Fmish Surface icon m the contextual tab of the ribbon to complete the Graded
Region command.

Activate the Section l view to see the bmlding pad more clearly. Try selecting the building
pad and changing the Height Offset From Levei value in the Properties palette. Observe how the
Net Cut/Fill values change as the pad defines the scope of excavation for the foundation.

You can also make the topography schedule easier to read by assignmg descriptive mforma-

tíon to each topographic surface. Select the surface and enter a value in the Name field in the

Properties palette. Change the name of the main surface to Existing Grade and then locate the

surface where the building pad is. Change its name to Pad Área and observe the topography

schedule once again.
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SBLBCTXNG TOPOSURFACES WITH THE FlLTER COMMAND

Ifyou have trouble selecting thetoposurfaces, you can select-tíie objecte Ín ,the drawjing^r
a crossing window and use the Piïtér conamand to select eactí topõsyrface< . .

If you would like to explore the completed project fíle for this exercise/
cGS-S-ite-Cut-F-iU-FINISHED. rvt from this booí:'s companion web page. """luo^

The Bottom Une

Select/ modify/ and replace elements. Many fundamental mteractions

Revit to select just what you neeá and to modify elements efficienüy. |

Master It How can you quickly select only the doar tags irt a plan view and switrhi
to another type? - " ' -•—uj

Editelements interactively. The editing tools in Revit are similar to those found in othl
CAD and BIM software programs. Tools such as Move, Copy, and Trim are avaüable on
Modify tab of the ribbon.

Masfer It How do you create a parametric repetition of an element?

Use ofher editing tools. Beyond fhe basic edítíng tools are more advanced conunands \

help you consistentíy and intelligently populate a buildmg model with content.

Master It How do you copy model elements in the same location for a multi-
story building?

EXPIOre A36° íeatures for collaboration. Whüe Revit hás a great mterface for creating.

editing project content/ there are tímes when you will want to share the model with dientsl
consultants who dorVt have Revit.

Master It Describe the functionaUties and limitations of loading your project model ul
to https://A360.autodesk . com.

Create site context for your project. 'ïïie site tools allow you to create context for your

building models/ mdudíng topographic surfaces, giaded regions/ and property lines.

Master It Describe the different methods used to create a topographic surface.

lonfíguring Templates
land Standards

^•^s=^^^^^^^^.l ^nd^a Pr^tte^t:,^^^^lIpZ^^^method: for establishmg^ISSïï^^^
teïCT^t
^theachsuccessiveproject. ^

IN THISCHAFTER, YOU WILL LBARN W

Define settings for graphic quality and consistency

Oïganize views for maximum efficiency

Create custam annotation famiUes

Start a project with a custam template

Develop a template management strategy

•

•

•

•

•

IB^^gpÏrtTe2^sappU^ano.s^.o^.^^
LÍkemany ote Wlications:,thlAuto^^^^^^ your knowledÍe
^:^d^w^!ol°^^m^t^^^^^^
oïthe^oftware progressos/ you wiü beg^ ^e^^t;^;design~and documentation
^orwes;ceÍtogs°stairs;tags;_aróottaJa^^^^^^
^v^^^w^^s^ze^^sl^^^wíh

ï!SS^^^^^r^^:ï=J"
a8^^:S^^-''y—ofthefouowmgmethods:

» Predefining ali project graphic and annotation requirements

» Preloading the model with annotation fafflilies and styles

• Defming standard system families
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We will explain these methods in greater detail throughout this chapter. For ]

you can save the completed settings as a new project template (with the fílenameext^

anduse.thistemplatewhenever you start a new Pr°Ject- ^ucancTeatTtempTatTs^Ï0!
ÏmpÍetely blank project/ by savinë an existinS FTOÍect as a template;'or byTÏm^uS
default templates provided with the Revit mstaÜatíon.

^ ^ To start from scratch/ click the File Tab menu and choose New > Projects. In the N... . l

ÏÏ08box/.shown in Figure 4-1/ choose None for the Template'FiI'e op£n7and dToo^!rl
Templatefor the create Newoption-on^ you cUck OK/ youwiïTbeïkedto^hooTe^ SI
^lof^surement-imperial or metric This dialos box ^oappearswhen'yo7pZcl^|
or go to the Home page and choose New under the Models section."

FIGURE 4.1

Starting a new project
íempïate from scratch
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s^tmë8i nTproject.tempIate without a base temPlate requircs Y011 to dewlop au comml
amtent suchas leveis/ grids/ sections/ callouts/ tags/ and model elements.'Before1

aUnewgraphiccontent, do a revíew comparing your reqmrement7tothe default7ymbnolZ1
Determmewhethfiryou can use or modi^ existmS famiues beforeyoubegm^creatins1^^!
!oadmto7°^new template-If you have onlvcustom gr^p^ "^^^

wouldbe appropriate; however/ ifmuch ofyour graphic style is similar "to thedefaultZwï
sugsest_you_start mth one of the default temPlatës and edit it as necessaiy. TMs'is7fsoïmud

\to getyouup andrunnmg-You can ímd these templates by dickmg Browselnl
TemplateFile area °ftheNew pr°J^ dialog box. By default, thetemplatefuïareL7alÍedchÍ

4atesdirectory:C:\ProgramData\Autodesk\RVT 202Q\Templates.~~1

Customizing Project Settings for Graphic Quality
oneof_the most common complaints from teams implementing Revit software on their fírst

prT?Jspoorgraphic quaüty °fPrmted documents. When you first instaU thesoftware;onl|
?meáefTsettmgsMedefínedto aPProx™te a standard graphTcappeamnceoTarchiït;
drawings. For example/üie lines for walls cut in sections are ?hicïrAran\ho"se^h^^^^
projectëd v;ews/ and calloutj)oundaries are dashed; however, almost7uaimo7atíoncatefíorie)
are^ttoa=lme weight of L Fortunately/ YOU can easily overcome theseproblemswithsotmeb|

'ation.

Discovering Object Styles

T eJnmarym_TS of controuing graP^ic consistency throughout a project is through ob^
styles. To access these settings/ select the Manage tab and chooseObjecïstyles fr^hesTtting

ghown in Figure 4.2, the dialog box is divided intofour tabs: Model Objects/
?^ison Objecte/ AnalyticalModel Objects/ and Imported Objects. Settings for Lme Weight/
^^nnLme Pattern/ and Material are estabUshed for each category.

1'Styles diaioë
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Model Objects The Category column on the Model Objects tab Usts ali available catego-
ries and subcategories of model elements. It is important to note that the subcategories for

model and annotatíon objects are created in families/ which are loaded into the project or

template. This will be discussed in greater detail in Chapter 15, "Desígning with the

Family Editor.
The next two columns/ under Line Weight/ define the line weight used when the elements

are displayed in projection or cut view. You use a projection view when you are looking at the

object from a distance; you use a cut view when youi view plane is mtersectmg the element as

ma section. In some categories/ the Cut setting is unavailable; these element categorieswill

never be cut in plan or section views/ regardless of the location of the view's cut plane. For

categories that enable cut display/ you can set element geometry in the Family Editor to follow

that rale or not/ as shown in Figure 4.3.
Une Color and Une Patternallow you to customize the display properties of each category

and subcategory/ but remember that printing a Revit view is WYSIWYG (what you see is what
you get)—coÍors wiU print as colors unless you override them to print as grayscale or black ü-1

the Print Setup dialog box. The last colunrn/ Material, allows you to define a default material

to be associated with the category or subcategory in case family components in that category

don/t have materiais explicitly defined. If a family hás materiais set to By Category/ it refer-

ences Üie material defined in the corresponding object style within the project environment.

Annotatíon Objects The Annotation Objects tab is similar to the Model Objects tab except
there are no material defírútions. There is also only one column for line weight (Projection)

because lines do not have three-dimensional properties like model objects and cannot be //cut/
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FIGURE 4.3

Customizing the cut

display of geometry
in a family
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and are beyond the scope of this book.

I^rtelo?eriL70uc^contr? appearance of layers (DWG) and leveis Í
(^^llmwotmpottedcAD&lw&mu^^^^
t^;ftheob)eristy,les dialos box;.however-we wm covertMsïgreater'deZuta'c"h^l
"Interoperabüity: Working MultÍplatform."'

ASSIGNING LlNE WEIGHT l

Íïl^aywarótoavoidTigring^ïine weight of 1 tó ob?ects béc^eüÜslstKewe&is^bl
tems. Reserving its use wiU helpobject.pmmes staÉuÍomcòmí&ÏtothS^^

Using Line Settíngs

Iou^use lmesm a variety ofways^some Ü"es relate to obvious tools. such as detaU Imes a

Zd^l^^hTLyou.c.anpIac<ofcersw?medre»om^^^
u^representation of model and annotation elements" as previously disca

ï the desired graphic quality requires a review of Ime weighïpatt^anZtyl^

SETTING LlNE WEIGHTS

s^ ÏIme^ei&htslttmgs/.cück the Mana§e tab and choose AddÍtionaI Settmgs > Une
wstl^ed^oëboxshown^
bweâã^^mentípom ? to ló^Pormodel objects/ hea^erÜnewei^s ïa^^ie^aÍeJ
yo1urcqmrcmorc8rïular contnïl between scales-cück ^ Add bíton toÍnsert'anotherscaÍe v|
colmrm and edit the line weights as required. h the Pe^pecd^LmeWrightran^^n Í
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)ecify Ime weights. This is because armotation is always

-:1 scale and perspective views are not defíned at any measiu-able scale.

14.4
[yneweightsvary

ïdingonthe
scale.

UneWerahts

Modet Sne iwghtsi «wtra] fcie wd^is for utïiects Hte »»cfe, ana windows m oirÏioy^sNc vtews, Iftiey si^t^id on wew
scaSe..

Therewelémo<idineweyite.E3chG3nbegh/wa^rofore3A'aaw^e,'3ekona(»(itoáiangeSneïwtt!h>

We recommend fhat you fírst customize fhe graphic appearance of model and annotation

elements with object styles before trying to manipulate any of fhe mformation in ttie Line Weights
dialog box. You should attempt to refine the Une weight settmgs only wifh a rigorous investigation of
prmted views m multiple scales/ because changes in one área can have an ünpact on several others.

SETTING UNE PATTERNS

Une pattems are created from a rcpetitive series of dashes, spaces/ and dots. To edit or create line

pattems/ switch to the Manage tab and choose Additional Settmgs > LÍne Pattems. The Lme
Patterns dialog box/ shown in Figure 4.5, displays a list of existing line patterns m the project.

ÏJDRB 4.5
dialog box dispkys

me patterns in

i.project.



128 l CHAPTBR 4 CONFIGURING TEMPLATES AND STANDARDS CUSTOMIZING PROJECT SETTINGS FOR GRAPHIC Q.UALITY | 129

To edit an existing pattem, select a pattern from the list and then click the Edit bi
New to create your own pattems. You create and edit patterns by specifymg dash and

lengths, which wül form a repeating sequence/ as shown m Figure 4.6. For dots/ a lensüi
not required.

FIGURE 4.6

Une pattems consist of

dashes, spaces, and dots.

Une Psttem Properite
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3/lë"

Defíne the sequence/ as shown in the following image.

Any dash or dot must be followed by a space/ and ali dashes and spaces must have a

defmed length.
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Prequently, a line pattem is required to include a symbol or text for elements such as fencej

lines/ piping/ or underground utilities. In Autodesk® AutoCAD® software/ shape defimtions c|

be used within linetype definitions to achieve the desired results. In Revit/ these special lines

can be created as line-based detail components. You can fínd samples of this type of custem;

by downloading the file c04-Llnes.rvtorc04-Lines-Metnc.rvt from Üüs book/s web pa^

atwww.wiley.com/go/mastenngrevit2020.

CREATING A NEW LlNE PATTERN

Follow these steps to create a new simple line pattern:

l. Switch to the Manage tab and choose Additional Settings > Lme Pattems.

2. In the Line Pattems dialog box, click New.

3. In the Name field/type MARA Fattem.

5. Confirm by clickmg OK.

6. The resultmg line pattern looks like ti-ús:

SETTING UNE STYLES

Now that we have discussed the basic components of lines (weight and pattern)/ the two are

combmed with a color to create Une styles for use in detail Unes, model Unes/ filled regions/ and

maskmg regions. They are also available when the Linework tool is used to override a part of a

model element. To open the Line Styles dialog box (shown m Figure 4.7), switch to tíie Manage
fab and choose Additional Settings > Line Styles. Note that you may need to expand the list of

line styles by clicking the plus sign next to Lines.
In the Line Styles dialog box/ notice that some of the style names are bracketed—for example,

<Hidden>. These are internai/ "system" types of lines that cannot be renamed or deleted and

associated to functions m Revit Similarly/ the default standard Une styles provided out of the box
(Thin Lmes, Médium Lines, and Wide Unes) cannot be renamed or deleted. In both cases/ their

weight, color, and pattem can be modified.
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FIGURE 4.7
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weight, color,
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ÜSINtí CAÜflpN WHEN DELBTOÏtetmESryi.ES

Ifyôu delete.alírie style ysed m'a-pro^ct, any elemënts using the deleted style wiUbe unableto.íe

'- enee Üïat style anymore, The Hnès àssígned.to the deleted style willbe reassignedto,a commons
.&úchlas:Thin.Linés—possiblyprpduçing.uhdesirsble'resuÏts. ' - • .

Establisíüng the best styles for your templates wiU be completely up to you/ but we wül of
some proven examples for mspiration. First/ realize that the applícation already uses common]

styles such as Thin Lines/ Médium Lines/ and Wide Unes. If you are creating a complete arra^

customized line styles for your colleagues to use/ simply add new line styles that conform to y|
graphic standard. Be sure to provide a naming convention that identifies the new lines styles.

One common approach is to create line styles organized by their weight niunber along wif

any variable to their appearance/ such as (3) Gray Dashed or +Line 01. The parentheses (or th|
use of any special characters at the begmning of the line/s name) keep your custam Une styk

sorted to the top of the Ust in the Line Styles dialog box as well as in the Type Selector when
you7re using a líne-based tool. This approach hás proven to be effective and efficient when

creating details in drafting views or generatmg fill or masldng regions.

Another approach reserves certain line styles for special circumstances where lines reprcsí

aspects of a buüding in a plan/ elevation/ or section and must be assigned to a specific layer v^

views are exported m CAD format. For example/ the crossing lines typically used to indicate .

área in plan that is "open to below" may need to be assigned to the CAD layer A-FLOR-BELV

This is difflcult if you used a Ime style based solely on weight and pattem such as (2) Dashed|
Vou cannot separately assign that Ime style to A-FLOR-BELW for the floor plan export and
A-DETL-TH-IN for ali other exports. Here are some examples of Une styles you could create:

• Open to Below

• ADA Circles
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^ Curbs

^ pire Rating

^ take care to understand the different settmgs when you are begirming to

lïe graphic settings for lines m the Revit template. To change the displayed weight of an
!c^enHn<a project/ you~should make changes not in Line Weights but rather'thlough üle_ob-Íect

^sdialog box. For example/ if you want to increase the cut Une weight of a waU already set to

ldonot increase the value of (5) in the Line Weights dialogbox. You would change this value
l bÏseFecting (6) or (7) as the cut weight of a wall in the Object Styles dialog box.

Defíning Materiais
Defíning materiais in your project template is another important task that can help maintain

úc consistency in many other áreas. Materiais drive the graphic repiesentation of elements/

notpst in a rendered view but also m hidden line yiews that are 2D or 3D. They are also

(• responsible for cleanups between model elements because materiais can merge with one another

whCTi elements of the same material are joíned. In Figure 4.8, the surface patterns and colors are

ali derived from the material assigned to each element.

[4.8

liais define the
Eeandcutpatterns,

: and render

oftheelements.

Surface Pattern

Surface Color

Materiais in Revit are organized mto groups of properties called asseis, consisüng of the

followmg: Identity, Graphics, Appearance/ Physical/ and Thermal. Lefs explore these by operdng

the Material Browser. Switch to the Manage tab and choose Materiais on the Settings panei to

open the Material Browser (Figure 4.9). The left side of the dialog box shows the materiais that
exist in the active project/ includmg a search bar to help you quicïdy find materiais for editmg.

Click the icon just below the search bar to show or hide the LÍbrary Panei. On the right/ the
selected materiaFs assets are displayed as tabs.
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FIGURE 4.9

Manage material

properties using the

Material Browser.
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MATERIAL PROPERTIES

Select any material in fhe Project Materiais list/ and we-11 step through each of the asset tabs. 1

íí8^!1? ^?efm.Tschedule values and keynotes for materiais. SpedfyÍng correct idenüty d|
r-,your standard or typical materiais wíll increase efficiency when you/re using ann.otationl

as material tass/ as wel1 as faciuíate quality managementby aligning model data suchi
manufacturei, model/ and mark with your project specifícations. In Figure 4.10, we've enterel

some sample^dentity data. The use of material identity data in project"aimotation is also
díscussed in Chapter 19, "Annotatmg Your Design."

FIGURE 4.10

Use identity data to

classify, find, tag, and

schedule materiais.
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[ics Defines shadmg color/ surface patterns, and cut patterns. These properties will

rinine llow a model element displays in non-rendered víews (Hidden Line/ Shaded, or

ConsistentColors).

As of the 2019 release, you can specify separate patterns for Foreground and for Background

:h pattern category. This feature allows for the creation of more flexible patterns. For example,

iuld specify a Sand pattern for Foreground and a light-gray Solid fíll pattem for Background. The

ilt would be a solid light-gray fíll pattern with a Sand dotted pattern overlaid on top of the gray.

Shading Defines the color and transparency of a material. Note that the color can be

dependent on the material/s render appearance. If the Use Render Appearance option is

selected/ the color and transparency are adopted from the Appearance asset settings and

the shading contrais will be disabled.

Surface Pattem AUows the selection of a model pattern to be displayed on the faces of
elements m elevation, plan, and 3D views. Note that a material/s surface pattern does not

appear in rendered views; a pattern can be defmed in the Appearance asset tab.

Cut Pattem Allows the selection of a draftíng pattern to be displayed when an element is
cut in a model view. Some elements can/t be cut/ as discussed previously in this chapter; in

these cases, this setting hás no effect on the graphic display/ and the pattern wÜl not display.

Appearance Defines rendermg attributes for use in Realistic and Ray Trace display modes as

well as rendermgs. These properties wiU become visible only when you render a view and

will not affect other graphic display styles/ unless the Use Render Appearance optíon is
selected in the Graphics asset under Shading.
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Identity/ Graphics/ and Appearance are the three assets that are required for every mate

Revit. You can add Physical and Thermal asseis for analysis/ if necessary.

Physical Defines physical properties of a material for analysis.
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Thermal Defines thermal properties of a material for analysis.

ADDING AND REPLACING MATERIAL ASSETS

You can also replace an asset for Appearance, Physical/ or Thermal properties witi-i one from any

asset library. Let/s review the process to add a new asset to a material. To complete the following

exercises, download and open c04-Maten ais. rvt from thisbook/s web page.

l. On the Manage tab/ select the Materiais tool to open the Materiais Browser. Select the

material Concrete - Cast-In-Place Concrete from the Project Materiais list.

2. Click the plus button in the tabbed list of assets and then select Physical.

3. The Asset Browser dialog box will open (Figure 4.11). In the asset selection tree at the left,
expand íhe Autodesk Physical Assets tree and navigate to Concrete and then Standard.
Find the asset named Concrete 3.5 ksi/ and with the mouse pointer ]y)vered over the asset/

click the arrow located at the right end of fhe asset listing.

4. Click the X to dose the Asset Browser and retum to the Material Browser.
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PJCÜBB 4.11

Use the Asset Browser to

access material assets in

the document or a

material library. ípert Type Categoiy
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You wiU see a new Physical Asset fab next to the Appearance tab.

20u™ot chanseanyof the asset Properties m theAutodeskFhysicaI Assets librarv.
twSaÍÍer Hassethas been assi8ned toap70ie^y"^^^ LleT£pJ
^lmïtus.pro^s.ina^kexe"^
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l. Continuingfrom the previous exercise, make sure the Material Browser is <

- - Cast-In-Place Concrete material is selected. Select thePhysïcalAÏsettab"

2. Click the DuplÍcate This Asset icon at the top of the tab.

Itshou!dcha.TAenameofthe asset to concrete 3-5 ksi(2)- ^ Aange the name ofan3
asset/ expand the Information drop-down menu and clickin theNamefíeld.^
name to Concrete 3.5 ksi (Custom). '''""~ """'

ídentfty „. Gsaphit.s : ÂppeatancË l pfnysíeal

NameJÇoncrete3.5fes!(Cy^om)'

Oiscriptioo 'C&nmtefe^â.Stei'

• Ke^woTds LEtTudwa^wKr®t6,CQACI

Type C&ncrete ' :

SubcEa&ï laandard

SotiFce .Autodesk

StweeUFÈLt
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^ge the Source field to your name and then expand the Concrete drop-down

menu Change the Shear Strength Modifícation to 1.75.

Return to the Project Materiais list and select Cast-In-Flace.

You wiU now add the customized physical asset to this project material.

^ck the plus button m the tabbed list of assets and select Physical.

. Asset Browser/ scroll to the top of the list of assets and select DocumentAssets. ^ ^

6' S^t^sÏist/youwillïmd Concrete 3.5 ksi (Custem). Hover the mouse P^ter^t^s
^tlan(Ï cÏÏd/the arrowat the end of the row to add it to the selected material. This will

update the material properties.

, wav vou can quickly change assets is by using the ReplaceAssetcommand^Instead

^Sg^cFa^t pwpS^p^c^ma^lm the Matenarórov[sel;a^
^^ec^^^^ce'Mse^on^s^^^
Iquickexercise:

l. With the Material Browser still open/ select the material named Concrete - Precast

Concrete and then select the Appearance tab.

2. Click the Replace This Asset icon in the Appearance tab.

3. In the Asset Browser/ navigate to the Appearance Library folder and then click Concrete.

Notice that the Ust of asseis is automatically filtered to show only those assets with fhe

Aspect fíeld specífíed as Appearance.

4. Select the Smooth Precast Structural asset and double-dick it/ or cUck the replace arrow at

the end of the row/ as shown in Figure 4.12.

5. Click the X to dose the Asset Browser and then click OK to dose the Material Browser.

PLANNING MATERIAL STRATEGIES
. seem impossible to ünagme ali the materialsyou willneed in a ProÏe^whichm^make
o^soïSmg^atempTateYeemdauntmg.Thinkof^^

^wo^bnck7con°crete7glass/ and só on-and buUd from those. R™mber/atem^atelÍust
astartinRpomt7andyoucan"always expand it. ïf you create a number of high^alltymateJL
^th^urstefo7a"pVo[ect/'use theTransfer ^^^^
ba^k ^you7tempÏaterYou~canalso create custom material libraries for your own reuse or for

teams. _ , , ..

t&Yo^oSamzaLtion/s existmg graphic standards taxonomy is likely tiw starting plarcwh?you

are lookmgto manage materiais: ifthere is not an existmg system^ you cancre^e •^ase^ori
íe workfTows"ofyom- teams. When you start to organize materiais by name, there are many

prevailing theories too numerous to list here/ but here are a few suggestions:

By Type Each material is prefixed with a descriptor such as Metal, Pamt^ Carpet, Wood,

and só on.

By Use Each material is prefixed with a descriptíon of its application, such as CMàin^,

Interior, Exterior, Site, and só on.
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FIGURE 4.12

The Asset Browser can

also be used to replace

an asset assigned to

a material.
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Alphabetical Materiais have no prefixes.

By CSI Division Each material is prefíxed with a MasterFormat numerical descriptor
correspondmg to its specification section.

By Mark Eachmaterial is prefixed with the designation of its Mark aimotation parame
(for example/ WDOl-Wood-Cherry).

Whatever naming conventíonyou choose for materiais/ the Materic

OTganíze and manaSe them efficienüy. First/ note that you can change the display of themat]
Tlst/mcludmg sortingoPtions/ by cUcking the drop-down arrow at Üie upper ríght/as showl

Figure 4.13. You can also fílter the list of materiais according to the Classprope5yb7cTicidr
funnel icon at the upper left.

. ou can also use the search bar to ciuicklyfind matching text in any material property fie

For example/ try typing sample in theSearch bar and the iFst wül reflect thosematenalsAa^
mclude that term in the Keywords property.

IEATIN6 A SIMPLE EXTERÍORfiLAZING MATEMAÏ. . ;..: ; .:; ;

?Ín tïie èarly phases of design, you-may want to Içeep the levei of detsil to a minünunu Iníâct,- guiâ^' :•

!SImes..for modeling leveis of devèlopment may be establislied as párt pf a BIM e^çcution pl%;;

<See<ALA. G202-2013. Project • Building Information ModeUng.PrótoçpÍ Porm,at:www<â.'ia^aF.g^:,

SSnÍ^ct^ocs- or the B:IM executipn planning guide fmm.'Penn State at bT-m-. jísa^edu. Yó4- ^Wï;

so-reference Levei of Development Spçdfication from BIN FÓRUM at https : /;(b^mfornf<t •:ot'M^<

|wp~co.ntent/uploads/2Q13/'08/2913-lOD-Specificat-toa.pdf.) To símpUfy.Üíe .çreàtiçn-pf-

! exterior endosures súch as a curtain wall, try creatíng a glass material .with a surface patfetítt apP^XÏ';:

|>.imatíngthe layout dimensions of a ,curtain wall system (suchas. 5' x 12/ o,rl.5.ïú:^-?.:&m)..fPhen'

Íjreate. a geri^rio wall type using.this material, and you will have a much lighter'^vál typë to explôjre;

Íesignoptíonswithgreate.ase.- . ' . . '' ... . '-"• *•'':.;;"'• '^'^.'

Defíning Fill Patterns
Materiais are often represented with simple hatch patterns. For any material used/ you can define

a surface pattern and acut pattern. For simple parallel hatches and crosshatches/ you can use the

patterns already supplied or you can make your own pattems.
For more complex patterns/ you need to import an externai pattern fíle (with the filename

extension . pat). Such pattern defmitions can be imported from pattem files used by AutoCAD—a

process we explam later in ttús chapter. To create, modify/ or view an available fill pattem/ switch

to the Manage fab and choose Additional Settings > Fill Patterns (see Figure 4.14). On the left
side of the FÏ11 Patterns dialog box/ you can view the names and small graphic previews of the
pattems. Below those are the Pattern Type options/ where you choose what type of pattern to

create and specify what type of pattem you want to edit (Model or Drafting).
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FIGURE 4.14

Fill patterns are defined
separately for drafting
and model

representatíons.
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M.odel patterns are used to convey real-world dimensional patterns to represent a material,

whereas drafting patterns are intended for symbolic representations. For example/ a model pat

used to show a brick pattem in 3D and elevadon víews/ whereas a brick drafting pattern is us|
represent the material in plan and section. Figure 4.15 shows how concrete masonry urúts (Cl

are represented with a runnmg bond pattern (model) as well as a crosshatch (drafting). To dis|
cut patterns in a 3D view, you must enable and adjust a section box to intersect a model eleme

Model patterns have specific behaviors that are not dependent on any view. The scale yoi

establish in a model pattem will always be that size/ regardless of the view scale. In the ex;

shown in Figure 4.15, the surface of the CMU wall displays a block pattem that measures K
(400 mm x 200 mm). If you were to change the view scale, the pattern would appear larger o^

smaller/ but it would always measure the same. With a drafting pattem/ the opposite is tme:|

pattem adjusts with the view scale/ só the pattern looks identical in ali scales.

Fill patterns are also created as one of two types: simple or custom. Figure 4.16 ülush'ates|

some examples of each option.

Simple These patterns are generated with parallel or crosshatch lines that can have diffe
angles and spacíng. With both the Crosshatch and Parallel Línes options, you can specify|
one angle for the entire pattem. Using crosshatch/ you can set two spacing values.

Custam To create a more complex custom pattern, you have to ímport a pattern (PAT)

from an externai source. This is often necessary becanse of the current limitaüon m creatilj|

natively complex patterns, Your office may have a set of established patterns that have be(

used for years/ and the Custom option allows you to import an.d reuse them without havi^

to make them again from scratch. Custam pattems let you ünport- a PAT file from anywhe

on your hard drive or on a network and use it as a base pattern for a new fíll pattern.

M5
í^bís)
ISÏ"(CU£)
Fdelp^te?
ldefined-

botha

Cut Pattern

Suríace Pattem

14.16
ïft to right: a

;fiUpattern,

|)lefillpatternwith

)sshatch option

and a custam

btem

CMÍATING ANEW SIMPLE PATTERN _ ^ ^_ ^ ^ ^^ ^^^^^^^^s^^button"Agenenc-pattem appeais in the New Pattern cliaiog DOX.

pattern and assign orientatlonbehavior^ „ ^^r^rïy useful when you're makmg draftmg ^i; ESïEiSxs^^^
Toyiew^KeepReadable/ and Align With Element.
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FIGURE 4.17

From left to right:

Orient To View, Keep
Readable, and Align
With Element

Orient To View When tiús orientation is applied/ the patterns used in Üie project ali ]
the same orientation and the same origm. Theyrre always perfectíy aligned with the nr,,
of the view.

Keep Readable This orientation will mamtam alignment with the view (that is, horizj
Imes will remain horizontal) but wÜl be adjusted relative to angled host elements.

Align With Element This orientation ensures that the pattem orientation depends on Í
orientation of the host element. Patterns essentially rim parallel to the element

CREATING A CUSTOM COMPLEX PATTERN

Custam patterns require an externai file that contams the definition of the pattern. The file

extension of that pattern should be . pat/ which is what you'11 make in tius exercise by edit

existmg AutoCAD PAT file. An advantage of specifying patterns m the template file is thatl
PAT file wonrt need to be installed on each computer where the application is mstalled; pa|
are stored internaUy in the Revit template or project file.

Before modifying PAT fíles, always make a copy of the original PAT me you intend to •
base; you don/t want to risk messmg up other files that might already be using that origina
file. PAT files can be edited with Notepad or any other text-editing application. For fhis ex|
you'11 choose the AutoCAD pattern called Grass/ which you can find in acadt só. pat (in:
units) or acad. pat (imperial uiüts) located on ti-üs book^s web page.

IMPORTING A CUSTOM PATTERN

Follow these steps to make a custam fill pattem by importing an existing pattern defínitioi

l. Using Notepad or a similar text editor applicaüon^ open the file acadi só. pat (Metr|
pattems) or acad. pat (Imperial pattems).

2. Highlight the lines that define the pattern/ and select them.

*GRASS,Grass área

90, 6, 0, 17.9605, 17.9605, 4.7625, -31.1585

45, 0, Q, 0, 25.4, 4.7625, -20.6375

135, 0, 0, 0, 25.4, 4.7625, -29.6375

The actual numbers m the pattem may differ slightly/ depending on whether you.
using acadtso.pat or acad.pat.

CUSTOMIZING PROJECT SETTINGS FOR GRAPHIC QUALITY | 143

3. Choose Edit > Copy.

a new text file and paste the selection. (You can also open the Revit metri c. pat or

rev-it.patfilelocatedinC:\Program F-iles\Autodesk\Rev1t 202Q\Data, inwhichall
Revit patterns are aü-eady saved. In that case, you can paste the selected text in that file.)

5. This is the important part; in the new text file where you pasted the selected text/ add the

two Unes shown in bold here:

;ÏoUNITS=MH

*GRASS,Grass área

;SSiTYPE=DRAFTING
90, 0, 6, 17.9605, 17.9605, 4.7625, -31.1585

45, 0, 0, 0, 25.4, 4.7625, -20.6375

135, 6, 0, 0, 25.4, 4.7625, -20.6375

The first line that you write before the pattern text/ ; °oUNITS=MM, can appear only once in

the text file. It defines the value for the units used in the pattem. In the example, the units

are millimeters (MM); if you wanted to work in imperial units/ it would be ;?oUNITS=INCH.
(ïf you use the option in step 4 to collect ali patterns in the master PAT file/ then this Ime
already exists and you don/t need to add it.)

The second statement/ ; ?áTYPE=DRAFTING/ helps define whether you/re creatmg a drafting or

model pattern. In this example, the pattem is the Drafting type.

6. Save your text file with a . pat filename extension.

7. On the Manage tab/ choose Additional Settings > Fill Patterns.

8. In the Fill Patterns díalog box/ verify that the Drafting option is selected/ and click the
New fill pattern icon/ m the bottom-left comer of the Fill Patterns dialog box.

9. In the New Pattem dialog box/ select the Custom option.

The lower part of the dialog box offers new options.

10. Click Browse/ navigate to the place on your hard drive or network where you saved the

PAT fÜe/ select it/ and then click Open.

IMPORTING PAT FILES

ït's important to know that when you import a new patterd, the type ofpattern needs to bethe same.as,

the new type ofpattem you're maldng. In other worás, if youre maldng a new model patÈerti,<you can t

import a drafting pattem. If you try to do só, you'11 see a waming messagç like the onç $hown here,,
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In the list that appears to the right of this button/ you can see the name of the
created: GRASS/ as shown m Figure 4.18. (If you have a PAT fíle with many p;
defined/ you'11 see ali the other drafting patterns available m that list.) The namefl
pattern automatically becomes the name of your fíll pattem, but you can chant

if you like.

PlGURE 4.18

The New Pattem áialog
box displays the

imported PAT me in the
Custam group.

If necessary/ you can adjust the scales of the ünported pattern. The Preview windot

displaysthegraphicof the partem/always in 1:1 scale.Thisinformsyouifyouneec
scale the pattern up or down. You/ll know that you need to scale the pattern if the

appears as a solid black box—that means the pattern is too dense. As an altemative,|

preview box shows only white/ your scale might need to be reduced. In Figure 4.18^

used the import scale of 0.01 to accommodate the scaling.

11. Ïf you/re happy with íhe result/ confirm by clicking OK.

Now that you have created a fíll pattern, you can use the pattem in a number of ways. ^

the simplest ways is to assign the pattern directly to a material. We purposely mstructed yí

create a grass pattem m the previous exercise to Íllustrate a limitaüon in Revit—you cannoj

assign a surface pattern to a material that is associated with a toposnrface. |

In the followmg exçrcise, you will assign the grass pattern to a material in the sample pj
that hás already been assigned to a toposurface. We will then show you how to create a ne^

filled region type to create a symbolic representation of grass in the site plan.

Contüluínë wítí-l tÏïe c04-Maten ais . rvt fíle/ switch to the Manage tab and click Materiais.

-[^ the Material Browser/ find the material named Site ~ Grass and choose the Graphics tab.

Under the Surface Pattern properties > Foreground/ click the Fattern field and then choose

the GRASS pattern you created in the previous exercise. Click OK.

The pattern wül be assigned to the material. Next/ we will create a filled region type and

use Ít as a graphic mdicator on a site plan.

In the Project Browser/ activate the floor plan named Site. Switch to the Annotate tab and

in the Detail panei select Region > Fiiïed Region.

In the Properties palette/ click Edit Type and duplicate the current filled region type to a
new type named Grass. Set the Foreground FiU Pattem property to GRA.SS, leave the

Background FUI Fattern empty, and uncheck the Maskmg box. (Figure 4.19).

Í.19
lewíiüed
^ewithyour
^fiUpattem.

Foreground FiS! Pattern

Foregrounct Pattern Color

Background FM Pattern

Background Pattem Color

5. Click OK to dose the Type Properties dialog box/ and draw a shape on the Site plan using
any confíguration of lines, making sure your lines form a closed loop.

Remember to click the green check mark in the contextual ribbon to complete the sketch of the

fitted region. Take a moment to experiment with the <InvÍsible Lmes> type and díaw the
boundary condition of the fÜled region. Next/ apply a second fiU pattem (Sand) to the
Background Fill Pattem. You will achieve a similar result as shown in the following sketch.
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Ch&çs» SpaceTyps má CotorScheme
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TheÍesendwSappearyar*. Toapfáyatütorstheme
\riéw^ âwsse a ^wce t^?e aró »í«me. snd iyes& CK,

3. Select the color fill legend you placed in the previous step, and click the Edit Scheme icon
at the right end of fhe ribbon. The Edit Color Scheme dialog box will appear.

4. Click the Add Value icon (the plus symbol) to populate the list of departments in the
Scheme Defínition área. Add the values as shown in Figure 4.20. Choose colors and fíll

patterns accordmg to your graphic requirements.

1GURB4.20
ïdit color schemes to

idd predefined values,
Êolors, and fill patterns.

Preconfiguring Color Schemes

TÏluslo^ÏorsAemes/m pro]ect docum^tatíon will be covered m greater detail m (
lftra,elto£YourDesi^:'however^

lT^Z:ale^fscmaa^
8mg!"uenttot,.u8esAesme.departaentna^^^

^^^?ure^^a^^-^^I^^^q
^ Ïefo!lowmg steps/ you wul create a new color fíu legend with some predefined deoart-1

^t,llu!%m^aTOCHtedrotora: mesesettmss cmbe-^^^^^^^^^^
!em£late(t:.rte)or a project file^ • rvt).that acts as a contamer'forsetting7toïe Serred l
™feractíve pr°jectme: Dowrioad -dopenfteÏe'c"G4l-Zlor"-IS'^S ."vTZSF
book/swebpageandfollowthesesteps: ^ "' """ '"""""""

l' ^va^myfloorplan view from the project Bro^er. Qn the Annotate tab, choose the 3
^íU Legend tool.

2* ^cla.lTnd m thefloor planview/ and Y0" will see the Choose Space Type And Colo|
ïhemidiaïgbox-setspace Type to Rooms and Color Scheme\o15epart^n^e^1

• modified later) and then click OK.

5. Click OK to dose the dialog box.

6. Activate the Levei l floor plan; then/ from the Architecture tab/ choose the Room button

and add rooms to the enclosed spaces shown in the plan view. For clarity/ we have turned

on the Interior Fill and Reference properties for rooms in this piau view. This will make it
easier for you to select the rooms in the next step.

You will not want to let fhese rooms remam if you save the file as a project template, but it

will help to better visualize the color schemes if you can see them placed in a sample

model view.

When rooms are placed/ you can either type the values for departments that match tine

predefmed values in the color scheme or select the values in the Propçrties palette when

each room is selected/ as shown in Figure 4.21.
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7. Select each room that you placed in the piau view/ and select a Department value in,

Properties palette accordmg to the layout shown m Figure 4.22. The department valuel

used in every project started with your project template will have the same colors aïdÍ
patterns accordmg to those specified m the original color scheme. You also have,
fined list of your client/s department names. 1

FIGURE 4.22

Color-filled plans can use

predefined values in
templates.
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At this point/ you have two optíons for storíng these types of settings. We will discuss

strategies for managing templates later in this chapter, but for now you can either save this fil|
a project template or mamtain it as a container fíle/ which is simply an RVT file that holds
settings you will transfer into other project files. For a container file/ simply leave the ffle as is/j
and we will discuss the use of the Transfer Project Standards command later in this chapter. If|
you want to use this file as a project template/ follow these steps: " j

l. In the plan view/ select ali the walls/ rooms/ and room tags/ and then delete them.

2. Activate the Room Schedule view under Schedules/Quantities m the Project Browser.

3. Click m the fírst row of the schedule and then click the Delete button in the ribbon. Repeat
this step untíl ali rooms have been removed from the schedule. (Note that deleting rooms

from tine plan wiü not delete them from the model. To find unplaced rooms, you will need

to re-create a room schedule.)

4. Go to the Application menu and then select Save As > Template. Name the file

c04-Color-Scheffle-Template.rte.

You don/t have to delete ali the modeled content and rooms from your project templates;

however/ it/s likely that you will have a unique layout for each project you design. By deletmg
the sample walls and rooms/ you maintained the color scheme settings with the predefined

colors/ pattems/ and department names.

Increasing Effícient View Management
Once you have customized the settings for graphic quality/ you can use several other tools and

techniques to mcrease efficiency and ensure that your visual standards are applied consistently

throughout your projects. The properties of ali views can be used to your advantage in creatmg a

browser orgaiúzation that meets the needs of your teams. You can apply fílters to views for

:ating graphic overrides based on model element parameters. You can manage and deploy

these settings and more in view templates that can be applied to many views simultaneously.

Organizing Views
Maintainmg a clear and consistent organization of views withm a Revit project can generate

measurable mcreases m project productivity. Especially m larger projects/ a Revit file can have

more than 1/000 views/ which can easÜy cause confusion and wasted time if the right view

cannot be found in the Project Browser when needed.

Downloadand openthefile cQ4-Browser-Org. rvt from this book s web page. Mostdefault

project templates contam a few simple Browser Organization types that can be copied and/or

customized—except for the type named Ali. To access these settings/ switch to the View ribbon/

fínd the Windows panei/ click the User Interface drop-down button/ and select Browser

Organization, as shown m Figure 4.23.

ÍGURE4.23
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;RecentFili
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Select any one of the listed types m the Browser Organizaüon dialog box, and click the V^. Í
button. Remember/ you can't edit or delete the type named Ali. " -- ^mf

ïn t^le ?owser orëarli2ation Properties dialog box (Figure 4.24) are a Grouping And Sortí.
tab and a Füteringtab GroupingAnd Sorting allows you to group views based on selected^Í
parameters/ whereas the Filtermg tab gives you the opportunity to display oiüy viewsthatnÍ
selected criteria. Passl

FIGURE 4.24
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Choose the Grouping And Sortmg fab to specify three leveis of hierarchy to be shown in the
Project Browser. Here are some examples:

• FamiIyAnd Type/ Discipline/ View Scale

• Phase/ Discipline/ Family And Type

• Detail Levei/ Pamily/ Type

To further organize the views m your project/ you can create additional project parameters

and assign them to views and sheets. The followmg is one example of adding custom text
parameters to views for more refíned organizatíon: -

l. On the Manage tab/ fínd the Settings panei/ and click Project Parameters.

2. In the Project Parameters dialog box/ click Add.

3. In the Parameter Properties dialog box/ create a parameter named Zone; andl for Type Of

Farameter, specify Text. Select the Instance option; then find and check the Views category/

as shown in Figure 4.25. You may also set the Group Parameter Under value to

Identity Data.
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4. Click OK to dose both of the open dialog boxes.

5. Return to the Browser Organization dialog box and click New. Name the new type Zone/

Phase and click OK.

6. Set the following values on the Groupmg And Sortmg tab in the Browser Organizatíon

ProperÜes dialog box:

• Group By: Zone

• Then By: Phase

7. Click OK to dose the dialog box and retum to the Browser Organization dialog box.

8. Check the box next to Zone/Phase to make this browser setting current, and click OK to

dose the dialog box.

The Project Browser is now ready to support the use of the custem view parameters you

created earlier.
It is now up to you to assign values to the custom view parameters created in the previous

exercise. These values can be assigned directly to the view properties in the Properties palette or

by adding them to view templates. Views that do not have values for these parameters will be

found inthe browser hierarchy listed as ??? (three question marks). Figure 4.26 illustrates this
scenario in which floor plans and ceiling plans have values assigned to the Zone parameters but

the elevation views do not.
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FIGURE 4.26
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Creating and Assigning Filters
Filters areanother view configuration and customization tool that can be <

dzlploy!dÏ.Rev.itproject temPlates- They are similar to the mters"avaÜabl7ms3;ecduTesuiJ
they can either display or hide elements matchmg user-specÍfíedcntenrHowe^Z"!

ah^lemdejhlëíap^caw^^ oí el^entswithina vÍew^lÏepossÍbTecombmZlJ
applïcation of™w mters is virtually limitiess/ so let/s take a lookatarfewreaT-woridlfe^

> f^wF wm review the steps to create and assign a view mter- Thefonda^n"tarst^ï|

l. Create a named fílter.

2. Assign it to object categories.

3. Assígn data criteria.

4. Add to the VisibiUty/Graphic settings of a view.

5. Define graphic ovemdes.

^ Ae following example/ you will create view mle-based füters to identify fírc-rated wa|
withdifferent colors. You can download the sample füe c04-Samp\~e^Bund:i:ng"rYtufromIt

.'s web page. Here are the steps:

l. Openthefile c04-Sample-Bu-ilding. rvt. Switch to the View fab/ fmd the Graphicsj
andclickFilters. - " "'"'

2. Addanew named filter by clickmg the New button on the lowerieft side of the dialo!
<. Name the fírst new filter WaUs-Fire l/ use the Define Rules opüon7and thencUcj
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V^ien the expanded Füters dialog box appears/ fírst make sure the Walls-Fire l filter is

selected; then m the Filter List pull-down menu/ make sure only Archítecture is selected.

Finally/ in the Categories Ust/ find Walls and check the category.

In Filter Rules at the right side/ select And (Ali Rules Must De True). Define the criterion to
filter by Fire Ratmg Equals l HR and then click Apply.

5. With the Walls-Fire l filter still selected/ click the Duplicate icon twice (the second icon
below the Filters list) and then rename the duplicated filters Walls-Fire 2 and Walls-Fire 3.

fi. Select Walls-Fire 2, change the value m Filter Pules to 2 HR/ and click Apply.

7. Select Walls-Fire 3 and change the value in Filter Rules to 3 HR/ as shown in Figure 4.27,

and then click Apply again.

Ê 4.27
lüesappliedto
Irfireratíngs

íü 'S & . o»*)U ! diEá i

8. Click OK to dose the Filters dialog box.

9. Activate the Levei l floor plan, open the Visibility/Graphic Overrides dialog box, and
select the FÜters fab.

10. Click the Add button, select ali three fílters you created in fhe previous steps/

and cUck OK.

11. CUck the Override button m each filter row under Cut-Lines and edit as follows:

• Fattern: Solid

• Color:

• Walls-Fire l = Green

• Walls-Fire 2 = Yeiïow

• Walls-Fire 3 = Red

12. Click OK to dose the VisibiUty/Graphic Overrides dialog box.
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With the filters now applied to the floor plan/ walls that have been assigned a fíi
will appear with the color overrides you assigned to the respective Blters.You canrr.

. !f,rs to defm,e §raptíc styles for SPecific model elements such as furniture by owner^
walls/ secure doors, or equipment not in contract. N

You can also create filters based on selection. This allows you to define the objects to bei
fütered without a ruleset. This is a useful option when there is no clear rule that will alÏowl

^ ^.l^u.rróed' ThTselection can happen before or after the fílter creation, allowmg yo
add or subtract as needed. To create a selection fílter/ foUow these steps with same file useá
rule-based fílters:

l. Activate the view Levei l Design. In the Manage tab/ locate the Selection panei.

2. Select EdÍt Selection. The Edit FUters dialog will appear with a Ust of rule-based mtej
s&tection fílters.

3. Select New.

when the Filter Name dialoë aPpears/ provide the name MARA Test and choose Se|
The dtíalog will dose with the ribbon providing the Edit Selectíon tools. By default, 1
Add To Selection tool is active.

selectseveral objects m the pïan view to add to the set. To remove objects from the se

select Remove From Selection. Vou will notice the mouse frades its plus symbol for a

mínus symbol. You will also see that previously imselected objects are now suppress
allowing you easy access to change your selection set.

Snce/ou Ïre satxsfíed/ choose Fiiüsh Selection. As shown in Figure 4.28, you now h^|
fílter based on selection/ rather than a rule.

128 . ..
^electi°">

irules

Eüsing View Templates
re defíned your desired settings m as many view types as possible/ you can use

tes to manage these settmgs and apply them to other views of the same type. The

ÍusTofvïewtemphtes wïll be discussed in various_chapters of this book, but we will discuss their
^importance to the project template m this section. Lefs begin by opening the View

Templates tool:

l. On the VÍew fab/ find the Graphics panei and select View Templates > Manage View

Templates.

In the View Templates dialog box (Figure 4.29), you wiU find icons to duplicate/ rename^
or deleteview templates below the list on the left. On the right are the víew properties that

can be applied when the view template is applied to a view.

IE 4.29
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Notice the colunem named Include on the right of thís dialog box. TNs colnn.- l

to include or exclude various view properties when you are applying the vi^>^

you uncheck View Scale and Detail Levei settings/ you can apply this tenit

multiple scales and detail leveis, while applymg settmgs such as visibilityofc^
Phase Filter/ and View Range without affecting the View Scale or Detail LF

AIso notice in Figure 4.29 the custam view parameter created earlier: 2one.

be applied with the view template, whích will have the effect of catalogii
customized hierarchy within the Project Browser. Changes to view

matically reflected in the views to which they have been assigned.

2. Click OK to dose the window.

The only way to assÍgn a view template to a view is in the Properües palette. Selec

in the Project Browser and then examine the Properties palette to locate the View Tem,-]

parameter. If the View Template parameter button displays as <None>/ then no view

hás been assigned. Click the button to launch the Assign View Template dialog box,
an appropriate view template. In contrast to this assigning workflow/ view template pri|

can be applied to individual víews. Applying a view template is a one-time appUcatíon.l
changes to the view template will not change a view where a template was applied. Yol

apply a template in various ways/ including the following:

• Selectmultiple views in the Project Browser/ right-click/ and then select Apply v|
Template from the context menu.

• From the View tab, click View Templates > Apply Template PropertÍes To Curre

• Select multiple sheets in the Project Browser/ right-click/ and then select Apply v|
Template To Ali Views from the context menu.

Any of these methods will apply the properties of a view template/ but will not assii
view template to the view. If you use these methods and a view happens to have a VÍCT

already assigned/ a message will prompt you to partially apply the properties that are r|
managed by the view template assigned to the view.

VÍew Template Préssnt

Target views have a View Tempiate asslç

Apptying this vsew template will cniy sffedt those propertte
which are noí confmlied by a viesiw ÍËmpiate aïsignsd iïi the
viw prcpertïes.

Any properties listed in the View Templates dialog box/ shown previously in Figure :\
are selected m the Include fíeld wül not be changed if you choose to partially apply víe^
template properties to a view with an assigned template. For example, Íf model object s^
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,d in the assigned view template and you are attemptíngto aPP^emPlate^0^ that
Kt^d^^fec^tyírmodÍ^^^^^^^ object settings from the assigned view
Ílso!^pwiU notbe overridden from the applied properties.
l^^^es^rZïively^tu^^^^^^^ to applymg v^templates/youc^m^se
LP!?cÏeotnïrï^^^^^
|^fe^rcpoZ^e7o^trsX?eT-7exe™^^^^^^^^

^ters exercise/ and follow these steps:

l.

2.

3.

11 floor plan m the Project Browser/ right-dicktí.e LevelJ^pkn/
^VAo^DupÍicateVÍew> Duplicate from the context menu. Rename the duplicate

view Levei l Design.

WÍth the properties of the Levei l Design floorplan active m thepr°Pe/tifâ^^^^^^^^
^tlTyL^SeuType Properties7ialog box/ click DupUcate to create a new type named

Design Flans.

Click the button m the View Template Applied To New Viaws field and select the Design

plan view template (Figure 4.30). Click OK.

1.30
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4. Click OK to dose the Type Froperties dialog box.

You should noüce that the Levei l Design floor plan in the Project Browser T,

under Floor Plans (Design Plans); however/ the view template hás not b(

this view yet.

5. In the Properües palette/ click the View Template field button/ select the Desifh, -Á

template/ and then click OK.

The floor plan view should appear changed, no longer displaying any annotaM-

6. From the View tab/ click Piau Views > Floor Plan. Ïn tihe New Floor Plan dic

Design Plans in tíie Type drop-down list and then select Levei 2 from the list.

7. Click OK/ and a new floor plan for Levei 2 will be created that hás the Desii
template already assigned. Rename this view Levei 2 Design.

The workflow described in the previous exercise will help you spend less time coi

view settings and more time focused on your designs. Including view templates ii

template will give your teams the ability to quickly apply your standard view settin&l
also support continued consistency as each building project grows in scope and size^

Remember that view templates are easily shared between projects using the Transfer

Standards tool/ which we will discuss later in this chapter in the section //Strategies fi

Managing Templates."

Creating Custom Annotations
We are avid supporters of global graphic standards for architecture and engineering/ su|

Urúted States National CAD Standard (www.nat'ionalcadstandard.org)/butinreaUty|
architects and designers will líkely have their own set of graphic conventions that will:
implemented in their Revit projects. Placing customized annotation famiUes in your pi

template wiU save time when you are starting new projects and ensure maximum com],

with your firm/s conventions. You can load tag families into the template using several]

• Switch to the Insert tab/ and in the Load From Library panei/ select Load Famil}

open the Load Family dialog box where you can select the families you would'.

• Using Windows Explorer, select RFA tag families and drag them into the Revit;
environment with the template open.

• Use the Loaded Tags And Symbols tool available in the Annotate tab when yoi
the Tag panei (Figure 4.31). This tool allows you to preview ali loaded and pres
symboïs that will be used for respective element categories.

In the following sections/ we wÜl walk you through creating some common elemí

customizing system annotation.
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lARCHIVINGAND MANAGING CüSTOM CONTENT

lany new users are unsure where to store custom-created families. It is not advisable to save them,

|th the system folders created during the installation of Revit because you may lose track of them or>;

, ïnadvertently delete them when you reinstall the software. Reinstalling the application erases just

l.about any folder and its.entire contents. Ít is thus wise to keep your personally created content

lelsewhere, under a separate, independent folder; if you are not a single nser, store that folder otí &.

?shared network drive. Remember that you can aïways include adáitional library shortcuts in the

application options. Just select Füe Locations and click the Places button from the Options menu.

fou should also keep your templates up-to-date as you add more content; thafc way, you need to'

|maintain only a few template fíles rather than dozens of separate family files. It's even better if you.'

|can establish a template manager as a role within the office só everyone isn't making graphical

tanges to your templates.

itroducing Tag Family Fundamentais
•gs in Revit have various similarities and differences from the annotation symbols you might

id in a CAD application. They are similar in that they are created at 1:1 scale,and contam Unes

td other graphic elements. The mam difference is that Revit tags merely report information from
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model elements/ whereas a CÁD-based symbol usually holds an attribute value i

directly relate to the armotated buildmg element and therefore hás to be entered ^^oel
dynamic aimotation elements are referred to as labels within a Revit family/whüe^ï,1!
annotatíon is simply known as text.

Before youbegin to custoirúze annotatíon families or create your own/ let/s
look at the difference between text and labels. '

Text ^ In the Famíly Editor/ placing text in an armotation family or titíe block:
defmmg text that will always be the same and is unchangeable when thaïfamiÍ^TJl
the project environment. Figure 4.32 shows the words ÁREA and VOLUME^
.of^he,re this room ta?is pla^ed/ the text wíl1 always saV AREA and VOLUME.LS'elrfÏ
^kth1e_same way:.if you !?d static. text/ that text'aPPears the same for aUsectio^^
Tbis technique is nottypicaUy used for sections because each section is a referenceS
yiew^andyou want that information to be dynamic and parametric. This is whe?lLla!
functionality comes into play.

FIGURE 4.32

FIoor plan showing
the room tag

Labels Like static text/ a label offers textual information; however/ it is a live reference i

parameter value of an element m the project. For example/ if you add an Área label, itwl

pull the value of the área of the room; if you add a Sheet Nuinber label in a SectíonHeadl
. .lïíly?ntheFïiIy.Editorenvironment and then use that section head in a project/ fhe]
^ automaticauy display the actual sheet number on which the section view is placed ir
project If you move the section view from one sheet to another/ the label will automática

report ti^enew sheetnumber. In Figure 4.32, UNIT 4 is a label reporting the room name; |
number^Ol is a label reportmg the room number. The label behaves as dynamic text and|
always fully coordinated with the value of the model element parameter it represents.

Creatíng a Custam Door Tag

Inïs!neyou COUId us.e the_actuaï width and height of a door element to drive the tag value. |
ca ,,an examPle of creatmg custam tags for a basic model element, use the foUowing step|

a-eate the custom^door tag shown in Figure 4.33. You can download the template files fromt
book's web page if you can/t fínd them in the default locatíon.
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t.33

^ CUck the File Tab and select New > Aimotation Symbol.

\ ^te"NewAnnotation Symbol didogbox^lect te family template called Door Tag

is ^fïorMetric Door Tag. rft/anddickOpen.

ï^ss^^^^s'^^-'
3. OntheCreate fab, find theText panei and select Label. CUck the intcrsection of the two

anes to position the label.

^^^:S^ESy^
•• 'ÏÏSSSÍÍSSSS^^

^tTsr^SLoa^ SS: a7sh6own in Figure 4.34.

14.34
Ir more than one

ïter to a

Itabel

.tcftetíid- Pa(mt!UTS^lt*Bml^Bi!Rto

ItítheWlyfaf™''"»'*

^ÏS£S=^^=^^-
the-display of the label.

•• Ï^;ÍS^^Sa=£^sï
theHeight parameter to 80 (in) or 2000 (mm).
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6. With the Width row selected (click row l), click the Edit Parameter/s Units Fr
the Format dialog box/ uncheck fhe Use Project Settings option and set the foUo^J

• Units: Decimal Inches (or Millimeters)

• Roundmg: O decimal places

• Unit Symbol: None

7. Repeat the previous step for the Height parameter.

8. Click OK m ali open dialog boxes.

9. Qn the Create tab/ activate the Masking RegÍon tool and sketch a six-sided

shown previously in Figure 4.33.

Remember to finish the sketch by clicking the green check mark in fhe Mode panei.
masking region is used instead ofjust lines because it wül allow the door tag to obsc
any geometry if it is placed over a model object. ïf you do not need this graphic com
tion, simply create the tag outlme with lines.

10. Save and name your tag/ and load it into your project template.

Make sure that it is specified as the default tag for doors in the Loaded Tags And S\
dialog box, and use the Tag By Category or Tag Ali Not Tagged tool or place new dói
with the Tag On Placement option. Using concatenated parameters in tag labels alloi
great deal of flexibÍUty while utiUzing actual parametric values. In this example
(Figure 4.35), the actual Width and Height parameters driving the door size become
text displayed in the tag.

FIGURE 4.35

The custom tags applied
to doors comprise actual

doar sizes.

:SSltÍN4:ycÍMfiI3típ^%^::;^>l:i::^:^;^ï^

^T?M4$h^úisêryoïyôúy^us&m:^tót&Se|,'^t^êôft^
:éleïri£^s^s^h^aooj^^ti6l&ws,^Qç^/^n<fô^
<lTang@the>yaAy^üê'taa^t^^ê^júst^eteyA
. Í!tef^exainpli;.éRt^ a^4híé offf-tf^óç^tóyour i
-doëááoÈwôr^£Qï;le1t«mb^âüsê1ÍGtHn^tdrticl&&eio^|à.

itábÏïsÉ. âijÊâütevâluy! ïai^o:
|l$.tCrèáÈ^on^:QÉ éâcïUlêifó
^©u.^^44 KEe^®H^ u'sws 1§

^Ün|ç^ïtíáàtélY,4lhís"^

Customizing View Tags
Section/ calïout, and elevation tags are graptíc mdicators that reference (link to) other views ?

in your project. The graphics for these elements can be customized to meet most scenarios. Tü|

create a custam section tag, for example/ you have to fírst create a custam section tag family'
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tail family and then load them into a template or project. You must then associate them

l£^"section tag system family type/ which is then assigned to a section type. Switch to the
lÏ^P tab/and dloose AdditionaÍ Settmgs > Section Tags; you will see the application of

•iection head and tail famiUes m a section tag system family type, as shown in

|gure4.36.

In simple terms/ view tags are organized in the following hierarchy: the view type refers to a

f CaUout Tag type (and a Section Tag íype for section views); the Section Tag type then refers to a
section head family and a section tail family.

l . By default/ there is a predefined view tag for each view type. The graphics can vary depend-
l ing on the language version of Revit you have installed on yourmachine. The view tags shown

in~Figure 4.37 are displayed and avaüable by default m the U.S. English version.

[4.37

.éfault tags

CREATING A CUSTOM SECTION TAG

In the next exercise/ you will create a section tag that looks like the one shown in Figure 4.38. You

wül fírst need to create a section tag family using the Family Editor before loading the section tag
family into the template. You can download the template files from this book's web page if you
cannot find them in the default location.
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FIGURE 4.38

Customizing the
sectíon tag

To begin/ follow these steps:

l. CIick the File tab/ and select New > Annotation Symbol.

2. In the New Aimotation Symbol dialog box/ select the family template called
Head.rftorMetnc Sect-ion Head. rft/and clickOpen.

The Family Editor environment automatically opens/ and the drawing área shows

in whicMhree green reference planes (two vertical and one horizontal) have alreai

drawn. Do not change the position of either the horizontal reference plane or the-

reference on the right. In some templates/ this is mdícated with help text in red
can later remove). Í

The intersection of the horizontal and the right reference planes defines the conne

location with the section line. This means your annotation will be located behveer
intersection pomts.

A proposed geometric shape is drawn for the aimotation: a circle (two ares) and a3
tal line. The default shape is there to help you visually understand where to begm|
drawing your new tag geometry.

3. Select the ares that create the circle and delete them.

4. On the Create tab's Text panei/ click tine Label button. Position your cursor betwe

two vertical reference planes and below the horizontal plane/ and click to posiüoi
of the label.

5. In the Edit Label dialog box/ select Sheet Number. Click the Add Parameter(s) To ]
button. In the Sample Value column/ you can enter a value; the default is A101. Clij

The label is placed and displays blue grips when selected. These let you change the i
fhe label text field. The length is important because any value that is added (in a pi
is longer than the length of this box wÍU begin to wrap and could cause undesirable

6. Following the same principie/ place the label Detail Number above the horizontal:
ence plane but still between the vertical reference planes/ as shown in Figure 4.39.

FIGURE 4.39

Place labeïs for Detaiï
Number and

Sheet Number.
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Vou can reposition a label by selecting it and using the Move button to move it around.

For more precise positioning/ use the arrow keys on your keyboard to nudge elements in

small mcrements. You can also help yourself by zoommg in for a better view. (Zoommg in

refines the mcrement for the nudge tools.)

7. On the Detail panei of tiie Create fab/ click the Filled Region button. You'11 be put into Sketch
mode. Using the Line tool, draw the shape shown in Figure 4.40. In the Properties palette/

click Edit Type. In the Type Properties dialog box/ check that Foregroimd Fill Pattem Color is
set to Black and Partem is set to Solid Fill. CIick OK to dose the Type Properties dialog box/
and then make sure the Unes you sketched form a dosed loop (no gaps or overlappmg lines).

14.40
leoutlmeofthe

ggion to form the

1 arrow.

8. Clíck Fmish Bdit Mode on the Mode panei of the Modify j Create Filled Region

Boundary tab.

9. Save the tag you just created as Custem Arrow. rfa on your hard drive or network/ and

you/re ready to use it in the template or a project. To load it mto your project/ click the

Load Into Project button located in the Family Editor panei. Choose the project where you
want to use the symbol and click OK.

Next, you will assign this tag to a section mark system family type in the context of a project

or template.

CREATING A SECTION TYPE WITH A CÜSTOM HEAD OR TAIL GRAPHIC

To create a section type that uses the section head family you created earlier/ you need to load the

new section head into the template file (if you/ve ah-eady loaded the custom arrow family in the

previous exercise/ skip to step 3):

l. If the family is not already loaded/ switch to the Insert tab, and on the Load From Library
panei, choose Load Family.

2. In Üie Load Family dialogbox/ find the Custom Arrow. r f a sectionhead you created

previously, select it^ and click Open.

3. Switch to the Manage tab and select Additional Settmgs > Section Tags.

4. In the Type Properties dialog box/ click Duplicate.

5. In the Name dialog box/ name the new type Custam Filled Arrow/ and click OK.

6. In the section head's Type Properties dialog box/ click the drop-down menu for Section

Head and select Custom Arrow. For Section Tail/ click <none>. This means the other end

of the section line will not use a symbol. Click OK.

The final step is to create a customized section view type/ which will use the new section

tag type you created in the previous step.
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ïitchto thevíew tab/ an.d on the create panel/seïect Section. By defaulf.

prTerties palette/70u wíllsee the default^ Section-Buildmg Section^(Ïflth'iuÏ^eÍ
as the default/ dick the pull-down menu and make the app?opnateseÍecL^snísïl°

8. On the Properties palette/ select the Edit Type button.

9. In the Type Properties dialog box, select Duplicate.

10. Name the new type Design Sections, and dick OK.

xnthe Type propertils dialog b0^/ díck the ellipsis on the far right end i
property/ and in the Type drop-down/ choose âustom Filled Arrow7"" "^lllc ">ect3

12. Click OK to exit the Type Propertíes for the Section Tag. Click OK again to ^ ^ l
Properties for Design Sections. " -~' ~""&"ULLU^it

^ You can now placea section in your drawing área and see the results shown in P,.

Note that m our sample/ the section is referendng a view that haïa7readybee'nlpl^eTo1

FIGURE 4.41

lhe completed custam

sectíon tag
A251

^Youcan rePeat,the Previ"us exerdses usÍng a callout tag famüy template instead <
ig template to achieve results similar to those shown in Figure 4^42.

FIGURE 4.42

Customizing the
callout tag /——NW

A^l
A] ai

CREATING A CUSTOM ELEVATION TAG

Elevation tags are a bit different from section or callout tags because one tag can simultj

S.YOU must/ therefore/ create and nest various parts of a customl
; ínto one fanúly in order to create custom graphics. Here ishow it works:"' Í

l. Click the File tab/ and select New > Annotation Svmbol.

!n the New Annotatíon symb01 dialog box/ select the family template caïled Elevaf
Mark Body.rftorMetnc Elevation Mark Body. rft/anddickOpen"

3. Usmgsteps simüar to those in the section tag exercise/ place the Sheet Number labe
draw línes as shown m Figure 4.43.

FIGURE 4.43

Define the custam

Imework and sheet
number for the elevation

mark body.

> sure the properties Keep Readable and Fixed Rotation are checked for the label.

gave the family as Custam Elev Head.rfa.

Click the Application menu and select New > Annotation Symbol.

> New Annotation Symbol dialog box/ select the family templat^called Elevatt on
l7' ÍTalrlkcPoYnte7.rftorMetric Elevation Mark Po-inter. rft and click Open.

^ methods similar to those m previous steps/ placo labels for the Detail Number and

l8' ^SeÏabelpïameters Drawa diamond with lines and a small/ triangular, fílled

region/ as shown in Figure 4.44.

'Ref
E44.-
ITevation

iposed of

Iregion,

t 9. Again/ remember to make sure the properties Keep Readable and Fixed Rotation are

checked for the labels.

|t0. Savethefamily as Custam Elev Pointer.rfa andloaditinto the Custom Elev Head

.rfafamily.

111. Place four instances of the Custom Elev PointCTfamily around the mtersection of the

visible reference planes, as shown m Figure 4.45.

1.45
id pointer

Iplaced four
Ithe head family.

A101

When this custam elevation tag family is loaded into a project and assodated with an eleva-

3e, Ít will fimction much like standard elevation symbols. ^ _ ^
Tfïthelviewrarephce'don a sheet/ you get a preview of the completed elevation symbol, as

shown in Figure 4.46.

14.46
Imized elevation

iterior

ms

A253

fc ..l
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Starting a Project with a Custam Template
Now that we have covered many áreas of customization within project templates,

configure Revit to use any of your custem project templates. To do só/ follow thest

l. Click the File tab/ and at the bottom of the menu/ click Options.

2. In the Options dialog box/ select the FÜe Locations category. The list of Proieri. rrj

Files allows you to select several RTE files that will be displayed on the Recpn+ü^
screen. You can see these files in a drop-down list when you laimch the New Pi

command either from the File tab or by pressing Ctrl+N on the keyboard.

3. Click the green plus to add RTE files/ and use the up and down arrow icons t-n r»l

arder of Üw templates in the list (Figure 4.47).

FIGURE 4.47

Add your custam project

templates to File
Locatíons in the Options
dialog box.

isns

Gi n era!

Usef interface

Graphks

Rendering

Check Speiling

SfeerítiCjWhi

ViewCube

Ma<ros

Pr&jecttemplatê iites; The firet iïve pfo^et tiemiAites rf appear es Srgs on the
Recent Fites paga,

e e is

C\ProgramDBt3VAutodesk\RVr201g\Tem.'.'.

C; \Users ^{ftmïtocunten ts

Defadtpsth fer -fenmly terepiate •Sés;

Strategies for Managing Templates
During ünplementation/ you can take one of two approaches when managing project

additive or subtractive. An addítive approach/ as shown m Figure 4.48, assumes that ffl(J

one project template will be developed to manage standards and content for a síngle p|
Typically/ a "base" template is used to start a project with a minimum amount of settín|
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:ontent and settmgs from "supplemental" templates are appended based on region,

?e, or project style. In this scenario/ each template fíle is lighter, but managing the

K^Ïates becomes more difficnlt because changes m common settings or families must be

I^Íied to ali templates.

In contrast/ the subtractive approach/ shown m Figure 4 49, uses a single master template that

. ali standard settings and content. This method relies on the project teams to remove and

re unused content. Although the ffle síze of these templates tends to be larger/ graphic

and template updates are easier to manage withm a single file.

^ggregating Template Data
lefher you are managmg the settings between templates or developmg a project with multiple
iplates in an additive approach/ you have useful tools withmRevit to help share data between

|iüjects/ such as Transfer Froject Standards, Insert Views From File/ and Insert 2D Elements From File.

FRANSFERRING PROJECT STANDARDS

fou can easily share Revit families between project files by loading their RFA files; however/ most
kher types of content must be transferred with the Transfer Project Standards cormnand Types of

|lements commonly transferred with this command include/ but are not limited to/ the followmg:

Materiais

System family types (Walls, Floors/ Roofs/ Stairs/ and só on)

Text and dimension styles

FiUed regions

Grid and levei types

Lme styles and pattems

Object style settmgs

Viewport types
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To use Üús command/ you must fírst have both the source and target Revit filçg
°Per

the same Ínstance of the software. As an alternative/ you can have the source file In

target file. Next/ make the target fÜe the active project. Switch to the Manage tab,

Transfer ProJect Standards on the Settings panei. In the Select Items To Copy dic

(Figure 4.50), choose as many item categories as you want to transfer/ and then clii

FIGURE 4.50
SelecÊ categories to be

transferred

between projects.

Sei e et items Tc CR)

' El^ïfeU.ln!!;J.ï!?s5.
JAnaiytecal Pipe Conneetior! T^>es
lAmotatton Family Labe] Tipes

QAres ana Volume CarepiitBitos

;[3Arrowhead ëtsks
I^Asssmbty Coáe SetCrgs
'QSfQwss!' Organization

;Ei;J8utyi"9'ï'ype Settings

!S03bleTfaySettÍngs
ïSCableïraySiïes

iQCaNe Tray T^es

l^jCafeutTags
|0CeifmgTypes
IQCotor RU Sdiemes
^CTtfnn^E B+ ^fltftínrna

If you choose an element category contammg some of the same fypes that already exis|

your current project/ you will be prompted with the option to overwrite the existing type|
import the new types only (New Only)/ as shown m Figure 4.51.

FIGURE 4.51

Transfemngproject

standards with

duplicate types

DuplicateType; X

The fDSemng Jypes aireaáy exist in lhe (testnateon p'<gect but are diffèrent:

2.5 "K 5'rectangufe

<R(»OT S®psratí?>
Ariguter Dimenston St^e : Angrósr -.
Assêmtíy Coáe Sétima

Bssk CeSng; Saienc
Compourid Ceitng : Ï x Ï ACT S^tere
Carpgyrri CesBng ; Ï ï, SS ACT System
Compourd Cdbng ; GW on W. Stajd

INSERTING VlEWS FROM A FILE

The Insert Views From File command is useful for sharing views between project files—

especially if you use the additive method of template management we mentioned earUer.

command allows you to copy drafting views/ renderings/ or schedules ÍTom one project to

another. It can also insert entire sheets with ali attached drafting views and associated pïOI

This procedure is quite useful if you use Revit project files as containers for your standardt

typical details. An entire sheet of details can be mserted with one command!
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l.
gwitch tothe Insert tab/ and choose

Inseri From File > Insert VÍews Fiom File in the

Ïïnport panei. ^ _..,_,,„„ ^\ and vou wül then see the

. ^^s^^^^^^^s^2' vs^^s^'^^^
1.52
^'canbeused

,rane"tire

^aftingviews

•pïoject-

Sïlectdrafiins'

Vtews;

IShwsivfews3'

,^^,orWt.te^totte^tp^.

3. ^—-—^^^^^^^^^^^''

'^^^âS^=^?s;f'':':"
oTguaZatos7a7we discussed earlier m this chapter.

INSERTING 2D ELEMENTS FROM A FILE ^ ^ ^ ^ ^ ^^ ^^ ^^ ^ command/ but

:;^^^!^!^^^£^^^e^^^
. msteïdofmsertmgan^tireview^w^ns^^
: ^^^^^i'-"^^^1^^^^^1^: 'SSiSSS^^
: ^^^^^weItM>^ZD"s

From File/ and then navigate to a p^ect me. ^ ^ ^ ^^ ^ ^^ ^

..vz^z^^^smmtw"ww^ss>'
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FIGURE 4.53
Insert 2D Elements
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3. For consistency, be sure to select the Transfer View Scale option to convert the scale of \

draftmg view to that of fhe yiew you are msertíng. Try moving fhe elements into positi
the Move command/ and after placing fhe 2D elements/ be sure to cHck Firush in thelEc

panei or double-click anywhere outside the elements to complete the command.

DUPLICATE TYPES WHEN INSERTING

When using Insert Views From File or Insert'2D Elements From Füe, be sure to watch for

about existing types not being overwritten, as shown here, because new element types
inserted source may contaín more desirable propertíes.

D u pli cata Typ es

ffre füftoswhg Tïpes already erest but sie differant. -Í1T& Types {rom ^e woí.
: are paathg wti be used.

rrowh&ad • fvrow 30 Degfee

If duplicated types from the ínserted source are needed, rather than the existíng types, ttn

lies can be loaded using the Load Family or Transfer Project Stanáards tools.
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fbe Bottom Une
pefíne settings for graphic quality and consistency. The fundamental buildmg blocks for

ïmplate are the customized settings for object styles/ Ime styles/ fill pattems/ maten-

ais/ and more.

Master It How can a complex custom-fill pattern be imported?

Organize views for maximum efficiency. The project template can be used to capture a

framework supporting your visual and organizational standards.

Master ït How can you customize the ProJect Browser to support your busmess needs?

Create custem annotation families. Developing a graphic style to match your standards

wilïusuaUy require you to edit some annotation families or create them from scratch.

Master It Can a single label display more than one parameter? How are custom view

tags loaded into a project?

Start a project with a custem template. Making your custom template available for new

', ensures that ali future projects will mamtain the same levei of graphic quality and

efficiency you expect.

Master It How do you set your own custom project template to be the default for

new projects?

Develop a template management strategy. Organizing your standards content/ and settings

while using Revit tools to transfer content will make your effort more efficient.

Master It How do you msert your standard details £rom one Revit project to another?

How do you transfer settings such as materiais?


